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Hardware Overview
The DXM can have several different configurations. The DXM has a model number label on the housing. Use the model 
number and model table to identify which boards are included in the your controller.

Not all combinations of base boards and radios are supported.

IMPORTANT:
Electrostatic discharge (ESD) sensitive device
ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
Use proper handling procedures to prevent ESD damage. Proper handling procedures include 
leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps; 
and assembling units on a grounded, static-dissipative surface.

Cellular Modem Board

Processor Board

MultiHop or Gateway
Radio Board

DXM100 I/O Base Board

Cellular Antenna
Connection

ISM Radio
Antenna

Connection

Housing Catch

The DXM100 I/O Base Board is shown. The DXM1000 I/O Base Board is similar.

I/O Base Board—The DXM I/O base board provides connections for all inputs, outputs and power. The I/O base board 
contains a 12 V solar controller that accepts connections to a solar panel and sealed lead acid (SLA) battery. The battery 
connection can also be used with line power to provide a battery backup in case of line power outages.

ISM Radio—The ISM radio, either a MultiHop or DX80 Gateway, fits on the I/O base board in the parallel sockets. Install the 
ISM radio so the U.FL antenna connection is to the side with the SMA antenna connectors. Connect the U.FL cable from the 
ISM radio U.FL to the right side U.FL connector. The ISM radio boards are available with either a 900 MHz radio (North 
America) or a 2.4 GHz radio (world-wide).

OverviewChapter 1 
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Processor—The processor board plugs into the base board using the two 20 pin socket connectors. The board sits above the 
ISM radio socket and held by the base board standoffs. Position the processor board so the USB and RJ45 Ethernet 
connection is to the front, away from the SMA antenna connections.

Cellular Modem (Optional)—The optional cellular modem (purchased separately) board plugs into the processor board with 
the U.FL antenna connection to the left. Attach the antenna cable from the cellular modem to the left U.FL connection on the 
base board.

In some DXM models, the cellular modem may be replaced with an ISM radio. In this configuration, position the top ISM radio 
antenna connection to the left of the SMA antenna connector.

LCD (Display) Board—The top housing contains the LCD board. The display board is connected to the base board using a 
ribbon cable with a 20 pin connector.

DXM100-B1 System Overview
Banner's DXM Logic Controller integrates Banner's wireless radio, cellular connectivity, and local I/O to provide a platform for 
the Industrial Internet of Things (IIoT).

Inputs and Outputs Connectivity Logic Controller User Interface

Universal inputs Cellular Action rules LCD screen

Discrete outputs Sure Cross radios Programming language LED indicators

Courtesy power and switch power Ethernet Scheduler

USB Push to the cloud

RS-485 client and RS-485 server Data logging

RS-232

CAN

Inputs and Outputs
On-board universal and programmable I/O ports connect to 
local sensors, indicators, and control equipment

Universal inputs
Discrete outputs, courtesy and switch power outputs
Battery backup, solar controller

Connectivity--The DXM's wired and wireless connectivity options make it easy to share data between local and remote 
equipment. The cellular modem option eliminates the need for IT infrastructures to connect remote equipment for sensing 
and control. The integrated Sure Cross® wireless radio enables Modbus connectivity to remote sensors, indicators, and 
control equipment.
Wired Connectivity

Ethernet: Modbus TCP or Ethernet/IP
Field Bus: Modbus RS-485 Client/Server, RS-232, or 
Controller Area Network (CAN)

Wireless Connectivity
Sure Cross® Wireless Radio: DX80 900 MHz, DX80 2.4 GHz, 
MultiHop 900 MHz, or MultiHop 2.4 GHz
Cellular modem: LTE-M (United States) or LTE-M/NB-IoT 
(outside the United States)

Logic Controller—Program the DXM's logic controller using action rules and/or ScriptBasic language, which can execute 
concurrently. The control functions allow freedom when creating custom sensing and control sequences. The logic controller 
supports the Modbus protocol standards for data management, ensuring seamless integration with existing automation 
systems. File and LCD password protection is an option.
Register Mapping

Cyclical Read rules from wireless devices or local wired 
Modbus devices that include optional scaling, error conditions, 
and the ability to activate a read rule
Cyclical or Change of State write rules to wireless devices or 
local wired Modbus devices with scaling
Modbus/TCP Client read or write rules for external devices on 
the network

Action Rules
Thresholds (IF/THEN/ELSE) with timers, minimum on/off time, 
and logging options  
Math/Logic Rules (arithmetic and bitwise operators)
Control Logic (logical operators and SR/T/D/JK flip flops) 
Trending (multiple averaging filters)
Tracking (counts, on/off times)
Push data on conditions

Scheduler
Time/calendar-based events
Holiday skips and one-time events
Dynamic scheduler updating
Astronomical clock
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Optional Text Programming Language
ScriptBasic to create variables, arrays, functions, loops, IF/
THEN/ELSE, logical and arithmetic operators, API commands, 
register access, string functions and operators, time 
commands

Data Logging
Cyclic Data/event logging

User Interface—A simple user interface consists of an LCD screen and four LED indicators. Use the LCD to access system 
status and setup, view user-selectable events or data, and to bind and perform site surveys for Sure Cross radios. Configure 
the user-programmable LEDs to indicate the status of the DXM, processes, or equipment.
User programmable LCD

Binding Sure Cross radios
Conducting a Site Survey
Viewing sensor information

Viewing the system's status
User-Defined LED indicators

Four multicolored LEDs: green, amber, red
Programmable behavior

DXM100-B1 Models

Model Base Radio Configuration

DXM100- B1 R1

B1 = Modbus controller for data aggregation of sensors and 
wireless networks

Power: 12−30 VDC/Solar/Battery
Comms: RS-485, CAN, RS-232 w/flow or secondary RS-485
Inputs: Four universal IN
Outputs: Four NMOS OUT, two analog OUT (0-10V or 
4-20mA)
Power OUT: Two selected 5V or 16V switched power, one 5V 
courtesy power

Blank = None
R1 = 900 MHz, 500 mW PE5 Performance Radio (North 
America)

R2 = 900 MHz, 500 mW HE5 MultiHop Data Radio (North 
America)

R3 = 2.4 GHz, 65 mW PE5 Performance Radio (Worldwide)

R4 = 2.4 GHz, 65 mW HE5 MultiHop Data Radio (Worldwide)

R5 = 900 MHz, 65 mW HE5L MultiHop Data Radio (Used for 
MGAGE networks)

R8 = 900 MHz, Performance Radios approved for Australia/New 
Zealand

R9 = 900 MHz, MultiHop Radio approved for Australia/New 
Zealand

Some example models include, but are not limited to, the following:

Models Description

DXM100-B1R1 DXM100-B1 Wireless Controller with DX80 ISM 900 MHz radio

DXM100-B1R2 DXM100-B1 Wireless Controller with DX80 ISM 900 MHz MultiHop radio

DXM100-B1R3 DXM100-B1 Wireless Controller with DX80 ISM 2.4 GHz radio

DXM100-B1R4 DXM100-B1 Wireless Controller with DX80 ISM 2.4 GHz MultiHop radio

Cellular Communication—Controllers accept Banner LTE-M (CATM1) modems only. Cellular modems are ordered separately 
as accessories under the following part numbers:

LTE CAT-M1 AT&T (North America only): SXI-CATM1ATT-001
LTE CAT-M1 Verizon (United States only):SXI-CATM1VZW-001
LTE CAT-M1/NB-IoT Multi-Carrier (Europe only): SXI-CATM1WW-001

DXM100-B2 System Overview
Banner's DXM Logic Controller integrates Banner's wireless radio, cellular connectivity, and local I/O to provide a platform for 
the Industrial Internet of Things (IIoT).

Inputs and Outputs Connectivity Logic Controller User Interface

Universal inputs Cellular Action rules LCD screen

Discrete outputs Sure Cross Radios Programming language LED indicators

Continued on page 8
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Continued from page 7

Inputs and Outputs Connectivity Logic Controller User Interface

Courtesy power and switch power Ethernet Scheduler

DC latching outputs USB Push to the cloud

Analog outputs RS-485 client and RS-485 server Data logging

SDI-12 serial interface

Inputs and Outputs
On-board universal and programmable I/O ports connect to 
local sensors, indicators, and control equipment.

Universal inputs, discrete outputs, courtesy power and 
switched power outputs, DC latching outputs
Battery backup, solar controller, SDI-12 serial interface

Connectivity—The DXM's wired and wireless connectivity options make it easy to share data between local and remote 
equipment. The cellular modem option eliminates the need for IT infrastructures to connect remote equipment for sensing 
and control. The integrated Sure Cross® wireless radio enables Modbus connectivity to remote sensors, indicators, and 
control equipment.
Wired Connectivity

Ethernet: Modbus/TCP or Ethernet/IP
Field Bus: Modbus RS-485 Client/Server

Wireless Connectivity
Sure Cross® Wireless Radio: DX80 900 MHz, DX80 2.4 GHz, 
MultiHop 900 MHz, or MultiHop 2.4 GHz
Cellular modem: LTE-M (United States) or LTE-M/NBIoT 
(outside the United States)

Logic Controller—Program the DXM's logic controller using action rules and/or ScriptBasic language, which can execute 
concurrently. The control functions allow freedom when creating custom sensing and control sequences. The logic controller 
supports the Modbus protocol standards for data management, ensuring seamless integration with existing automation 
systems. File and LCD password protection is an option.
Register Mapping

Cyclical Read rules from wireless devices or local wired 
Modbus devices that include optional scaling, error conditions, 
and the ability to activate a read rule
Cyclical or Change of State write rules to wireless devices or 
local wired Modbus devices with scaling
Modbus/TCP Client read or write rules for external devices on 
the network

Action Rules
Thresholds (IF/THEN/ELSE) with timers, minimum on/off time, 
and logging options 
Math/Logic Rules (arithmetic and bitwise operators) Control 
Logic (logical operators and SR/T/D/JK flip flops)
Trending (multiple averaging filters)
Tracking (counts, on/off times) Push data on conditions

Scheduler
Time/calendar-based events
Holiday skips and one-time events
Dynamic scheduler updating
Astronomical clock

Optional Text Programming Language
ScriptBasic to create variables, arrays, functions, loops, IF/
THEN/ELSE, logical and arithmetic operators, API commands, 
register access, string functions and operators, time 
commands

Data Logging
Cyclic Data/event logging

User Interface—A simple user interface consists of an LCD screen and four LED indicators. Use the LCD to access system 
status and setup, view user-selectable events or data, and to bind and perform site surveys for Sure Cross radios. Configure 
the user-programmable LEDs to indicate the status of the DXM, processes, or equipment.
User-Programmable LCD

Binding Sure Cross radios
Conducting a Site Survey
Viewing sensor Information

Viewing the system's status
User-Defined LED indicators

Four multicolored LEDs: green, amber, and red
Programmable behavior
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DXM100-B2 Models

Model Family Base Radio

DXM100- B2 R1

B2=Smart valve control, SDI-12 data collection
Power: 12−30 V DC/solar/battery
Comms: RS-485, (1) SDI-12 serial interface
Inputs: Four universal IN
Outputs: Four NMOS OUT, two 0-10V analog, two DC 
latching
Power OUT: Two adjustable 5V to 24V switched power, one 
SDI switched power, and one 5V courtesy power

Blank = None

R1 = 900 MHz, 500 mW PE5 Performance Radio (North 
America)

R2 = 900 MHz, 500 mW HE5 MultiHop Data Radio (North 
America)

R3 = 2.4 GHz, 65 mW PE5 Performance Radio (Worldwide)

R4 = 2.4 GHz, 65 mW HE5 MultiHop Data Radio (Worldwide)

R5 = 900 MHz, 65 mW HE5L MultiHop Data Radio (Used for 
MGAGE networks)

R8 = 900 MHz, Performance Radios approved for Australia/New 
Zealand

R9 = 900 MHz, MultiHop Radio approved for Australia/New 
Zealand

Some example models include, but are not limited to, the following:

Models Description

DXM100-B2R1 DXM100-B2 Wireless Controller with DX80 ISM 900 MHz radio

DXM100-B2R2 DXM100-B2 Wireless Controller with DX80 ISM 900 MHz MultiHop radio

DXM100-B2R3 DXM100-B2 Wireless Controller with DX80 ISM 2.4 GHz radio

DXM100-B2R4 DXM100-B2 Wireless Controller with DX80 ISM 2.4 GHz MultiHop radio

Cellular Communication—Controllers accept Banner LTE-M (CATM1) modems only. Cellular modems are ordered separately 
as accessories under the following part numbers:

LTE CAT-M1 AT&T (North America only): SXI-CATM1ATT-001
LTE CAT-M1 Verizon (United States only):SXI-CATM1VZW-001
LTE CAT-M1/NB-IoT Multi-Carrier (Europe only): SXI-CATM1WW-001

DXM1000-B1 System Overview
Banner's DXM Logic Controller integrates Banner's wireless radio, cellular connectivity, and local I/O to provide a platform for 
the Industrial Internet of Things (IIoT).

Inputs and Outputs Connectivity Logic Controller User Interface

Universal inputs Cellular Action rules LCD screen

Discrete outputs Sure Cross® Radio Programming language LED indicators

Courtesy power and switch power Ethernet Scheduler

USB Push to the cloud

RS-485 client and RS-485 server Data logging

RS-232

Modbus registers for internal local registers (Modbus ID 199) 

Local Registers  Type  Description 

1–845  32-bit integer  Local data registers 

846–849  32-bit integer  Reset, Constant, Timer 

Continued on page 10
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Continued from page 9

Local Registers  Type  Description 

851–900  32-bit non-volatile integer  Data flash, non-volatile 

901–1000    Reserved for internal use 

1001–5000  Floating point  Floating point registers, local data registers 

5001–7000  32-bit integer  Local data registers 

7001–8000  32-bit non-volatile integer  Data flash, non-volatile 

> 10000    Read-only virtual registers, system-level data 

Inputs/Outputs—On-board universal and programmable I/O ports connect to local sensors, indicators, and control equipment.
Universal Inputs
Discrete outputs
Courtesy power
Switch power
Battery backup
Solar controller

Connectivity—The DXM's wired and wireless connectivity options make it easy to share data between local and remote 
equipment. The cellular modem option eliminates the need for IT infrastructures to connect remote equipment for sensing 
and control. The integrated Sure Cross® wireless radio enables Modbus connectivity to remote sensors, indicators, and 
control equipment.
Wired Connectivity

Ethernet: Modbus TCP or Ethernet/IP
Field Bus: Modbus RS-485 Controller/Peripheral (client/
server)

Wireless Connectivity
Sure Cross Wireless Radio: DX80 900 MHz, DX80 2.4 GHz, 
MultiHop 900 MHz, or MultiHop 2.4 GHz
Cellular modem: LTE-M (United States) or LTE-M/NB-IoT 
(outside the United States)

Logic Controller—Program the DXM's logic controller using action rules and/or ScriptBasic language, which can execute 
concurrently. The control functions allow freedom when creating custom sensing and control sequences. The logic controller 
supports the Modbus protocol standards for data management, ensuring seamless integration with existing automation 
systems. File and LCD password protection is an option.
Register Mapping

Cyclical Read rules from wireless devices or local wired 
Modbus devices that include optional scaling, error conditions, 
and the ability to activate a read rule
Cyclical or Change of State write rules to wireless devices or 
local wired Modbus devices with scaling
Modbus/TCP Client read or write rules for external devices on 
the network

Action Rules
Thresholds (IF/THEN/ELSE) with timers, minimum on/off time, 
and logging options
Math/Logic Rules (arithmetic and bitwise operators)
Control Logic (logical operators and SR/T/D/JK flip flops)
Trending (multiple averaging filters)
Tracking (counts, on/off times)
Push data on conditions

Scheduler
Time/calendar-based events
Holiday skips
One-time events
Dynamic scheduler updating
Astronomical clock

Optional Text Programming Language
ScriptBasic to create variables, arrays, functions, loops, IF/
THEN/ELSE, logical and arithmetic operators, API commands, 
register access, string functions and operators, time 
commands

Data Logging
Cyclic data/event logging

User Interface—A simple user interface consists of an LCD screen and four LED indicators. Use the LCD to access system 
status and setup, view user-selectable events or data, and to bind and perform site surveys for Sure Cross radios. Configure 
the user-programmable LEDs to indicate the status of the DXM, processes, or equipment.
User programmable LCD

Binding Sure Cross radios
Conducting a Site Survey
Viewing sensor information

Viewing the system's status
User Defined LED indicators

Four defined LED indicators: green, amber, and red
Programmable behavior
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DXM1000-B1 Models

Model Base Radio Configuration

DXM1000- B1 R1

DXM1000-

B1 = Modbus controller for data aggregation of sensors and 
wireless networks

Power: 12−30 V DC / Solar / Battery
Comms: RS-485, RS-232 w/flow or secondary RS-485
Inputs: Four universal IN
Outputs: Four NMOS OUT, two analog OUT (0-10 V or 4-20 
mA)
Power Out: Two selected 5 V or 16 V switched power one 5 
V courtesy power

Blank = None
R1 = 900 MHz, 1 W PE5 Performance Radio (North America)

R2 = 900 MHz, 1 W HE5 MultiHop Data Radio (North America)

R3 = 2.4 GHz, 65 mW PE5 Performance Radio (Worldwide)

R4 = 2.4 GHz, 65 mW HE5 MultiHop Data Radio (Worldwide)

R5 = 900 MHz, 65 mW HE5L MultiHop Data Radio (Used for M-
GAGE networks)

R8 = 900 MHz, Performance Radios approved for Australia/New 
Zealand

R9 = 900 MHz, MultiHop Radio approved for Australia/New 
Zealand

Some example models include, but are not limited to, the following:

Models Description

DXM1000-B1R1 DXM1000-B1 Wireless Controller with DX80 ISM 900 MHz radio

DXM1000-B1R2 DXM1000-B1 Wireless Controller with DX80 ISM 900 MHz MultiHop radio

DXM1000-B1R3 DXM1000-B1 Wireless Controller with DX80 ISM 2.4 GHz radio

DXM1000-B1R4 DXM1000-B1 Wireless Controller with DX80 ISM 2.4 GHz MultiHop radio

Cellular Communication—Controllers accept Banner LTE-M (CATM1) modems only. Cellular modems are ordered separately 
as accessories under the following part numbers:

LTE CAT-M1 AT&T (North America only): SXI-CATM1ATT-001
LTE CAT-M1 Verizon (United States only): SXI-CATM1VZW-001
LTE CAT-M1/NB-IoT Multi-Carrier (Europe only): SXI-CATM1WW-001

DXM1000-B2 System Overview
Banner's DXM Logic Controller integrates Banner's wireless radio, cellular connectivity, and local I/O to provide a platform for 
the Industrial Internet of Things (IIoT).

Inputs and Outputs Connectivity Logic Controller User Interface

Universal inputs Cellular Action rules LCD screen

Discrete outputs Sure Cross radios Programming language LED indicators

Courtesy and switch power outputs Ethernet Scheduler

DC latching outputs USB Push to the cloud

Analog outputs RS-485 client and server Data logging

SDI-12 serial interface

Modbus registers for internal local registers (Modbus ID 199) 

Local Registers  Type  Description 

1–845  32-bit integer  Local data registers 

846–849  32-bit integer  Reset, Constant, Timer 

851–900  32-bit non-volatile integer  Data flash, non-volatile 

901–1000    Reserved for internal use 

Continued on page 12
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Continued from page 11

Local Registers  Type  Description 

1001–5000  Floating point  Floating point registers, local data registers 

5001–7000  32-bit integer  Local data registers 

7001–8000  32-bit non-volatile integer  Data flash, non-volatile 

> 10000    Read-only virtual registers, system-level data 

Inputs/Outputs
On-board universal and programmable I/O ports connect to 
local sensors, indicators, and control equipment

Universal inputs, discrete outputs, courtesy power, switch 
power
Battery backup, solar controller, DC latching outputs, SDI-12 
serial interface

Connectivity—The DXM's wired and wireless connectivity options make it easy to share data between local and remote 
equipment. The cellular modem option eliminates the need for IT infrastructures to connect remote equipment for sensing 
and control. The integrated Sure Cross® wireless radio enables Modbus connectivity to remote sensors, indicators, and 
control equipment.
Wired Connectivity

Ethernet: Modbus/TCP or Ethernet/IP
Field Bus: Modbus RS-485 Client/Server

Wireless Connectivity
Sure Cross Wireless Radio: DX80 900 MHz, DX80 2.4 GHz, 
MultiHop 900 MHz, or MultiHop 2.4 GHz
Cellular modem: LTE-M (United States) or LTE-M/NBIoT 
(outside the United States)

Logic Controller—Program the DXM's logic controller using action rules and/or ScriptBasic language, which can execute 
concurrently. The control functions allow freedom when creating custom sensing and control sequences. The logic controller 
supports the Modbus protocol standards for data management, ensuring seamless integration with existing automation 
systems. File and LCD password protection is an option.
Register Mapping

Cyclical Read rules from wireless devices or local wired 
Modbus devices that include optional scaling, error conditions, 
and the ability to activate a read rule
Cyclical or Change of State write rules to wireless devices or 
local wired Modbus devices with scaling
Modbus/TCP client read or write rules for external devices on 
the network

Action Rules
Thresholds (IF/THEN/ELSE) with timers, minimum on/off time, 
and logging options
Math/Logic Rules (arithmetic and bitwise operators)
Control Logic (logical operators and SR/T/D/JK flip flops)
Trending (multiple averaging filters)
Tracking (counts, on/off times)
Push data on conditions

Scheduler
Time/calendar-based events
Holiday skips
One-time events
Dynamic scheduler updating
Astronomical clock

Optional Text Programming Language
ScriptBasic to create variables, arrays, functions, loops, IF/
THEN/ELSE, logical and arithmetic operators, API commands, 
register access, string functions and operators, time 
commands

Data Logging
Cyclic data/event logging

User Interface—A simple user interface consists of an LCD screen and four LED indicators. Use the LCD to access system 
status and setup, view user-selectable events or data, and to bind and perform site surveys for Sure Cross radios. Configure 
the user-programmable LEDs to indicate the status of the DXM, processes, or equipment.
User-Programmable LCD

Binding Sure Cross radios
Conducting a Site Survey
Viewing sensor Information

Viewing the system's status
User-Defined LED Indicators

Four multicolored LEDs: green, amber, and red
Programmable behavior
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Overview of the configuration software features

USB

DXM Configuration Software

Local Registers

System
Settings

Register Mapping

Action Rules

Scheduler

ScriptBasic

Register
View Utility

XML Config File
Ethernet

DXM1000-B2 Models

Model Base Radio Configuration

DXM1000- B2 R1

B2 = Smart valve control, SDI-12 data collection
Power: 12−30 V DC/solar/battery
Comms: RS-485, one SDI-12 serial interface
Inputs: Four universal IN
Outputs: Four NMOS OUT, two 0-10V analog, two DC 
latching
Power OUT: Two adjustable 5V to 24V switched power, one 
SDI switched power, and one 5V courtesy power

Blank = None
R1 = 900 MHz, 1 W PE5 Performance Radio (North America)

R2 = 900 MHz, 1 W HE5 MultiHop Data Radio (North America)

R3 = 2.4 GHz, 65 mW PE5 Performance Radio (Worldwide)

R4 = 2.4 GHz, 65 mW HE5 MultiHop Data Radio (Worldwide)

R5 = 900 MHz, 65 mW HE5L MultiHop Data Radio (Used for 
MGAGE networks)

R8 = 900 MHz, Performance Radios approved for Australia/New 
Zealand

R9 = 900 MHz, MultiHop Radio approved for Australia/New 
Zealand

Some example models include, but are not limited to, the following:

Models Description

DXM1000-B2R1 DXM1000-B2 Wireless Controller with DX80 ISM 900 MHz radio

DXM1000-B2R2 DXM1000-B2 Wireless Controller with DX80 ISM 900 MHz MultiHop radio

DXM1000-B2R3 DXM1000-B2 Wireless Controller with DX80 ISM 2.4 GHz radio

DXM1000-B2R4 DXM1000-B2 Wireless Controller with DX80 ISM 2.4 GHz MultiHop radio

Cellular Communication—Controllers accept Banner LTE-M (CATM1) modems only. Cellular modems are ordered separately 
as accessories under the following part numbers:

LTE CAT-M1 AT&T (North America only): SXI-CATM1ATT-001
LTE CAT-M1 Verizon (United States only): SXI-CATM1VZW-001
LTE CAT-M1/NB-IoT Multi-Carrier (Europe only): SXI-CATM1WW-001

DXM Configuration Software
Download the latest version of all configuration software from http://
www.bannerengineering.com. For more information on using the DXM 
Configuration Software, refer to the instruction manual (p/n 209933).

The configuration software configures the DXM client by creating an XML file 
that is transferred to the DXM client using a USB or Ethernet connection. The 
DXM client can also receive the XML configuration file from a Web server 
using a cellular or Ethernet connection.

This configuration file governs all aspects of the DXM client and server 
operation.

The wireless network devices are a separate configurable system.  Use the 
DX80 Performance Configuration Software to configure the internal DX80 
client radio and the wireless server nodes bound to it. Use the MultiHop 
Configuration Software if the internal radio is a MultiHop device.

All configuration software can be connected to the DXM client using a USB 
cable or an Ethernet connection.

DXM Automation Protocols
The DXM supports the following automation protocols.

http://www.bannerengineering.com
http://info.bannerengineering.com/cs/idcplg?IdcService=GET_FILE&dDocName=209933&RevisionSelectionMethod=Latest&Rendition=web
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Modbus RTU
The DXM manages two separate physical ports running the Modbus RTU protocol. The DXM is the Modbus client when 
operating the Modbus client RTU port. The DXM uses the client Modbus RTU bus to communicate with locally connected 
Modbus devices or uses the Banner wireless radio to communicate with remote Modbus devices.
The other Modbus RTU port is used by a host system to access the DXM as a server device. The server Modbus RTU 
port allows access all the internal registers concurrently with the client RTU port. Set the Modbus ID using the LCD 
menu: SYSTEM CONFIG › DXM Modbus ID.
By default, the Modbus RTU ports are active. Configure the port parameters using the configuration software.

Modbus TCP/IP
A host system acting as a Modbus client can access the DXM using the Modbus TCP/IP protocol over Ethernet. 
Standard Modbus port 502 is used by the DXM for all Modbus TCP/IP requests.
All internal registers are available to the host system concurrently with Modbus RTU.
By default, Modbus TCP/IP is active. Configure the DXM using Modbus TCP rules in the configuration software.

EtherNet/IP™
The Ethernet port is actively running EtherNet/IP. From the factory, the DXM is configured to read and write registers on 
DX80 wireless devices 1 through 16. Custom configurations can be set using the configuration software.
By default, EtherNet/IP is active.

DXM Modbus Overview
The DXM uses internal 32-bit registers to store information. The processor's internal Local Registers serve as the main global 
pool of registers and are used as the common data exchange mechanism. External Modbus device registers can be read into 
the Local Registers or written from the local data registers.

The DXM, as a Modbus client or server, exchanges data using the Local Registers. Modbus over Ethernet (Modbus/TCP) 
uses the Local Registers as the accessible register data.

Action, Read/Write, and Threshold Rules allow you to manipulate the processor's Local Registers. The ScriptBasic 
programming capabilities extend the use of Local Registers with variables to create a flexible programming solution for more 
complex applications.

The processor's Local Registers are divided into three types: integer, floating point, and non-volatile. When using Local 
Registers internally, the user can store 32-bit numbers. Using Local Registers with external Modbus devices follows the 
Modbus standard of a 16-bit holding register. Local Registers are accessible as Modbus ID 199.

Accessing the I/O base board and the LCD follows the same communication as an external Modbus device. Each device has 
a unique Modbus ID. The I/O base board is Modbus ID 200 and the LCD is Modbus ID 201.

Overview of the DXM Modbus processor

Local Registers
(Modbus ID 199)

DXM Processor

Local Registers
Integer

Action Rules
Read/Write Rules
ScriptBasic

Local Registers
Float

Local Registers
Non-Volatile

Modbus Data
Traffic Control

Gateway or MultiHop
(ID 1)

I/O Base Board
(ID 200)

LCD
(ID 201)



09-Dec-24 page 15 of 110

DXM100-Bx And 1000-Bx Wireless Controller Product Manual 

© Banner Engineering Corp. All rights reserved.

•
•
•

•
•
•

•

•
•

Chapter Contents
Device Setup ...................................................................................................................................................................................................... 15
Configuration Instructions................................................................................................................................................................................... 18

Device Setup
Apply Power from a PSW-24-1 to the Controller
Follow these instructions to apply 12–30 V DC power to the controller using a wall plug.

Equipment used:
DXM Wireless Controller
MQDMC-401 0.3 m (1 ft) cordset with a 4-pin M12 quick disconnect fitting
PSW-24-1 Wall plug power supply; 24 V DC, 1 A

IMPORTANT:
Never operate a radio without connecting an antenna
Operating radios without an antenna connected will damage the radio circuitry.
To avoid damaging the radio circuitry, never apply power to a Sure Cross® Performance or Sure 
Cross® MultiHop radio without an antenna connected.

Binding and Conducting a Site Survey with the ISM Radio
Before the ISM radio can communicate, the ISM radio within the DXM must be bound to the other radios in the wireless 
network.

Use the DXM LCD menu to bind external radios to the internal ISM radio.

If you are having difficulty running binding or site surveys, it may be because of the speed of the XML configuration file or 
script running on the DXM. To resolve this issue, try one of the following options:

Disable the XML and script by setting DIP switch 4 on the processor board to ON and cycling the power to the DXM. 
After binding the devices, turn DIP switch 4 back OFF and cycle power again to return to normal operation of the XML 
and script.
Adjust the XML or script to slow down the RTU read or write rules.
Upload a blank XML, bind all devices, then upload the configured XML file.

Bind a DX80 Node to a DXM and Assign the Node Address
Binding Nodes to a Gateway ensures the Nodes only exchange data with the Gateway they are bound to. After a Gateway 
enters binding mode, the Gateway automatically generates and transmits a unique extended addressing (XADR), or binding, 
code to all Nodes within range that are also in binding mode. The extended addressing (binding) code defines the network, 
and all radios within a network must use the same code. 

Quick Start GuideChapter 2 

Connect the brown wire from the MQDMC-401 cordset to the DXM's PW (+ power) terminal.1. 

Connect the blue wire from the MQDMC-401 cordset to the DXM's GD (- ground) terminal.2. 

Connect the PSW-24-1 power supply to the MQDMC-401 cordset.3. 

Plug in the PSW-24-1 wall plug power supply.4. 

Apply power to all the devices.
Separate radios by two meters when running the binding procedure. Put only one DXM Gateway into binding mode at 
a time to prevent binding to the wrong Gateway.

1. 

Enter binding mode on the DXM radio:2. 
Use the arrow keys to select the ISM Radio menu on the LCD and press ENTER.a. 
Highlight the Binding menu and press ENTER.b. 
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Bind a MultiHop Radio to a DXM and Assign the Device ID
Before beginning the binding procedure, apply power to all the devices. Separate radios by two (2) meters when running the 
binding procedure. Put only one DXM MultiHop client radio into binding mode at a time to prevent binding the server or 
repeater radios to the wrong client radio.

Binding MultiHop radios ensures all MultiHop radios within a network communicate only with other radios within the same 
network. The MultiHop client radio automatically generates a unique binding code when it enters binding mode. This code is 
transmitted to all radios within range that are also in binding mode. After a repeater/server radio is bound, the repeater/server 
radio accepts data only from the client radio to which it is bound. The binding code defines the network, and all radios within 
a network must use the same binding code. 

◦

◦

Assign the Node address to the Node.
For Nodes without rotary dials: Use the DXM arrow keys to select the Node address to assign to the DX80 
Node about to enter binding mode. The DXM assigns this Node address to the next Node that enters binding 
mode. Only bind one Node at a time.
For Nodes with rotary dials: Use the Node's rotary dials to assign a valid decimal Node Address (between 01 
and 47). The left rotary dial represents the tens digit (0 through 4) and the right dial represents the ones digit 
(0 through 9) of the Node Address. You can leave the DXM "Bind to" address set to 1 because the Node's 
rotary dials will override that setting.

3. 

Start binding mode on the DXM radio by pressing ENTER on the DXM radio.4. 

◦
◦
◦

Enter binding mode on the DX80 Node.
For housed radios, triple-click button 2.
For board-level radios, triple-click the button.
For Nodes without buttons, refer to the Node's datasheet for instructions on entering binding mode.

The left and right LEDs flash alternately and the Node searches for a Gateway in binding mode. After the Node binds, 
the LEDs stay solid momentarily, then they flash together four times. The Node automatically exits binding mode and 
reboots.

5. 

Label the Node with the assigned address number for future reference.6. 

Press BACK on the DXM to exit binding mode for that specific Node address.
The Node LEDs continue to flash red until the DXM exits binding mode with that Node address.

7. 

Repeat these steps for as many DX80 Nodes as are needed for your network.8. 

When you are finished binding, press BACK on the DXM until you return to the main menu.9. 

Enter binding mode on the DXM radio:1. 
Use the arrow keys select the ISM Radio menu on the LCD and press ENTER.a. 
Highlight the Binding menu and press ENTER.b. 

◦

◦

Assign the device address to the repeater or server radios. Valid device IDs are 11 through 60.
For MultiHop radios without rotary dials: Use the DXM arrow keys to select the device ID to assign to the 
MultiHop radio about to enter binding mode. The DXM assigns this device ID to the next radio that enters 
binding mode. Only bind one server radio at a time.
For MultiHop radios with rotary dials: Use the MultiHop radio's rotary dials to assign a device ID . The left 
rotary dial represents the tens digit (1 through 6) and the right dial represents the ones digit (0 through 9) of 
the device ID. You can leave the DXM "Bind to" address set to 1 because the MultiHop's rotary dials will 
override that setting.

2. 

Start binding mode on the DXM radio by pressing ENTER on the DXM radio.3. 

◦
◦
◦

After entering binding mode on the DXM, put the MultiHop repeater or server radio into binding mode.
For housed radios, triple-click button 2.
For board-level radios, triple-click the button.
For radios without buttons, refer to the radio's datasheet for instructions on entering binding mode.

After binding is completed, the MultiHop radio automatically exits binding mode and begins operation.

4. 

Press BACK on the DXM to exit binding mode for that specific device address.
The MultiHop radio's LEDs continue to flash red until the DXM exits binding mode with that MultiHop radio.

5. 

Label the MultiHop radio with the assigned address number for future reference.6. 

Repeat these steps, changing the device address, for as many MultiHop radios as are needed for your network.7. 
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Conduct a Site Survey from the DXM
Conduct a Site Survey to verify the wireless communication between the radios within your wireless network.

Conduct the site survey when the Nodes and DXM Controller are at the proposed installation sites to determine each radio's 
signal strength with the DXM.

For a DX80 network, the Gateway controls the site survey and the results display on the LCD. Running a site survey on a 
DX80 network does not affect the throughput of the DX80 network. The DX80 Gateway-Node system can run a site survey 
analysis while the network is operational. For a MulitHop network, the client device passes the site survey request to the 
intended Modbus server device. The Site Survey runs and the results display on the LCD. Running a site survey on a 
MultiHop network stops all network traffic to that device.

If the Site Survey fails (100 missed packets), verify the radios are at least 10 feet from the DXM and/or rerun the binding 
procedure. If you find poor signal quality, common solutions include moving the DXM to a more central location relative to the 
Nodes or using higher-gain antennas on the DXM. Contact your local Banner Engineering representative for assistance.

Set a Static IP Address
Change the IP address of the DXM to connect to a local area network, Modbus TCP/IP host controller, or EtherNet/IP host 
controller.

There are two ways to set the IP address: using the DXM's LCD menu or using the configuration software to change the XML 
file. IP addresses entered into the LCD menu system override the IP addresses in the XML configuration files. To use the IP 
addresses set in the XML configuration file, clear the IP addresses from the menu system.

System Config menu options

System Config
to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓
Ethernet DHCP Update DHCP Mode

IP:
SN:
GW:
Reset

Update IP Address
Update SN
Update GW Address
Resets Ethernet parameters
to xml defaults.

After making changes to the
Ethernet settings, restart the DXM.

Use this same procedure to set the subnet mask (SN) and default gateway (GW) to match your network requirements. Your 
IT department can provide these settings if needed.

When you are finished binding, press BACK on the DXM until you return to the main menu.
All radio devices begin to form the network after the client data radio exits binding mode.

8. 

On the DXM: Use the arrow buttons to select the ISM Radio menu and press ENTER.1. 

Select the Site Survey menu and press ENTER.2. 

Use the Up or Down arrows to select the device ID number and press ENTER to run the site survey with that radio.
The site survey results display as green, yellow, red, and missed packets. Green indicates the highest signal strength, 
then yellow, and red. Missed packets were not received.

3. 

When you are finished running the Site Survey, press Back twice to return to the main menu and exit site survey 
mode.

4. 

On the DXM, use the arrows and move to the System Config menu. Press ENTER.1. 

Use the arrow keys to select the Ethernet menu. Press ENTER.2. 

Highlight the DHCP selection and press ENTER. Set DHCP to OFF.3. 

The system will request a restart, press ENTER to confirm.4. 

Follow steps 1 and 2 to reenter the Ethernet menu. Use the arrow keys to select IP. Press ENTER.
The IP address displays (for example, 192.168.0.1).

5. 

Use the up and down arrows to change the IP address. Press ENTER to move to the next octet.6. 

Press ENTER on the final octet to accept the changes.7. 

Cycle power to the DXM.
The changes are saved on the DXM and the new IP address will be used.

8. 
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DXM Configuration Software

USB

DXM Configuration Software

Local Registers

System
Settings

Register Mapping

Action Rules

Scheduler

ScriptBasic

Register
View Utility

XML Config File
Ethernet

Configuration Instructions
Configuring the Controller
Configure the DXM using the configuration software. The DXM Configuration 
Software allows the user to define parameters for the DXM, then saves the 
configuration in an XML file on the PC. To configure the DXM, connect the 
DXM's USB or Ethernet port to a computer.

After the configuration file is saved, upload the XML configuration file to the 
DXM for operation.

This quick start guide outlines the basic operations to set up a DXM using the 
configuration software. For a more comprehensive explanation of features, 
refer to the DXM Configuration Software Instruction Manual (p/n 209933).

Introduction to Traditional Setup Mode
This section will walk you through the traditional method of setting up the 
DXM Configuration Software and communicating with a connected DXM 
device. Version 4 of the configuration software supports multiple DXM device 
models, each of which incorporates different features.

As soon as a DXM model is connected to your computer, the software 
automatically detects the correct model and loads the appropriate screens. 
You may also manually select which model of DXM you are configuring if you 
intend to create a configuration file without connecting a device. This ensures that the interface and the configuration file use 
the correct features.

Not all screens are available for all models. To change to another model of DXM, go to the Connect to DXM screen and use 
the drop-down list to select another model. If the active configuration is incompatible with the selected model, you will be 
prompted to either proceed and wipe out the active configuration or cancel the model change and preserve the configuration.

Traditional Setup opening screen

Connect via USB or Ethernet. If connecting via Ethernet, set network parameters through the DXM LCD menu in the System 
Cfg › Ethernet menu. Network parameters can also be set within the configuration software. Setting parameters on the LCD 
menu overrides the parameters stored in the configuration file. To use the network parameters in the configuration file, reset 
the network parameters on the DXM LCD menu.

Since the DXM-R90x connects only via TCP, its Connect to DXM screen differs from the other DXM models. When the Select 
DXM Model drop-down is set to DXM-R90x, a new network discovery table is displayed. Click Scan Network for DXMs to 
detect DXM devices on the host computer's network. Discovered DXMs are listed in the network discovery table. Double-click 
any row entry to connect to that DXM. If the DXM's IP address is already known, the standard TCP connection option is 
available below the network discovery table.

Banner recommends disconnecting the COMM port through the Device menu before turning off power or disconnecting the 
USB cable. Use Device › Reboot to restart the DXM if needed; the tool automatically disconnects the COMM port, then 
reconnect it again.

http://info.bannerengineering.com/cs/idcplg?IdcService=GET_FILE&dDocName=b_4496867&RevisionSelectionMethod=Latest&Rendition=web
http://info.bannerengineering.com/cs/idcplg?IdcService=GET_FILE&dDocName=209933&RevisionSelectionMethod=Latest&Rendition=web
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TIP: If connection attempts are failing (Application Status Icon in the footer of the tool is Red), close the 
configuration software and disconnect the USB cable from the computer. Reconnect the cable, launch the 
software, and attempt connecting again.

If you cannot connect to your DXM Controller, refer to for more information.

IMPORTANT: Any model of DXM may connect to the configuration software regardless of which device 
model is selected in the tool. Compatibility is checked before configuration files are uploaded to the 
device.

Configuration Example: Reading Registers on a Modbus Server Device
The local registers are the main global pool of registers that are defined by the user to store data within the DXM. The local 
registers are listed on the Local Registers › Local Registers in Use screen.

The bottom status bar displays the communications status, application status, and the DXM Configuration Software version.

In this short example, we will configure the DXM to read six registers on an external Modbus server device and save the data 
into the local registers.

The software only loads a file to the DXM. Internal parameter settings that are changed in the tool but not saved to the file will 
not be sent to the device.

Modify Multiple Registers
Modify a range of registers from the Local Registers › Local Registers in Use › Modify Multiple Registers screen.

Select which parameter fields to modify. Most parameters have three selections.
Unchanged—no changes
Default—change to default settings
Set—modify the parameter. Other selections will appear based on the parameter.

Modify Multiple Registers screen

Create an RTU Read Rule
Follow these steps to create a new read rule.

This example screen shows a read rule created to read six registers (address 1 through 6), from Modbus ID 4. The results 
are stored in the Local Registers 1 through 6.

Enter the Starting register and Ending register.1. 

Select the value to change using the drop-down list next to each value.2. 

Enter the new value in the field provided.3. 

To push register values to the web server, set Cloud Settings to Read.
If the Cloud Settings are set to Read, the web server only views data from the device and cannot write data to the 
device. If the permissions are set to Write, the web server only writes to the device and cannot read the data. If the 
permissions are set to Read/Write, the web server can read the data from the device and write to the device from the 
web.

4. 

Click Modify Registers to save and apply the changes.5. 
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Read Rules - Configuration Example

Set the Time
Use the Settings › System screen to define the time zone and daylight saving option. The time zone and DST options are 
saved into the configuration file.

Settings > System > Device Time

Save and Upload the Configuration File
After making any changes to the configuration, you must save the configuration files to your computer, then upload it to the 
device.

Changes to the XML file are not automatically saved. Save your configuration file before exiting the tool and before sending 
the XML file to the device to avoid losing data. If you select DXM › Send XML Configuration to DXM before saving the 
configuration file, the software will prompt you to choose between saving the file or continuing without saving the file.

From the Register Mapping › RTU › RTU Read screen, click Add Read Rule.1. 

Click the arrow next to the name to display the parameters.2. 

Name your rule.3. 

Select the device ID.4. 

Select how many registers to read, and the beginning register.5. 

Define the register type, how often to read the register, and any other appropriate parameters.6. 

If necessary, select the error condition. For this example, if the read function fails after three attempts, the read rule 
writes 12345 to the DXM local registers. Notice the list of local register names this read rule is using.

7. 

Go to the Settings › System screen.1. 

If you connect the DXM to a computer, click Sync PC Time with Device to set the time on the DXM to match the time 
of the computer.

2. 

Set your time zone and select whether or not your device observes daylight saving time (DST).3. 

Save the XML configuration file to your hard drive by going to the File › Save As menu.1. 

Go to the DXM › Send XML Configuration to DXM menu.

Status indicator bar

2. 
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◦

◦
◦

If the Application Status indicator is red, close and restart the DXM Configuration Tool, unplug and re-plug in 
the cable and reconnect the DXM to the software.
If the Application Status indicator is green, the file upload is complete.
If the Application Status indicator is gray and the green status bar is in motion, the file transfer is in progress.

After the file transfer is complete, the device reboots and begins running the new configuration.
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ISM radio board

DIP Switch
Bank 1

Button

LED

DIP Switch
Bank 2

11 ONON

Antenna

2
3

4

2
3

4

Chapter Contents
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DIP Switch Settings for the Performance Gateway Radio Module..................................................................................................................... 24

Plug the ISM radio into the I/O base board with the U.FL antenna connector closest to the SMA connectors. Typically, users 
will not need to adjust the DIP switch settings on the physical radio modules.

For the DXM models with a display, set the radio options using the LCD 
menu.

Button Operation
For DXM models without an LCD, use the button to bind the ISM radio. 
For models with an LCD, use the ISM menu to bind the radio.

LED Operation
The LED located on the ISM radio module indicates power and 
communications traffic. ISM board LED operations also display on the 
LED on the right side of the I/O base board.

Solid green DX80 ISM radio LED indicates power.
Flashing green MultiHop ISM radio LED indicates operation.
Red and green combined: Communications traffic and binding.

DIP Switches for the MultiHop Radio
MultiHop ISM radio models include R2, R4, or R5 in the model number.

DXMxxx-xxR2 - MultiHop 900 MHz
DXMxxx-xxR4 - MultiHop 2.4 GHz
DXMxxx-xxR5 - MultiHop 900 MHz, 100 mW
DXMxxx-xxR9 - MultiHop 900 MHz, (Australia)

Making changes to the baud or parity settings requires that you make the same settings to the Modbus Client 
Communications section within the DXM Configuration Software (Settings › General.

Disabling the serial port disables the ISM radio in the DXM. Selecting Transparent mode causes radio communications to be 
slower and denies access to device I/O register data.

DIP switch settings

D1 Switches D2 Switches

Device Settings 1 2 3 4 1 2 3 4

Serial line baud rate 19200 OR User defined receiver 
slots OFF* OFF*

Serial line baud rate 38400 OR 32 receiver slots OFF ON

Serial line baud rate 9600 OR 128 receiver slots ON OFF

Serial line baud rate Custom OR 4 receiver slots ON ON

Parity: None OFF* OFF*

Parity: Even OFF ON

Parity: Odd ON OFF

Disable serial (low power mode) and enable the receiver 
slots select for switches 1-2 ON ON

Transmit power
900 MHz radios: 500 mW (27 dBm)
2.4 GHz radios: 65 mW (18 dBm) and 60 ms frame

OFF*

Continued on page 23

ISM Radio Board (ID 1)Chapter 3 
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Continued from page 22

D1 Switches D2 Switches

Device Settings 1 2 3 4 1 2 3 4

Transmit power
900 MHz radios: 250 mW (24 dBm)
2.4 GHz radios: 65 mW (18 dBm) and 40 ms frame

ON

Application mode: Modbus OFF*

Application mode: Transparent ON

MultiHop radio setting: Repeater OFF OFF

MultiHop radio setting: Client OFF ON

MultiHop radio setting: Server ON OFF

MultiHop radio setting: DXM LCD Menu Control ON* ON*

* Default configuration. The default settings for D2 DIP switches 3 and 4 are ON. This allows for forcing the device into client 
mode and DXM menu control for the radio power settings.

Application Mode
The MultiHop radio operates in either Modbus mode or transparent mode. Use the internal DIP switches to select the mode 
of operation. All MultiHop radios within a wireless network must be in the same mode.

Modbus mode uses the Modbus protocol for routing packets. In Modbus mode, a routing table is stored in each parent device 
to optimize the radio traffic. This allows for point-to-point communication in a multiple data radio network and 
acknowledgment/retry of radio packets. To access a radio's I/O, the radios must be running in Modbus mode.

In transparent application mode, all incoming packets are stored, then broadcast to all connected data radios. The data 
communication is packet-based and not specific to any protocol. The application layer is responsible for data integrity. For 
one-to-one data radios it is possible to enable broadcast acknowledgment of the data packets to provide better throughput. In 
transparent mode, there is no access to the radio's I/O.

Baud Rate and Parity
The baud rate (bits per second) is the data transmission rate between the device and whatever it is physically wired to. Set 
the parity to match the parity of the device you are wired to.

Disable Serial
Disable an unused local serial connection to reduce the power consumption of a data radio powered from the solar assembly 
or from batteries. All radio communications remain operational.

Transmit Power Levels/Frame Size
The 900 MHz data radios can be operated at 500 mW (27 dBm) or 250 mW (24 dBm). For most models, the default transmit 
power is 500 mW.

For 2.4 GHz radios, the transmit power is fixed at 65 mW (18 dBm) and DIP switch 5 is used to set the frame timing. The 
default position (OFF) sets the frame timing to 60 milliseconds. To increase throughput, set the frame timing to 40 
milliseconds. For battery-powered devices, increasing the throughput decreases battery life.
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DIP Switch Settings for the Performance Gateway Radio 
Module
The 900 MHz radios have a high output option that will transmit at 500 mW 
(27 dBm). The low output option transmits at 250 mW (24 dBm). The 250 mW 
mode reduces the radio's range but improves the battery life in short-range 
applications. For 2.4 GHz models, this DIP switch is disabled. The transmit 
power for 2.4 GHz is fixed at about 65 mW EIRP (18 dBm). 

DX80 Performance Gateway ISM radio devices include R1, R3, or R8 in the 
model number.

DXMxxx-xxR1 - DX80 Performance 900MHz
DXMxxx-xxR3 - DX80 Performance 2.4GHz
DXMxxx-xxR8 - DX80 Performance 900MHz (Australia)

IMPORTANT: To adjust the transmit power on the Gateway 
radio, Banner recommends using the LCD menu (System 
Conf › ISM Radio › RF CNTRL).

DIP switch settings for bank 1

DIP Switch 1

OFF 500 mW (27 dBM) (default configuration; 900 MHz only)

ON 250 mW (24 dBm, 900 MHz models only), DX80 compatibility mode
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Processor Board for the DXM1x0 Models
Processor board for the DXM

1

14

H

I

A

B
C

D

E

A

F

G

Processor board features

Callout Description Function

A Cellular modem 
connection

Install the cellular modem onto the processor board with the cellular modem's U.FL connector on the 
left. The antenna cable will go between the cellular U.FL connector and the left I/O base board U.FL 
connector. Always disconnect the power to the device before installing or removing a cellular modem.

B Button
Use the processor board button to force a cloud push. To force a push to the cloud, press and hold 
this button for five (5) seconds to send an immediate push message from the device (if properly 
configured).

C Boot load jumpers

D DIP switches

E Micro SD card

F LED 1 Heartbeat, indicates the processor is running

G LED 2 Indicates the cellular modem power cutoff is active; if the incoming power is less than 11.2 V, the 
cellular modem is powered down

H LED 3 XML configuration file was rejected; or file load in process; or the second phase of boot loading is in 
process (flashing)

I LED 4 ScriptBasic program failed to load; or the beginning phase of boot loading is in process (flashing = in 
process, on = complete)

Processor Board for the DXM1x00 Models

1

A

E
C

F

A - Cellular modem connection
B - Bootload

Processor BoardChapter 4 
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C - LED
D - DIP switches
E - Micro SD card

Cellular Modem Connection—Install the cellular modem onto the processor board with the cellular modem's U.FL connector 
on the left. The antenna cable will go between the cellular U.FL connector and the left I/O base board U.FL connector. Always 
disconnect the power to the device before installing or removing a cellular modem.

Button Operation—Pressing and holding the button down during power-up puts the processor into manual programming 
mode. Programming requires a microchip SAM-BA programming application. To force a push to the cloud, press and hold this 
button for five (5) seconds to send an immediate push message from the device (if properly configured)

LED Operation—The single LED indicates the processor is running.
Flashing green—The processor is running
Single red flash at power-up time—The Bootloader is present
Toggling Red/Orange—The Bootloader is examining the new file
Toggling Red/Green—The Bootloader is loading the new image

DIP Switch Settings for the Processor Board
After making changes to the DIP switch settings, cycle power to the device.

DIP switches for the DXM processor board

Settings
DIP Switches

1 2 3 4

Disable Ethernet Port
OFF *

ON

Disable LCD Display
OFF *

ON

Not used OFF *

Bypass XML
OFF *

ON

Bypass XML
Turn on to have the XML file ignored at boot time. This is useful for ignoring a corrupt or questionable XML configuration 
file. After the device is running, a new XML file can be loaded using the DXM configuration tool.
Turn on to stop the processor from executing the defined configuration. This is useful if the loaded configuration is using 
all the processing time and not allowing DXM Configuration Tool operations.
The factory default position is OFF.

Disable Ethernet Port
Set to on to power down the Ethernet interface. Disabling the unused Ethernet port reduces power consumption.
The factory default position is OFF.

Disable LCD Display
Set to on to disable the LCD. This DIP switch should be on when the LCD display board is not connected.
The factory default position is OFF.

Ethernet
Before applying power to the DXM, verify the Ethernet cable is connected.

The number of times the processor attempts to connect to the Ethernet network is configured in the DXM Configuration 
Software (Settings › Network Ethernet Connection Acquisition). The default setting is two retries one minute after the device 
boots up and another retry two minutes later.
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The Ethernet connection supports the DXM Configuration Software, Modbus/TCP, and EtherNet/IP. ScriptBasic also has 
access to Ethernet for custom programming. Use the software or LCD menu system to configure the characteristics of the 
Ethernet connection, including the IP address. Any parameters not changeable from the menu system are configurable from 
the configuration software.

Ethernet parameter changes entered through the LCD menu override the XML configuration parameters. To return to using 
the network settings in the XML configuration file, remove the Ethernet parameters defined by the LCD menu using the 
System Config › Ethernet › Reset menu.

USB
The USB port is used with the DXM Configuration Software to program the DXM100-Bx or 1000-Bx Wireless Controller. The 
USB port is also used as the console output for the processor and ScriptBasic.

Turn on debug messages to the serial console by selecting Print push debug messages to serial console in the DXM 
Configuration Software Settings › Cloud Services screen.
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I/O Base Board Connections for the B1 Models
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D
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H

J

K
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1 18

1932

m A

V

A OUT 2
A OUT 1M

L

1 No connection 12 CT. RS-232 CTS 23 N3. NMOS OUT 3

2 PW. 12 to 30 V dc or solar power in 
(+) 13 S-. Secondary RS-485 – 24 N2. NMOS OUT 2

3 GD. Ground 14 S+. Secondary RS-485 + 25 N1. NMOS OUT 1

4 B+. Battery in (< 15 V DC) 15 CL. CANL (DXM100-B1 only) 26 GD. Ground

5 GD. Ground 16 CH. CANH (DXM100-B1 only) 27 U4. Universal Input 4

6 M-. Primary RS-485 – 17 GD. GND 28 U3. Universal Input 3

7 M+. Primary RS-485 + 18 P3. Courtesy Power 5 V 29 GD. Ground

8 GD. Ground 19 A2. Analog OUT 2 30 P1. Adjustable Courtesy Power (5 V 
or 16 V)

9 TX. RS-232 Tx 20 A1. Analog OUT 1 31 U2. Universal Input 2

10 RX. RS-232 Rx 21 P2. Adjustable Courtesy Power (5 V 
or 16 V) 32 U1. Universal Input 1

Continued on page 29

IO Base BoardsChapter 5 
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Continued from page 28

11 RT. RS-232 RTS 22 N4. NMOS OUT 4

A Base board LED E Jumpers - Configures Analog Out 1 
and 2 for mA or V J Modbus Server ID DIP Switches

B A1. Cellular or secondary antenna F Radio Binding Button K Modbus Server ID DIP Switches

C Radio LED G Programming header L Processor Board Connection

D A2. ISM Antenna H ISM Radio Board Connection M Display Connection

I/O Base Board for the B2 and S2 Models
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1 No connection 12 2B. DLatch 2B 23 N3. NMOS OUT 3

2 PW. 12–30 V DC or solar power in 
(+) 13 S-. Secondary RS-485 – (not used 

for the S2) 24 N2. NMOS OUT 2

3 GD. Ground 14 S+. Secondary RS-485 + (not used 
for the S2) 25 N1. NMOS OUT 1

4 B+. Battery in (< 15 V DC) 15 SP. SDI-12 Courtesy Power 26 GD. Ground

5 GD. Ground 16 SD. SDI-12 Data 27 U4. Universal Input 4

6 M-. Primary RS-485 – 17 GD. GND 28 U3. Universal Input 3

7 M+. Primary RS-485 + 18 P3. Courtesy Power 5 V 29 GD. Ground

8 GD. Ground 19 A2. Analog OUT 2 (0–10 V) 30 P1. Adjustable Courtesy Power (5–
24 V)

9 1A. DLatch 1A 20 A1. Analog OUT 1 (0–10 V) 31 U2. Universal Input 2

10 1B. DLatch 1B 21 P2. Adjustable Courtesy Power (5–
24 V) 32 U1. Universal Input 1

11 2A. DLatch 2A 22 N4. NMOS OUT 4

A Base board LED J Modbus Server ID DIP Switches

Continued on page 30
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Continued from page 29

B A1. Cellular or secondary antenna K Modbus Server ID DIP Switches

C Radio LED G Programming header L Processor Board Connection

D A2. ISM Antenna H ISM Radio Board Connection M Display Connection

DIP Switches for the IO Board
The DXM100-Bx or 1000-Bx Wireless Controller I/O board DIP switches are set from the factory to Modbus ID 200.

Set the Modbus ID on the IO Base Board (for Models without 
LCDs)
For DXM Server models without an LCD menu system, use DIP switches J and K to set the Modbus ID.

This device can use Modbus register 6804 in the I/O board to access the full range of Modbus IDs.

DIP Switch location J defines the course group of Modbus IDs. DIP Switch 4 must be set to ON for DXM100-S1, DXM100-S2, 
DXM100-S1R2, and DXM100-S2R2 models.

Settings
Location J DIP Switches

1 2 3 4

Modbus ID set to 11 through 19 OFF OFF

Modbus ID set to 20 through 29 ON OFF

Modbus ID set to 30 through 39 OFF ON

Modbus ID set to 40 through 49 ON ON

Not Used -

Modbus Server Configuration (DX100-S1 and -S1R2 models only) (1) ON

Standard Communication Mode OFF

The DIP switches at location K define the lower digit of the Modbus ID.

DIP Switches J DIP Switch K, Switches 1, 2, 3, 4 (0 is OFF, 1 is ON)

1 2 0,0,0,0 1,0,0,0 0,1,0,0 1,1,0,0 0,0,1,0 1,0,1,0 0,1,1,0 1,1,1,0 0,0,0,1 1,0,0,1

OFF OFF x (2) 11 12 13 14 15 16 17 18 19

ON OFF 20 21 22 23 24 25 26 27 28 29

OFF ON 30 31 32 33 34 35 36 37 38 39

ON ON 40 41 42 43 44 45 46 47 48 49

DXM100-Bx or 1000-Bx Wireless Controller Example—To set the DXM100-Bx or 1000-Bx Wireless Controller to a Modbus ID 
of 34, set the following:

Location J DIP switches set to 1=OFF, 2=ON
Location K DIP switches set to 1=OFF, 2=OFF, 3=ON, 4=OFF

The location J DIP switches set the upper Modbus ID digit to 3 while the location K DIP switches set the lower digit to 4.

Setting the DXM I/O Board Modbus ID using Modbus Registers—Write to the I/O board's Modbus register 6804 to set the 
Modbus ID to any valid Modbus ID (1 through 245).

For the DXM100-Bx or 1000-Bx Wireless Controller model, all switches on DIP switch K should be in the OFF position 
to use the Modbus register server ID.
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I/O Board Jumpers for the B1 and S1 Models
Hardware jumpers on the DXM I/O board allow the user to select alternative pin operations. Turn the power off to the device 
before changing jumper positions.

Jumper Function Positions

E Analog output characteristics for 
AO2 (pin 19) and AO1 (pin 20)

Defines current (0–20 mA) or voltage (0–10 V) for analog output 1 and 2.
By default, current (0–20 mA) is selected using jumpers 1 and 2 and registers 4008 and 4028 contain 
a value of 2.

To select voltage (0–10 V) for output Aout1, set jumper 1 in the voltage position (V) and set Modbus 
register 4008 on the I/O board (SID 200) to 3.

To select voltage (0–10 V) for output Aout2, set jumper 2 in the voltage position (V) and set Modbus 
register 4028 on the I/O board (SID 200) to 3.

Apply Power to the DXM100-Bx Controller
Apply power to the DXM100-Bx or 1000-Bx Wireless Controller using either 12 to 30 V DC or a 12 V DC solar panel and 12 V 
sealed lead acid battery operating together.

The DXM100 has three power input and three power output options:
Input Power:

12 to 30 V DC
12 to 30 V DC solar panel
12 V DC sealed lead acid battery with automatic charging

Courtesy Output Power Supplies:
One 5 V DC fixed
Two 5 V DC or 16 V DC (DXM100-B1 models) or Two 5 V to 24 V DC (DXM100-B2 models)

The DXM continuously monitors the health of the power inputs. If a power input fault is detected, the DXM automatically 
switches over to battery with continuous uninterrupted operation.

If the incoming voltage drops below 11.2 V DC, the cellular modem does not turn on and will not turn on until the voltage is 
above 11.8 V DC. A text file (CmVMon.txt) on the internal micro SD card saves the periodic sampling of the incoming voltage. 
If cellular operation stops because of voltage, it is logged in this file.

Pin Description

Pin 1 No connection

Pin 2 12 to 30 V DC input (+) or solar panel connection (+)

Pins 3, 5, 8, 17, 26, 29 Main logic ground for the DXM100-Bx or 1000-Bx Wireless Controller

Pin 4 Solar or backup battery positive input. Battery voltage must be less than 15 V dc. Use only a sealed lead acid 
(SLA) battery.

Connecting a Battery
When attaching a battery to the DXM as a backup battery or as a solar battery, verify the charging algorithm is set properly. 
The factory default setting for the battery charging algorithm assumes you are using 12 to 30 V DC to recharge the battery.

The charging algorithm is designed to work only with a sealed lead acid (SLA) or lithium ferrophosphate (LFP) battery..
When using 12 to 30 V DC, connect the 12 to 30 V DC + to pin 2 and connect the ground to pin 3.
When using main DC power with a backup battery (default configuration), connect the incoming main power pin 2 (+) 
and to pin 3 (-). Connect the 12 V battery to pin 4 (+) and pin 5 (-). The incoming main power must be 15 to 30 V DC 
to charge the battery.

Supplying Power from a Solar Panel
To power the DXM100-Bx or 1000-Bx Wireless Controller from a 12 V DC solar panel, connect the solar panel to power pins 
2(+) and 3(-). Connect a 12 V DC SLA or LFP rechargeable battery to pins 4(+) and 5(-).
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The factory default setting for the battery charging configuration assumes you are using 12 to 30 V DC power to recharge the 
battery. If the incoming power is from a solar panel, you must change the charging configuration.

The battery charging configuration defaults to a battery backup configuration. To change the charging configuration from the 
menu system:

To change the charging configuration by writing to Modbus register 6071 on the I/O base board (ID 200):

Connecting the Communication Pins
The base board communications connections to the DXM100-B1 Wireless Controller are RS-485 (primary), RS-485 
(secondary) or RS-232. The base board communications connections to the DXM100-B2 Wireless Controller are RS-485 
(primary) and RS-485 (secondary).

RS-485. The primary RS-485 bus is a common bus shared with the ISM radio board (Modbus ID 1) or optional cellular board. 
The DXM100-Bx or 1000-Bx Wireless Controller is defined as the Modbus Client on this bus. Other internal Modbus servers 
include the local processor registers (Modbus ID 199), the base I/O controller (Modbus ID 200), and the display board 
(Modbus ID 201). When assigning Modbus IDs to externally connected devices, only use IDs 2 through 198.

RS-232. The RS-232 bus is not currently defined for the DXM100-B1 models. There is no RS-232 for the DXM100-B2 
models.

Pin Parameter Description

Pin 6 Primary RS-485 – Running Modbus protocol at 19.2k baud, use this bus to connect to other Modbus Server devices. 
The DXM100-Bx or 1000-Bx Wireless Controller is a Modbus Client device on this RS-485 port.Pin 7 Primary RS-485 +

Pin 9 RS-232 Tx Serial RS-232 connection. This bus must use a ground connection between devices to operate 
correctly. (DXM100-B1 models only; not available on the DXM100-B2 models)Pin 10 RS-232 Rx

Pin 13 Secondary RS-485 – The DXM100-Bx or 1000-Bx Wireless Controller is a Modbus server on this bus (see "I/O Base 
Board Connections for the B1 Models" on page 28).

Pin 14 Secondary RS-485 +

Pin 15 CANL –
DXM100-B1 models only. Not available on the DXM100-B2 or DXM1000 models.

Pin 16 CANH +

Modbus RTU Client and Server Ports
The DXM can be a Modbus RTU client device to other server devices and can be a Modbus server device to another Modbus 
RTU client. The DXM uses the primary RS-485 port (M+/M-) as a Modbus RTU client to control external server devices. All 
wired devices connected to the client RS-485 port must be server devices.

As a Modbus RTU client device, the DXM controls the external server connected to the primary RS-485 port, the local 
ISM radio, the local I/O base board, and the local display board.
As a Modbus RTU server device, the DXM local registers can be read from or written to by another Modbus RTU 
client device.

The secondary port (S+/S-) is the Modbus RTU server connection. The secondary (server) Modbus RS-485 port (S+/S-) is 
controlled by another Modbus client device, not the DXM. The server port is used by an external Modbus client device that 
will access the DXM as a Modbus server device.

Use the configuration software to define operational settings for both the Modbus RTU client port and the Modbus RTU 
server port.

Use the DXM's LCD menu to set the Modbus ID for the secondary RS-485 port.

From the DXM LCD menu, navigate to System Config › I/O Board › Charger.1. 
Select Solar for solar panel configurations or DC for battery backup configurations.2. 

Write a 0 to select the solar power charging configuration.1. 
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Set the Client and Server Port Parameters
The basic communications parameters for the RS-485 ports are set in the DXM Configuration Software and are saved in the 
XML configuration file.

Settings > General screen

Baud Rate
Defined for both the Modbus client and server
Settings include: 19200 (default), 1200, 2400, 9600, 38400, 
57600, and 115200.

Delay between messages
Applies to the Modbus client port
Sets the minimum wait time from the end of a Modbus 
transaction to the beginning of the next Modbus transaction.

Parity
Defined for both the Modbus client and server
Settings include: None (default), odd, even, space, and mark

Timeout
Applies to the Modbus client port
Covers the expected time for messages to be sent throughout 
the wireless network. For the DXM, the Timeout parameter is 
the maximum amount of time the DXM should wait after a 
request is sent until the response message is received from 
the Modbus server device.

Wireless Modbus Backbone
Applies to the Modbus server port
Define when there is an ISM radio plugged into the processor 
board. When this is done, the Modbus server port uses the 
MultiHop radio as the server port instead of the terminal block 
connection on the I/O base board. Settings include: None 
(default), Modbus, or Ethernet

Set the DXM Modbus Server Port ID
Set the DXM Modbus server port ID using the LCD menu system.

After cycling power to the device, the updated DXM Modbus ID is listed under the System Config menu.

Inputs and Outputs
The I/O base board is a Modbus server device (ID 200) that communicates to the processor board using Modbus commands. 
Use the DXM Configuration Software to create a configuration using read/write maps that will access inputs or outputs on the 
I/O board.

Communication with the I/O board runs at a maximum rate of 10 ms per transaction. The parameter setting for the bus with 
the I/O board and the processor board are fixed. External Modbus communication runs at a maximum rate of 50 ms per 
transaction. The parameter settings for the external RS-485 buses are controlled by the DXM Configuration Software.

In the DXM Configuration Software, go to the Settings › General screen.1. 
To set the parameters for the Modbus Client, change the settings in the Client Port Settings M+/M- section.2. 
To set the parameters for the Modbus Servers, change the settings in the Server Port Settings S+/S- section.3. 

On the LCD, use the down arrow to highlight System Config and click the Enter button.1. 
Highlight DXM Modbus ID and click Enter.2. 
Use the up and down arrow buttons to change the DXM Modbus Server Port ID.3. 
Press Enter to accept the ID change.4. 
Use the configuration software to cycle power to the device.5. 
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Refer to for more descriptions of each Modbus register on the DXM100-Bx or 1000-Bx Wireless Controller.

Universal Inputs
The universal inputs on the DXM100-Bx or 1000-Bx Wireless Controller can be programmed to accept several different types 
of inputs:

Discrete NPN/PNP
0 to 20 mA analog
0 to 10 V analog
10k temperature thermistor
Potentiometer sense
Bridge
NPN raw fast

Any input can be used as a synchronous counter by configuring the input as a discrete NPN/PNP input.

Use the DXM Configuration Software tool to write to the appropriate Modbus registers in the I/O board to configure the input 
type. The universal inputs are treated as analog inputs. When the universal inputs are defined as mA, V, or temperature, use 
Modbus registers to configure the operational characteristics of the inputs. These parameters are temperature conversion 
type, enable full scale, threshold and hysteresis. Refer to the DXM100 Controller Instruction Manual (p/n 190037) for the 
parameter definitions.

When a universal input is configured as an NPN or PNP input type, it can be enabled to be a synchronous counter. Enable 
the counter function by setting Modbus register 'Enable Rising' or 'Enable Falling' to 1. See "Modbus IO Registers for the B1 
IO Base Board" on page 76 for universal input register definitions.

Pin Universal Input Modbus Register Description

27 4 4 Program the universal inputs to accept input types NPN, PNP, 10k thermistor, 0 to 10 
V, 0 to 20 mA, or potentiometer. The default setting is 8: NPN raw fast. To set the input 
type, write the following values to the Input Type Modbus registers defined in "Modbus 
IO Registers for the B1 IO Base Board" on page 76.

0 = NPN
1 = PNP
2 = 0 to 20 mA
3 = 0 to 10 V dc
4 = 10k Thermistor
5 = Not used
6 = Not used
7 = Bridge
8 = NPN Raw Fast (default)

28 3 3

31 2 2

32 1 1

Thermistor Input
A thermistor input must use a 10k temperature thermistor 
between ground and the universal input. The thermistor must 
be a 10k NTC (Banner model number BWA-
THERMISTOR-002) or equivalent. Select the temperature 
conversion of degrees C (default) or degrees F by writing 
Modbus registers defined in "Modbus IO Registers for the B1 
IO Base Board" on page 76.

Potentiometer Input
A potentiometer input is created from three inputs: a voltage 
source (pin 30) that supplies 5 V to the potentiometer and two 
inputs set to voltage inputs to read the voltage across the 
potentiometer. See Using Universal Inputs to Read a 
Potentiometer (p/n b_4462775) for more information.

Bridge Input
The bridge input is not implemented yet.

NPN vs NPN Raw Fast
The difference between NPN and NPN Raw Fast is the 
amount of settling time given to the input. Switch the input 
type to NPN if the input is not detecting a transition.

Synchronous Counters
When an input is configured as a counter (inputs set to NPN/
PNP), the input counts the input signal transitions. The count 
value is stored into two 16-bit Modbus registers for a total 
count of 32-bits (unsigned). To program an input to capture 
the edge transition counts, follow "Example: Configure Input 1 
as a Synchronous Counter" on page 34.
Synchronous counter sample the inputs every 10 ms. The 
input logic does not detect rising or falling edges, but instead 
samples the input every 10 ms to find level changes. The 
input signals must be high or low for more than 10 ms or the 
input will not detect transitions. Because most signals are not 
perfect, a realistic limit for the synchronous counter would be 
30 to 40 Hz.

Example: Configure Input 1 as a Synchronous Counter
Connect the DXM to the PC.1. 

Launch the DXM Configuration Software software.2. 

Connect to the DXM by selecting the Device › Connection Settings menu option. You may connect using either USB 
or Ethernet.

3. 

Select a COMM port from the drop-down list and click Connect.4. 

http://info.bannerengineering.com/intradoc-cgi/nph-idc_cgi.exe?IdcService=GET_FILE&dDocName=190037&RevisionSelectionMethod=Latest&Rendition=web
http://info.bannerengineering.com/cs/idcplg?IdcService=GET_FILE&dDocName=b_4462775&RevisionSelectionMethod=Latest&Rendition=web
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Example: Change Universal Input 2 to a 0 to 10 V DC Input

Example: Change Analog Output 1 to a 0 to 10 V DC Output

NMOS Outputs for the DXM100
NMOS output pins for the DXM100 models

Pin NMOS Discrete 
Outputs Modbus Register Description Wiring

22 4 504

Less than 1 A maximum current at 30 V DC
ON-State Saturation: Less than 0.7 V at 20 mA
ON Condition: Less than 0.7 V
OFF Condition: Open

Output

23 3 503

24 2 502

35 1 501

Analog (DAC) Outputs for the B1 and S1 Models
The B1 and S1 analog outputs may be configured as either 0 to 20 mA outputs (default) or 0 to 10 V outputs.

To change the analog (DAC) output type:

Click on the Register View tab on the left part of the page.5. 

Change the Source Register selection to I/O Board Registers.6. 

In the Write Registers area, write Modbus register 4908 to 1 to enable counting on the rising edge of the input signal.7. 

Read Modbus registers 4910 and 4911 to get the 32-bit value of the count.8. 

Connect the DXM to the PC.1. 

Launch the DXM Configuration Software software.2. 

Connect to the DXM by selecting the Device › Connection Settings menu option. You may connect using either USB 
or Ethernet.

3. 

Select a COMM port from the drop-down list and click Connect.4. 

Click on the Register View tab on the left part of the page.5. 

Change the Source Register selection to I/O Board Registers.6. 

Write a 3 to Modbus register 3326 on Modbus ID 200 (I/O board).7. 

Cycle power to the device.8. 

Using the Register View tab, read register 3326 to verify it is set to 3.9. 

Connect the DXM to the PC.1. 

Launch the DXM Configuration Software software.2. 

Connect to the DXM by selecting the Device › Connection Settings menu option. You may connect using either USB 
or Ethernet.

3. 

Select a COMM port from the drop-down list and click Connect.4. 

Click on the Register View tab on the left part of the page.5. 

Change the Source Register selection to I/O Board Registers.6. 

Set jumper 1 on the I/O base board to the 0 to 10 V position. Refer to the base board image for the analog output 
jumper position.

7. 

Write a 3 to Modbus register 4008 on Modbus ID 200 (I/O board).8. 

Cycle power to the device.9. 

Using the Register View tab, read register 4008 to verify it is set to 3.10. 

Remove power to the device.1. 
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DXM100/1000-B1 and S1 Models

Pin Analog Output Modbus Register Description

20 1 507 0 to 20 mA or 0 to 10 V DC output (I/O board jumper selectable)
Accuracy: 0.1% of full scale +0.01% per °C
Resolution: 12-bit19 2 508

Analog (DAC) Outputs for the B2 and S2 Models
The B2 and S2 analog outputs are 0 to 10 V dc outputs and cannot be changed.

DXM100/1000-B2 and S2 Models

Pin Analog Output Modbus Register Description

20 1 509 0 to 10 V DC output
Accuracy: 0.1% of full scale +0.01% per °C
Resolution: 12-bit19 2 510

DC Latching Outputs for the B2 and S2 Models

Pin DC Latching 
Outputs Modbus Register Description Wiring

9 D1A
507 Write a 1 to the output register to activate the DC 

Latching output from A to B.
Write a 0 to the output register to deactivate the DC 
Latching output from B to A. DB

D A 2-wire
self-latching
solenoid

10 D1B

11 D2A
508

12 D2B

The DXM Configuration Software allows the user to adjust parameters that govern the operation of the DC latch outputs. 
Most applications will not require any changes for correct operation. Software parameters include:

Enable H-Bridge—Enable or disable the H-bridge output. Default Enabled.
Voltage—The voltage applied to the output when the output is activated. Default 13 V DC.
Cap Warmup Time—The amount of time given to charge the output capacitor. The more time given to charge the 
output capacitor the more energy will be available to turn on the output. Default 80 ms
Switch Time—The amount of time the output is turned on to be able to change the solenoid output. Default 40 ms

SDI-12 Interface for the B2 and S2 Models

power

ground

serial SD

GD

SP
B2

Controller
SDI-12
device

The SDI-12 interface on the B2 Wireless Controllers can support up to five devices 
with twelve 32-bit register values each. The SDI-12 interface can be configured to 
increase the number of registers per device address for devices with large register 
sets. The factory default enables one SDI-12 device using device address 1 with 
up to nine registers with a SDI-12 command of "M!".

Use the configuration software or the LCD menu system to adjust the SDI-12 
parameters.

Remove the DXM cover.2. 
Change the hardware jumper position (see the table for the pin number and "I/O Base Board Connections for the B1 
Models" on page 28 for the pin locations).

3. 

Replace the DXM cover.4. 
Restore power to the DXM.5. 
Set the Output Type Select Modbus register (on the I/O board, ID 200) to a value of 2 (default) to select 0 to 20 mA or 
a value of 3 to select 0 to 10 V. For analog output 1 write to Modbus register 4008, for analog output 2 write to 
Modbus register 4028 (see the table for the values).

6. 
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Basic SDI-12 Interface Parameters
Up to five devices/commands can be accessed using the SDI-12 interface. There are three parameters for each device/
command: Enable, Device Address, Device Command. For more information, refer to the SDI-12 Technical Notes.

Enable. Instructs the DXM device to activate or deactivate the SDI-12 device. Write a 1 to enable, and write a 0 to disable. 
The factory default for device 1 is enabled; devices 2 through 5 are disabled.

Device Address. Each SDI-12 device must have a unique device address. This parameter is the ASCII code for the device 
address. Valid device addresses are 0–9 and a–z that map to ASCII codes 48–57 and 97–122, respectively. The factory 
default addresses are:

SDI-12 Device 0 uses ASCII code 48
SDI-12 Device 1 uses ASCII code 49
SDI-12 Device 2 uses ASCII code 50
SDI-12 Device 3 uses ASCII code 51
SDI-12 Device 4 uses ASCII code 52

Device Command The SDI-12 interface supports "M!" or "C!" commands. Use the Device Command parameter to define 
which command to use for this device. The factory default is "M!" commands for all devices (value of 10 in the Modbus 
register).

Supported M! commands

SDI-12 Command Register Value SDI-12 Command Register Value

xM! 0 or 10 xM5! 15

xM1! 11 xM6! 16

xM2! 12 xM7! 17

xM3! 13 xM8! 18

xM4! 14 xM9! 19

Supported C! commands

SDI-12 Command Register Value SDI-12 Command Register Value

xC! 1 or 20 xC5! 25

xC1! 21 xC6! 26

xC2! 22 xC7! 27

xC3! 23 xC8! 28

xC4! 24 xC9! 29

The Modbus configuration registers are listed. All registers are defined as Modbus holding registers. The factory default 
values are shown in parentheses. All values are in decimal unless noted otherwise.

Device/CMD Configuration
Registers (Default Value)

Enable Device Address Device Command

SDI-12 Device/CMD 1 1751 (1) 11001 (48) (1) 11002 (10)

SDI-12 Device/CMD 2 1701 (0) 11201 (49) 11202 (10)

SDI-12 Device/CMD 3 1651 (0) 11401 (50) 11402 (10)

SDI-12 Device/CMD 4 1601 (0) 11601 (51) 11602 (10)

SDI-12 Device/CMD 5 1551 (0) 11801 (52) 11802 (10)
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SDI-12 Device Result Registers
The result registers store all information received from the SDI-12 devices.

The registers are 16-bit registers and require two registers to store a 32-bit value. The factory default configuration defines 
the result registers as 32-bit registers, floating point format, and the first nine result registers are enabled for use. A host 
system reads the SDI-12 device data from these registers.

Result Registers Register 1 Register 2 Register 3 Register 4 Register 5 Register 6

SDI-12 Device/CMD 1 Result Upper 11101 11103 11105 11107 11109 11111

SDI-12 Device/CMD 1 Result Lower 11102 11104 11106 11108 11110 11112

SDI-12 Device/CMD 2 Result Upper 11301 11303 11305 11307 11309 11311

SDI-12 Device/CMD 2 Result Lower 11302 11304 11306 11308 11310 11312

SDI-12 Device/CMD 3 Result Upper 11501 11503 11505 11507 11509 11511

SDI-12 Device/CMD 3 Result Lower 11502 11504 11506 11508 11510 11512

SDI-12 Device/CMD 4 Result Upper 11701 11703 11705 11707 11709 11711

SDI-12 Device/CMD 4 Result Lower 11702 11704 11706 11708 11710 11712

SDI-12 Device/CMD 5 Result Upper 11901 11903 11905 11907 11909 11911

SDI-12 Device/CMD 5 Result Lower 11902 11904 11906 11908 11910 11912

Result Registers Register 7 Register 8 Register 9 Register 10 Register 11 Register 12

SDI-12 Device/CMD 1 Result Upper 11113 11115 11117 11119 11121 11123

SDI-12 Device/CMD 1 Result Lower 11114 11116 11118 11120 11122 11124

SDI-12 Device/CMD 2 Result Upper 11313 11315 11317 11319 11321 11323

SDI-12 Device/CMD 2 Result Lower 11314 11316 11318 11320 11322 11324

SDI-12 Device/CMD 3 Result Upper 11513 11515 11517 11519 11521 11523

SDI-12 Device/CMD 3 Result Lower 11514 11516 11518 11520 11522 11524

SDI-12 Device/CMD 4 Result Upper 11713 11715 11717 11719 11721 11723

SDI-12 Device/CMD 4 Result Lower 11714 11716 11718 11720 11722 11724

SDI-12 Device/CMD 5 Result Upper 11913 11915 11917 11919 11921 11923

SDI-12 Device/CMD 5 Result Lower 11914 11916 11918 11920 11922 11924

SDI-12 Device Settings
The following are generic sampling, power, and warmup parameters that should work for all SDI-12 devices. See the tested 
device table below. In most cases, parameters will not need to be adjusted but if needed there are three common SDI-12 
device parameters that control the communications and power of the SDI-12 device. Contact Banner Engineering Corp 
support for more guidance.

Sample Rate. Formed using two 16-bit parameters, a HI word and a LOW word. The sample rate is how often the 
SDI-12 device is powered up, then interrogated for data. The value in the registers is the number of 0.010 second 
counts. For example, the default values are HI word (1) and LOW word (24,464), which after combining the words in 
hexadecimal will calculate to 90,000 × 0.010 seconds. Adjusting this value affects the battery life.
Warmup time. Amount of time to wait, in 0.010 second increments, from powering on the device to the time to send 
communications to the device. The default value is 200, or 200 × 0.010 seconds. Adjusting this value affects the 
battery life.
Voltage. The default voltage setting is approximately 6.7 volts or a register value of 148. Adjusting this value affects 
the battery life.
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Registers (Default Value)

Device / Cmd Configuration Enable Device 
Address

Switch 
Power 
Enable

Device 
Command Sample Hi Sample Low Warmup 

Time Voltage

SDI-12 Device/CMD 1 1751 (1) 11001 (48) 
(1) 1754 (4) 11002 (10) 1752 (1) 1753 

(24464) 1755 (200) 1756 (148)

SDI-12 Device/CMD 2 1701 (0) 11201 (49) 1704 (4) 11202 (10) 1702 (1) 1703 
(24464) 1705 (200) 1706 (148)

SDI-12 Device/CMD 3 1651 (0) 11401 (50) 1654 (4) 11402 (10) 1652 (1) 1653 
(24464) 1655 (200) 1656 (148)

SDI-12 Device/CMD 4 1601 (0) 11601 (51) 1604 (4) 11602 (10) 1602 (1) 1603 
(24464) 1605 (200) 1606 (148)

SDI-12 Device/CMD 5 1551 (0) 11801 (52) 1554 (4) 11802 (10) 1552 (1) 1553 
(24464) 1555 (200) 1556 (148)

These SDI-12 probes have been tested and are functional with the factory default settings.

MFG Models Technical Note

Acclima SEN-SDI (TDT SDI-12 Soil Moisture Sensor) SDI-12 and the Acclima TDT SDI-12 Soil Moisture Probe (p/n b_4182040)

Adcon Telemetry HydraProbeII

AquaCheck Sub-surface Probe SDI-12 and the AquaCheck Sub-Surface Soil Moisture Probe (p/n 
b_4182041)

Decagon MPS-2, MPS-6, 5TE, TS1, T8
SDI-12 and the Decagon 5TE Soil Moisture Probe (p/n b_4182042)
SDI-12 and the Decagon GS3 Soil Moisture Probe (p/n b_4182043)

SDI-12 and the Decagon MPS-2 Soil Moisture Probe (p/n b_4182044)

HSTI HydraScout SDI-12 and the HydraScout HSTI Probe (p/n b_4182045)

Sentek EnviroSCAN SDI-12 and the Sentek EnviroScan Soil Moisture Probe (p/n b_4182046)

https://info.bannerengineering.com/cs/groups/public/documents/literature/b_4182040.pdf
https://info.bannerengineering.com/cs/groups/public/documents/literature/b_4182041.pdf
https://info.bannerengineering.com/cs/groups/public/documents/literature/b_4182042.pdf
https://info.bannerengineering.com/cs/groups/public/documents/literature/b_4182043.pdf
https://info.bannerengineering.com/cs/groups/public/documents/literature/b_4182044.pdf
https://info.bannerengineering.com/cs/groups/public/documents/literature/b_4182045.pdf
https://info.bannerengineering.com/cs/groups/public/documents/literature/b_4182046.pdf
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Cellular Modem Board
The LTE-M (United States) or LTE-M/NB-IoT (outside the United States) cellular modem is an optional accessory that is 
installed on the processor board on the two 12-pin sockets.

A - U.FL antenna connection

The U.FL connector should be to the left, with the 
antenna cable going to the left antenna U.FL connector. 
The SIM card slides into the socket on the back of this 
board.

Cellular Power 
Requirements
If the incoming voltage drops below 11.2 V DC, the 
cellular modem does not turn on and will not turn on until 
the voltage is above 11.8 V DC. A text file (CmVMon.txt) 
on the internal micro SD card saves the periodic 
sampling of the incoming voltage. If cellular operation 
stops because of voltage, it is logged in this file.

Using the DXM Cellular 
Modem
The DXM cellular modem provides a remote network 
connectivity solution for the DXM.

To use the cellular modem:

Activating a Cellular Modem
Follow these basic steps, as detailed in this document, to activate the cellular capabilities of your DXM Controller.

Cellular Modem BoardsChapter 6 

Verify the cellular modem is installed and the correct antenna is connected to the cellular antenna port.1. 
Activate the cellular service.2. 
Configure the DXM to use the cellular network as the network interface.3. 

Purchase a cellular modem kit from Banner Engineering Corp.1. 
Install the cellular modem, connect the antenna cable, and connect the cellular antenna.2. 
Activate a cellular plan to the SIM card, then insert the SIM card into the cellular modem.3. 
Configure the DXM to use the cellular modem.4. 
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Purchase one of these cellular modem kit models

Cellular Kit Model Kit Description Important Notes

SXI-CATM1VZW-001

Verizon CAT M1 cellular modem using Telit ME910 modem 
kit (Verizon part number SXIM1V). Includes a cellular 
modem, SIM card, internal adhesive antenna, external SMA 
antenna, and antenna cable. The SIM card is specific to the 
LTE-M technology and cannot be used in other cellular 
modems. Requires a LTE Verizon cellular wireless plan 
attached to the ICCID (SIM card) number and IMEI 
(International Mobile Equipment Identity) number.
Cellular plans can be purchased through 
celldata.bannercds.com.

This cellular modem kit is for use in applications that 
require monthly data usage approaching 50 MB or 250 
MB with push intervals no more frequent than every 10 
minutes. This modem is only for use in the contiguous 
United States region.
Please visit our support site for more details on 
coverage areas and cellular plan pricing.

SXI-CATM1ATT-001

AT&T CAT M1 cellular modem using Telit ME910 modem kit 
(AT&T part number SXIM1A). Includes a cellular modem, 
SIM card, internal adhesive antenna, external SMA antenna, 
and antenna cable. The SIM card is specific to the LTE-M 
technology and cannot be used in other cellular modems. 
Requires a LTE AT&T cellular wireless plan attached to the 
ICCID (SIM card) number and IMEI (International Mobile 
Equipment Identity) number.
Cellular plans can be purchased through 
celldata.bannercds.com.

This cellular modem kit is for use in applications that 
require monthly data usage approaching 50 MB or 250 
MB with push intervals no more frequent than every 10 
minutes. This modem is only for use in the North 
American region.
Please visit our support site for more details on 
coverage areas and cellular plan pricing.

SXI-CATM1WW-001

Worldwide CAT M1 cellular modem using Telit ME910 model 
kit. Includes a cellular modem, SIM card, internal adhesive 
antenna, external SMA antenna, and antenna cable. The 
SIM card is specific to the LTE-M/NB-IoT technology and 
cannot be used in other cellular modems. Requires an LTE 
cellular plan attached to the ICCID (SIM card) number and 
IMEI (International Mobile Equipment Identity) number.
Cellular plans can be purchased through 
celldata.bannercds.com or a local roaming SIM provider.

This cellular modem kit is for use in applications that 
require monthly data usage approaching 50 MB or 250 
MB with push intervals no more frequent than every 10 
minutes. This modem is only for use in the European
region within those countries that are members of the 
EU/EEA and adopt RED/CE compliant products.
Please visit our support site for more details on 
coverage areas and cellular plan pricing.

SXI-LTE-001

Verizon LTE cellular modem using Telit LE910 modem kit 
(Verizon part number SENSX002). Includes a cellular 
modem, SIM card, antenna, and antenna cable. The SIM 
card is specific to the LTE technology and cannot be used in 
other cellular modems. Requires a LTE Verizon cellular 
wireless plan attached to the ICCID (SIM card) number and 
IMEI (International Mobile Equipment Identity) number.
Cellular plans can be purchased through 
celldata.bannercds.com or a local roaming SIM provider.

This cellular modem is only used with the Wireless 
Network Bridge Hub (NET-HUB).
Please visit our support site for more details on 
coverage areas and cellular plan pricing.

For additional information, refer to the Banner Cloud Data Services support center (support.bannercds.com). The support 
center includes video tutorials, product documentation, technical notes, and links to download configuration software.

IMPORTANT: Only the DXM100 and DXM150 models in conjunction with an SXI-LTE-001 (obsolete) 
cellular modem can offer SMS/text messaging capabilities directly from the device. Contact a support 
specialist at Banner Engineering for configuration instructions, or SMS/text messaging can be delivered 
using the Banner CDS web service from any DXM model. 

Install the Cellular Modem (DXM100, 150, 700, and 1000 Models)
Follow these steps to install the cellular modem and antenna cable.

IMPORTANT:
Electrostatic discharge (ESD) sensitive device
ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
Use proper handling procedures to prevent ESD damage. Proper handling procedures include 
leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps; 
and assembling units on a grounded, static-dissipative surface.

http://celldata.bannercds.com
http://support.bannercds.com/home/pricing/how-to-choose-a-cellular-service-plan/
http://celldata.bannercds.com
http://support.bannercds.com/home/pricing/how-to-choose-a-cellular-service-plan/
http://celldata.bannercds.com
http://support.bannercds.com/home/pricing/how-to-choose-a-cellular-service-plan/
http://celldata.bannercds.com
http://support.bannercds.com/home/pricing/how-to-choose-a-cellular-service-plan/
http://support.bannercds.com
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Installing the cellular modem

1

2 3

Install the Cellular Modem (DXM1200 Models)
Follow these steps to install the cellular modem and antenna cable.

IMPORTANT:
Electrostatic discharge (ESD) sensitive device
ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
Use proper handling procedures to prevent ESD damage. Proper handling procedures include 
leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps; 
and assembling units on a grounded, static-dissipative surface.

SIM cards come in a credit card sized carrier. Carefully snap it out of the carrier.1. 

Make note of the IMEI number of the cellular modem and the ICCID number of the SIM card.
The numbers can be found on the cellular modem and the SIM card or SIM card carrier. You will need the SIM 
number to associate a wireless plan to this SIM card.

2. 

Insert the SIM card into the socket on the underside of the cellular modem while ensuring the conductive pads on the 
SIM card are interfacing with the terminals of the modem.
There is a matching notch in the socket and SIM card that will only allow the SIM to be inserted with one orientation. 
Do not force the SIM card into the socket.

3. 

◦

◦

Orient the cellular modem according to the pin layout.

DXM100, 150, and 1000

Modem

*SIM card is located on the underside of installed modem

Antenna Cable

DXM700

Modem

*SIM card is located on the underside of installed modem

Antenna Cable

For the DXM100, DXM150, and DXM1000 models—Install the cellular modem board onto the processor 
board as shown. Use the diagram to verify the orientation is correct.
For the DXM700 models—Install the cellular modem board onto the base board as shown. Use the diagram to 
verify the orientation is correct.

4. 

Verify the pins are properly aligned.a. 
Verify the hole in the cell modem aligns with the hole on the DXM board.b. 
Firmly press the modem into the 24-pin socket.c. 

Attach the antenna cable between the cellular modem board to the base board as shown.5. 

Install the external cellular antenna on the DXM's SMA connector located next to the antenna cable.6. 
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Installing the cellular modem

1

2 3

Activate a 4G LTE CAT M1 Cellular Plan
Activate a cellular plan for your DXM using the Banner Cloud Data Services website.

SIM cards come in a credit card sized carrier. Carefully snap it out of the carrier.1. 

Make note of the IMEI number of the cellular modem and the ICCID number of the SIM card.
The numbers can be found on the cellular modem and the SIM card or SIM card carrier. You will need the SIM 
number to associate a wireless plan to this SIM card.

2. 

Insert the SIM card into the socket on the underside of the cellular modem while ensuring that the conductive pads on 
the SIM card are interfacing with the terminals of the modem.
There is a matching notch in the socket and SIM card that will only allow the SIM to be inserted with one orientation. 
Do not force the SIM card into the socket.

3. 

Apply the internal antenna as shown paying attention to the antenna cable position.4. 
Pull back the adhesive protective paper from the middle of the antenna, only exposing the middle portion. 
Antenna application is easier if just a small middle portion of the adhesive is uncovered.

a. 

Center the antenna on the side wall. Use the exposed adhesive in the middle of the antenna to hold the 
antenna in place while aligning the antenna to the full length of the housing.

b. 

Slowly peel off the paper backing exposing the adhesive and stick to the plastic housing. The antenna should 
run below the rim of the housing.

c. 

Press firmly.d. 

Orient the cellular modem according to the diagram below.
The cellular modem is inserted into the main board with the antenna cable from the applied internal antenna attached 
to the cellular modem PCB.

Internal view of a DXM1200

*SIM card is located on the underside of installed modem

Cell Modem

Antenna Cable

SIM card*
location Micro USB

ISM
Radio
Board

Cellular Antenna Placement

5. 

Verify the pins are properly aligned.a. 
Verify the hole in the cell modem aligns with the hole on the DXM board.b. 
Firmly press the modem into the 24-pin socket.c. 

Attach the antenna cable between the cellular modem board to the base board. The antenna cable uses the top 
antenna connection.

6. 

Go to celldata.bannercds.com to purchase cellular data plans.1. 

If you have previously created an account, click Login and enter your username and password to continue.2. 

If you are creating a login for the first time:3. 
Select the region in which the device will operate.a. 

http://celldata.bannercds.com
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Activate a Worldwide 4G LTE MNB-IOT Cellular Plan (RED-CE)
The Worldwide 4G LTE-M/NB-IOT cellular modem is operational in those European countries that are members of the EU/
EEA and adopt RED/CE-compliant products.

An international roaming SIM is provided with the Worldwide module and may be activated following the steps listed in 
"Activate a 4G LTE CAT M1 Cellular Plan" on page 43. However, there may be regions that are not covered by the provided 
SIM card. In this case, a local SIM card must be activated and operated with this device to acquire connectivity services.

Configure the DXM Controller for a Cellular Modem
Use the DXM Configuration Software to create a configuration using a cellular connection.

IMPORTANT: Only the DXM100 and DXM150 models in conjunction with an SXI-LTE-001 (obsolete) 
cellular modem can offer SMS/text messaging capabilities directly from the device. Contact a support 
specialist at Banner Engineering for configuration instructions, or SMS/text messaging can be delivered 
using the Banner CDS web service from any DXM model.  

Select the cellular subscription plan. Please use the calculator and regional coverage information to determine 
the plan needed for your device (https://www.bannerengineering.com/us/en/products/wireless-sensor-
networks/iot-cloud-cellular-data-services/cellular-data-plans/Service-Plan-Calculator.html).

b. 

Create a username and password (use an email address for the username).c. 
Enter your payment information, mailing address, agree to the terms and conditions.d. 

Go to the My Services and Equipment section.4. 

Enter the SIM Number (ICCID) and the Module Number (IMEI).
The ICCID is the 20-digit number of the SIM, the bottom barcode number on the SIM card carrier. If the carrier card is 
not available, the ICCID is also printed on the SIM card, but must be removed from its socket to be read. The IMEI is 
the 15-digit number on top of the 4G LTE device.

5. 

Click Activate.

Enter the ICCID and IMEI numbers then click Activate

Although new activations are typically functional in 20 minutes or less, it may take up to 24 hours for the cellular plan 
to become active on the wireless network.

6. 

Work with the local Banner technical support person to identify and purchase machine-to-machine (M2M) (data plan 
only) SIM cards in 3FF 'micro' form factor.
Typical monthly data use will be 20-50 MB per month. When choosing a plan, pay close attention to data rates.

1. 

When activating the SIM, note the Access Point Name (APN) that the SIM provider states to use with their SIM.
The IMEI is the 15-digit number on top of the cell module PCB, below the words Telit ME910G1-WW and above the 
barcode. The ICCID is the 20-digit number printed on the SIM card itself.

2. 

Go to the Settings › Cloud Services screen.1. 

Set the Push Interface to Cell
All push data will be sent using the cellular modem.

2. 

◦

◦

Go to the Settings › Cellular screen. Under the Cell Configuration section, select the Cell module from the drop-down 
list.

For the United States (contiguous)—For Verizon LTE/CATM modems, select SXI-LTE-001 or SXI-
CATM1VZW-001 and set the APN to vzwinternet.
For North America—For ATT LTE/CATM modems, select SXI-CATM1ATT-001 and set the APN to 
iot0119.com.attz. Requires a SIM module to be purchased from a wireless carrier based on the IMEI number 

3. 

https://www.bannerengineering.com/us/en/products/wireless-sensor-networks/iot-cloud-cellular-data-services/cellular-data-plans/Service-Plan-Calculator.html
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IMPORTANT: Banner Engineering offers several prepackaged solutions that report to the Banner Cloud 
Data Services web-based software platform via cellular connectivity. Many of these solutions execute the 
data push using a ScriptBasic file instead of the XML configuration file. If you are using a Banner 
prepackaged solution (ex. SOLUTIONSKIT9-VIBE), then you do not need to set the Cloud Push Interval
on the Settings › Cloud Services screen. You still need to set the Push Interface to Cell and select the 
appropriate Cell Module and APN.

When the DXM is configured to use the cellular modem, the information on the cellular modem is found on the LCD menu 
under System Info › Cell. The menu does not display values until a transaction with the wireless cell tower is complete.

The Settings › Cellular screen

If there are no webserver parameters defined, the user must force a push to retrieve the data from the cellular network. On 
the LCD menu, select Push › Trigger Data Push.

◦

of the cellular modem. The wireless carrier will provide the APN parameters. Not all parameters may be 
required.
For regions outside of North America—Select SXI-CATM1WW-001 and set the APN to m2m.tele2.com when 
using the SIM card provided with the kit from Banner Engineering. When using a local roaming SIM, please 
use the APN as suggested by your cellular connectivity (SIM) provider.

To send data to the webserver, complete the parameters on the Settings › Cloud Services screen. Set the Cloud push 
interval and the Web Server settings. (For more information, refer to the DXM Configuration Software Instruction 
Manual (p/n 201127).

The Settings › Cloud Services screen

4. 

http://info.bannerengineering.com/cs/idcplg?IdcService=GET_FILE&dDocName=201127&RevisionSelectionMethod=Latest&Rendition=web
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Obtaining LTE service outside of the Banner Cellular Data Plans—Customers have the option of securing a data plan for the 
Verizon network themselves without using the Banner cellular data portal (celldata.bannercds.com). Suitable plans would 
include those available from Verizon directly or from a Mobile Virtual Network Operator (MVNO) licensed to resell Verizon 
network data plans. (The SXI-LTE-001 or SXI-CATM1VZW-001 will not function on AT&T, T-Mobile, or Sprint networks.) 
When purchasing a data plan, it is important to refer to the modem by its official Verizon network name (for example, 
SENSX002) and give the IMEI number (found on the cellular modem) to the plan provider. To use the SIM card that comes 
with the cellular modem kit, give the SIM card number to the provider. The required SIM card form factor is 3FF - Micro.

http://celldata.bannercds.com
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The LCD has four user-defined LED indicators, four control buttons, and an LCD. The four buttons control the menu system 
on the LCD menu.

The top-level menu always displays the time in a 24-hour 
format.

The up and down arrows scroll through display items.
The ENTER button selects the highlighted items on the 
display.
The BACK button returns to a previous menu option.

The left display column shows an arrow at the beginning of the 
line if the menu has submenus. The right column shows a 
vertical line with an arrow at the bottom if the user can scroll 
down to see more menu items.

The DXM can be configured to require a passcode be entered 
before the LCD and Menu system will operate. The passcode 
configuration is defined in the DXM Configuration Software.

Registers
The Registers submenu displays the processor's local registers that can be configured using the DXM Configuration 
Software.

Registers menu

Registers List of Local Register
Values and the Register Name to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓

To configure these local registers, launch the DXM Configuration Software. Go to Local Registers and expand the view for a 
local register by clicking on the down arrow next to the register number. In the LCD Permissions field, select None, Read, 
Write, or Read/Write.

Read allows the register to be displayed and Write or Read/Write allows the register value to be changed using the LCD. The 
Units and Scaling parameters are optional and affect the LCD.

LCD and Menu SystemChapter 7 
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Push
The Push menu displays information about the last data sent to the Webserver.

Push menu

Push Trigger Data Push Trigger Data Push

to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓Status
Time (hh:mm:ss)

The user can force an immediate push to the webserver using Trigger Push. If a current push is in process it may take 
several minutes to complete over cellular.

The Trigger Push submenu forces an immediate push to the web server.
The status and time fields indicate the success or failure of the last attempted push and the time of the last attempted 
push.

ISM Radio
The ISM Radio menu allows the user to view the Modbus ID of the internal ISM radio, enter binding mode, or run a site 
survey. This top-level ISM Radio menu is different from the System Config › ISM Radio submenu.

ISM Radio menu

ISM Radio MultiHop/DX80 ID

Binding

Site Survey

Bind to > 1

Node/Modbus ID > 1

to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓

Please Wait...

Site Survey results OR Failed to start Site Survey

The first option under the ISM Radio menu only displays the type of radio in the DXM (MultiHop or DX80 Star) and the 
Modbus ID of the radio. To change the ISM Radio Modbus ID refer to the System menu.

Select Binding to enter binding mode or select Site Survey to run a site survey.

Binding— All ISM radio devices must be bound to the internal Gateway/client device before the DXM can access wireless 
devices. The first submenu under binding allows the user to set the wireless address of the device to bind with. This is 
required to bind with wireless devices that do not have rotary dials (for example M-GAGEs, ultrasonic sensors, and Q45 
devices). See "Binding and Conducting a Site Survey with the ISM Radio" on page 15. For more information on binding a 
particular device, refer to the individual datasheet.

Site Survey—After creating a wireless network using the binding process, run a site survey on each device to see the link 
quality. See "Conduct a Site Survey from the DXM" on page 17.

IO Board
Use the I/O Board menu to view input values, output values, input counters values, and the charger status on the DXM I/O 
board. To change the configuration parameters, use the System Config menu.
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I/O Board menu

I/O Board Inputs

Outputs

Counters

Charger

Input 1
Input 2
Input 3
Input 4

Output 1
Output 2
Output 3
Output 4
Output 5
Output 6

Counter 1
Counter 2
Counter 3
Counter 4

Supply (V)
Battery (V)
Charging (A)
Charge (%)

to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓

The I/O Board menu includes the following submenus.
Inputs

Lists the inputs. Depending upon the input type, the value and 
unit's information will also be displayed.

Outputs
The DXM base configuration can include discrete, current, or 
voltage outputs. The output values will be displayed based on 
their configuration settings.

Counters
Counters on the DXM base board are associated to inputs but 
the count value is stored in a different register. Adjust or view 
the count registers using the LCD menu.

Charger
The on-board solar/battery charger of the DXM stores 
information about the charging circuit in Modbus registers. 
Use the LCD menu to view information about the incoming 
voltage, charging current, battery voltage, and battery charge 
percentage.

System Config
Use the System Config menu to set DXM system parameters.

System Config menu

System Config ISM Radio

to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓

I/O Board

Ethernet

Provision Cell
DXM Modbus ID: xxx
LCD Contrast: xx
Restart

DX80 ID: x
Auto Detect Radio

Advanced Options

Max Node Count: xx
Binding #: xxxxxx
RF Ctrl: Dip 1.00W

Ref Type: DX80
Ref Modbus ID: x

New ISM Modbus ID: x
Radio Detected Type: DX80
ID: 1

New ISM Max Nodes: xx
New ISM Binding Code: xxxxxx

Inputs

Outputs

Counters
Charger

Input x In Type:
Cnt Rise:
Cnt Fall:

Output x Default:
Type:
Voltage:

Charger: DC

DHCP Update DHCP Mode
IP:
SN:
GW:
Reset

Update IP Address
Update SN
Update GW Address
Resets Ethernet parameters
to xml defaults.

After making changes to the
Ethernet settings, restart the DXM.
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ISM Radio
DX80/MultiHop ID—The ISM radio is set at the factory to be Modbus device address 1 (Modbus ID 1). For some applications, 
you may need to change the Modbus ID. Adjust the Modbus device address using the LCD menu system. Any other method 
may cause issues with the DXM not knowing which Modbus device address is assigned to the radio, which causes issues 
with running Binding or Site Survey from the LCD menu.

Set the radio Modbus ID to a valid number (1 through 247) that is not being used by the DXM system. Processor Local 
Registers allocate ID 199, the I/O board is set to ID 200, and the display board is set to ID 201. With a DX80 Gateway (star 
network), it's easy to choose a new ID. With a MultiHop network, remember that the client MultiHop radio allocates a range of 
Modbus IDs for wireless devices, typically 11 through 110.

When setting the new ISM Modbus ID, the system changes the Modbus ID on the internal radio and changes the reference to 
it on the DXM. The reference Modbus ID is what the DXM uses to access the internal radio when running Binding or Site 
Survey.

Auto Detect Radio—If the internal Modbus ID of the radio was changed or the internal radio was changed, but not recorded, 
use Auto Detect Radio to determine the radio ID and radio type. The auto-detect routine broadcasts discovery messages and 
waits for a response. If other devices are connected to the external RS-485 ports, they may need to be disconnected for this 
process to work properly.

Advanced Options—The Advanced Options menu is typically not used unless the Modbus ID is changed without the DXM
being involved, such as when you write directly to the radio Modbus registers.

Reference Type selects the radio type between DX80 star architecture radios and a MultiHop radio. The DXM uses 
this reference to determine how to communicate to the internal radio. If set incorrectly, the DXM may not be able to 
run Site Survey from the LCD menu. Unless you are changing or adding the internal radio device, there should no 
reason to change the radio type.
Reference Modbus ID defines the Modbus ID the DXM uses when communicating with the internal radio. If this is set 
incorrectly, the DXM will not be able to run Binding or Site Survey through the LCD menu.

Max Node Count—Defines the maximum number of devices for the DX80 wireless network.

Binding #—This parameter allows the user to define the Binding code within the ISM radio. Typically, you will not have to 
adjust this number unless you are replacing an existing Gateway or client radio.

RF Ctrl—Displays the status of the ISM radio DIP switch 1 (off or on). The menu doesn't allow the user to change the DIP 
switch setting through the display.

IO Board
Use the System Config › I/O Board submenu to change the configuration parameters for the inputs, outputs, counters, and 
charger.

Use the Inputs menu to change the input type. The universal inputs on the DXM are defined from the factory as sinking 
inputs. To change the input type:

Input parameters

Input Type Description

Sinking Discrete input, low active, 0 = ON, 1 = OFF

Sourcing Discrete input, high active, 1 = ON, 0 = OFF

Current Analog input, 0–20 mA

Voltage Analog input, 0–10 V DC

Thermistor 2* Thermistor input, 10k - J (r-t curve), beta(K) 3890

Thermistor 1* Thermistor input, 10k - G (r-t curve), beta(K) 3575

Counter Description

In Type Sinking or sourcing

Continued on page 51

Go to the System Config › I/O Board › Inputs menu.1. 
Select which input to change.2. 
Select the input type. The available parameters include the Input Type and the Counter Edge Detect.3. 
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Continued from page 50

Counter Description

Cnt Rise Increment the count when the input transitions from 0 -> 1

Cnt Fall Increment the count when the input transitions from 1 -> 0

Use the Output menu to change the default condition, output type, and switched power voltage.

Output parameters

Output Type Description

Default Force output registers to a default condition if the I/O board has not been communicated with for a user-defined 
time. The communications timeout parameter must be set to use the Default condition.

Type Select the output type: NMOS Sinking, Switch Power (Swch Pwr), Analog.

Voltage Outputs defined as switched power can adjust the voltage: 5 V or 16 V

Use the Charger menu to change the charging algorithm for the battery. This parameter can also be set by writing Modbus 
register 6071 of the I/O board. See "Supplying Power from a Solar Panel" on page 31.

Charger parameters

Charger Parameters Description

DC Used when 12–24 V DC power supplies connected to the DXM power pins and the attached batteries are used as 
backup batteries. This limits the current during the battery charging process. (factory default setting)

Solar Select Solar when a solar panel is connected to the power pins of the DXM. Solar panels are current limited by 
their design and therefore can charge the battery without managing the input power.

Ethernet
Use the Ethernet submenu to sets the IP Address, Gateway Address, and Subnet mask of the DXM's Ethernet interface. You 
may change these settings either from the LCD menu (System Config › Ethernet) or from the XML configuration file created 
by the DXM Configuration Software.

The network address settings from the LCD menu have the highest priority and override settings in the XML configuration file. 
To use the parameter settings from the XML configuration file or use DHCP, execute the Reset under System 
Config › Ethernet or use the LCD to set the IP Address, Gateway Address, and Subnet Mask to 255.255.255.255. Reboot the 
DXM after changing the Ethernet parameters.

The Ethernet cable should be attached before powering up the DXM.

Provision Cell
If the DXM has a cellular modem installed, the modem must be provisioned on the network. This menu provisions the cellular 
modem on the network. For step-by-step directions, see "Using the DXM Cellular Modem" on page 40.

DXM Modbus ID
Use the secondary Modbus RS-485 port when the DXM is connected to a Modbus RTU network as a Modbus server device. 
Set the Modbus ID for the secondary RS-485 port using the LCD menu System Config › DXM Modbus ID.

LCD Contrast
Use the LCD Contrast option to adjust the LCD contrast. Adjust the starting number lower to decrease the display contrast. 
The factory default is 28. Do not set a number less than 15 or the display may not be bright enough to see to change back.

Reset
Use the Restart menu to force the main processor to restart. This does not affect the other boards in the system.
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System Info
Various DXM system settings are shown in this menu. The Push, Ethernet, and Cell parameters are helpful for debugging 
network connections. This is a read-only menu.

System Info menu

System Info Controller

Push

ISM Radio

IO Board

Date:
Firmware:
Build:
Model:
Serial:
Method:
Interval: hh:mm
URL:
Page:
Https: on/off
Site ID:

Serial:
Model:
Date:
RF FW Pt:
RF FW Ver:
RF EE Pt:
RF EE Ver:
Serial:
Model:  
Date:
RF FW Pt:
RF FW Ver:
RF EE Pt:
RF EE Ver:

to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓

Ethernet DHCP:
IP:
Subnet:
Gate:
Mac:
DNS1:
DNS2:

Cell Signal:
Phn#:
Dev#:
SIM:
CellVer:
CellMdl:
CellFw:
CellMask:

Wifi IP:
Mode:
AP:
Stat:

Script Path:
Baud:
Code:  

LCD Board Serial:
Model:
Date:
RF FW Pt:
RF FW Ver:
RF EE Pt:
RF EE Ver:

Cell
Shows the cellular MEID number (Mobil Equipment Identifier), 
MDN (Mobil Device Number), version, signal, firewall setting, 
and firewall mask. Some of these parameters are not visible 
until the cellular network is accessed.

Controller
Displays the date, build, model, and serial number.

Ethernet
Displays the IP address, MAC address, DHCP, Gateway 
address, and DNS settings.

I/O Board
Displays the serial number, model, date, firmware part 
numbers, and version numbers.

ISM Radio
Displays the serial number, model, date, firmware part 
numbers, and version numbers.

LCD Board
Displays the serial number, model, date, firmware part 
numbers, and version numbers.

Push
Shows the current parameters loaded from the XML 
configuration that applies to pushing data to a web server, 
including method (Ethernet or cellular), interval, URL, page, 
HTTPS, and site ID.

Sript
Displays the name of the ScriptBasic file running.

Wi-Fi
Displays the Wi-Fi IP address and other settings.
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Display Lock
Display Lock protects the DXM LCD menu system from being used until the proper passcode is entered.

Display Lock menu

Display Lock Enter password
>> x to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓

The display lock feature uses the configuration software to set a passcode within the DXM. A valid passcode is 1 to 9 digits 
long and uses numbers 0 through 9. For example, 1234 or 209384754.
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Overview of the configuration software features

USB

DXM Configuration Software

Local Registers

System
Settings

Register Mapping

Action Rules

Scheduler

ScriptBasic

Register
View Utility

XML Config File
Ethernet
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DXM Configuration Software
Download the latest version of all configuration software from http://
www.bannerengineering.com. For more information on using the DXM 
Configuration Software, refer to the instruction manual (p/n 209933).

The configuration software configures the DXM client by creating an XML file 
that is transferred to the DXM client using a USB or Ethernet connection. The 
DXM client can also receive the XML configuration file from a Web server 
using a cellular or Ethernet connection.

This configuration file governs all aspects of the DXM client and server 
operation.

The wireless network devices are a separate configurable system.  Use the 
DX80 Performance Configuration Software to configure the internal DX80 
client radio and the wireless server nodes bound to it. Use the MultiHop 
Configuration Software if the internal radio is a MultiHop device.

All configuration software can be connected to the DXM client using a USB 
cable or an Ethernet connection.

Save and Upload the Configuration 
File
After making any changes to the configuration, you must save the configuration files to your computer, then upload it to the 
device.

Changes to the XML file are not automatically saved. Save your configuration file before exiting the tool and before sending 
the XML file to the device to avoid losing data. If you select DXM › Send XML Configuration to DXM before saving the 
configuration file, the software will prompt you to choose between saving the file or continuing without saving the file.

Configuration InstructionsChapter 8 

Save the XML configuration file to your hard drive by going to the File › Save As menu.1. 

◦

◦
◦

Go to the DXM › Send XML Configuration to DXM menu.

Status indicator bar

If the Application Status indicator is red, close and restart the DXM Configuration Tool, unplug and re-plug in 
the cable and reconnect the DXM to the software.
If the Application Status indicator is green, the file upload is complete.
If the Application Status indicator is gray and the green status bar is in motion, the file transfer is in progress.

After the file transfer is complete, the device reboots and begins running the new configuration.

2. 

http://www.bannerengineering.com
http://info.bannerengineering.com/cs/idcplg?IdcService=GET_FILE&dDocName=209933&RevisionSelectionMethod=Latest&Rendition=web
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Register flow

Remote DevicesEthernet/USB/Cellular

Processor

Local
Registers

Display I/O Base Internal
Radio

Register Flow and Configuration
The DXM register data flow goes through the Local Registers, which are data 
storage elements that reside within the processor.

Using the DXM Configuration Software, the controller can be programmed to 
move register data from the Local Register pool to remote devices, the 
internal radio, the I/O base (if applicable), or the display.

Basic Approach to Configuration
When programming an application in the DXM, first plan the overall data 
structure of the Local Registers. The Local Registers are the main storage 
elements in the DXM. Everything goes into or out of the Local Registers.

Troubleshooting a Configuration
View Local Registers using the Local Registers  › Local Registers in Use screen of the DXM Configuration Software.

When a configuration is running on the DXM, viewing the Local Registers can help you to understand the application's 
operation. This utility can also access data from remote devices.

To configure the Local Register data to display on the LCD menu, go to the Local Registers screen, set the LCD permissions
to read or read/write.

Saving and Loading Configuration Files
The DXM Configuration Software saves its configuration information in an XML file. Use the File menu to Save or Load 
configuration files.

Save the configuration file before attempting to upload the configuration to the DXM. The DXM Configuration Software
uploads the configuration file saved on the PC to the DXM; it will not send the configuration loaded in the tool.

Uploading or Downloading Configuration Files
The DXM requires an XML configuration file to become operational. To upload or download configuration files, connect a 
computer to the DXM using the USB port or Ethernet port. Then use the Upload Configuration to Device or Download 
Configuration from Device under the Device menu.

Scheduler
Use the Scheduler screens to create a calendar schedule for local register changes, including defining the days of the week, 
start time, stop time, and register values.

Schedules are stored in the XML configuration file, which is loaded to the DXM. Reboot the DXM to activate a new schedule.

If power is cycled to the DXM in the middle of a schedule, the DXM looks at all events scheduled that day and processes the 
last event before the current time.

For screens that contain tables with rows, click on any row to select it. Then click Clone or Delete to copy/paste or remove 
that row. 

In the DXM Configuration Software, name the Local Registers to 
provide the beginning structure of the application.

1. 

Configure the read/write rules to move the data. The Read/Write rules 
are simple rules that move data between devices (Nodes, Modbus 
servers, sensors, etc) and the Local Registers.

2. 

Most applications require the ability to manipulate the Local Register 
data, not just move data around. Use the Action rules to make 
decisions or transform the data after the data is in the Local Registers. 
Action rules can apply many different functions to the Local Register 
data, including conditional statements, math operations, copy 
operations, or trending.

3. 

To perform scheduled events in Local Registers, go to the Scheduler screen in the DXM Configuration Software. 
These rules provide the ability to create register events by day of the week. The scheduler can also create events 
based on sunrise or sunset.

4. 
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Create a Weekly Event
Use the Tools › Scheduler › Weekly Events screen to define weekly events.

Scheduler > Weekly Events screen

Register updates can be changed up to two times per day for each rule. Each rule can be set for any number of days in the 
week by clicking the buttons M, T, W, Th, F, S, or Su.

If two register changes are defined for a day, define the start time to be before the end time. Select End Value to enable the 
second event in a 24-hour period. To span across two days (crossing the midnight boundary), set the start value in the first 
day, without selecting End Value. Use the next day to create the final register state.

Start and end times can be specified relative to sunrise and sunset, or set to a specific time within a 24-hour period. When 
using sunrise or sunset times, set the GPS coordinates on the device so it can calculate sunrise and sunset.

Create a One-Time Event
Define one-time events to update registers at any time within a calendar year.

Similar to Weekly events, the times can be specific or relative to sunrise or sunset. Define one-time events using the 
Tools › Scheduler › One Time Events screen.

Scheduler > One Time Events screen

Click Add Weekly Event.
A new schedule rule is created.

1. 

Click on the arrow to the left of the new rule to expand the parameters into view.
The user-defined parameters are displayed.

2. 

Name your new rule.3. 

Enter the local register.4. 

Select the days of the week this rule applies to.5. 

Enter the starting value for the local register.6. 

Use the drop-down list to select the type of Start at time: a specific time or a relative time.7. 

Enter the starting time.8. 

Enter the end time and end value for the local register.9. 

Click on Add One Time Event.
A new one-time event is created.

1. 

Click on the arrow to expand the parameters into view.
The user-defined parameters are displayed.

2. 

Name your one-time event by clicking on the name link and entering a name.3. 
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Create a Holiday Event
Use the Tools › Scheduler › Holidays screen to create date and/or time ranges that interrupt weekly events.

Scheduler > Holidays screen

Authentication Setup
The DXM has three areas that can be configured to require login and password authentication.

Webserver/ Cloud Services Authentication
Mail Server Authentication
DXM Configuration Authentication

The webserver and mail server authentication depends upon the service provider.

Set the Controller to use Authentication
The DXM can be configured to send login and password credentials for every HTTP packet sent to the webserver. This 
provides another layer of security for the webserver data.

Configuration requires both the webserver and the DXM to be given the same credentials for the login and password. The 
webserver authentication username and password are not stored in the XML configuration file and must be stored in the 
DXM.

Controller Configuration Authentication
The DXM can be programmed to allow changes to the configuration files only with proper authentication by setting up a 
password on the Settings › Administration screen in the DXM Configuration Software.

With the DXM connected to the PC, click Get Device Status. The DXM status displays next to the button.

Enter the local register.4. 

Enter the starting time, date, and starting value for the local register.5. 

Enter the ending time, date, and ending value for the local register.6. 

Click on Add Holiday.
A new rule is created.

1. 

Enter a name your new holiday rule.2. 

Select the start date and time for the new holiday.3. 

Select the stop date and time for the new holiday.4. 

From within the DXM Configuration Software, go to the Settings › Cloud Services screen.1. 

In the upper right, select Show advanced settings.2. 

Web Server Authentication screen

Define the username and password in the Web Server Authentication section of the screen.
The first time you select Require Authentication, a pop-up box appears 
with additional instructions. Since the data is not stored in the XML 
configuration file, it is hidden from view of the DXM Configuration 
Software.

3. 

Click on Send Authentication.
The controller must be connected to the PC for this operation to 
succeed.
The data transmits directly to the DXM's non-volatile memory. If 
successful, a pop-up window appears, asking to reboot the device.

4. 

Select Yes to reboot the device.5. 
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Settings > Administration screen

Use the DXM Configuration Software to:
Set the Admin Password
Change the Admin Password
Remove the Admin Password

To change or remove an admin password, the current password must be supplied. The DXM must be connected to the PC to 
change the administration password.

The DXM can be unlocked without knowing the administration password, but doing this erases the configuration program, 
logging files, and any ScriptBasic program on the device. For instructions on how to do this, see the "Additional Information" 
on page 63 section.

EtherNetIP Configuration
The DXM is defined from the factory to send/receive register data from the Gateway and the first 16 Nodes with an EtherNet/
IP™(1) host.

To expand the number of devices going to Ethernet/IP, change the Devices in system parameter in the DX80 Gateway 
(default setting is 8) to 32. To change this value:

This allows the user to maximize the use of the EtherNet/IP buffer to 28 devices.

EDS (Electronic Data Sheet) files allow users of the EtherNet/IP protocol to easily add a Banner DXM device to the PLC. 
Download the EDS files from the Banner website.

DXM EDS Configuration File (for PLCs) (p/n b_4205242)
DXM EIP Config File for DXM Controller with Internal Gateway (Models: DXM1xx-BxR1, DXM1xx-BxR3, and 
DXM1xx-BxCxR1) (p/n 194730)

Download an Existing Configuration from the DXM
If you have an existing configuration file, save the XML file locally as a backup on your computer.

Launch the the DX80 Configuration Software.1. 
In the menu bar, go to Device › Connection Settings and select Serial or Ethernet DXM.2. 
In the Configuration › Device Configuration screen, click on the arrow next to the Gateway to expand and display the 
Gateway's parameters.

3. 

In the System section, use the Devices in system drop-down list to make your selection.4. 

Apply power to the DXM.1. 

Connect an ethernet or USB cable between your computer and the DXM.2. 

Launch the DXM Configuration Software v4 and select your DXM model.3. 

◦
◦

On the Device › Connection Settings menu, select one of the following:
Select TCP/IP as the connection type and enter the IP Address of the DXM Controller; or
Select Serial as the connection type and select the appropriate Comm port

4. 

On the menu bar, select Device › Get XML configuration from DXM to download the XML configuration file.5. 

Save the XML file locally on your computer.6. 

http://info.bannerengineering.com/cs/idcplg?IdcService=GET_FILE&dDocName=b_4205242&RevisionSelectionMethod=Latest&Rendition=web
http://info.bannerengineering.com/cs/idcplg?IdcService=GET_FILE&dDocName=194730&RevisionSelectionMethod=Latest&Rendition=web
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Configuring the Controller
Use the configuration software to define the Protocol conversion for each local register to be EIP Originator › DXM or EIP 
DXM › Originator from the Edit Register or Modify Multiple Register screens.

Define a DXM local register as EIP Originator › DXM when the host PLC (Originator) will send data to the DXM local register 
(DXM).

Define a DXM local register as EIP DXM › Originator when that register data will be sent from the DXM (DXM) to the host 
PLC (Originator).

Data from an EIP controller in assembly instance 112 is data destined for the DXM local registers. The PLC is normally 
configured for INT or UINT data transfer. This allows for a seamless transfer of data.

EIP Assembly Instance 112 (16-bit) DXM Local Registers

Adrs Data Adrs Data

0 1122 1 1122

1 3344 2 3344

2 5566 3 5566

3 7788 4 7788

4 9900 5 9900

Data from the DXM local registers is sent to the EIP controller using assembly instance 100. Each local register in the DXM
defined as EIP DXM › Originator is collected in numerical order and placed into the data buffer destined for assembly 
instance 100. DXM local registers are capable of 32-bits, but only the lower 2-bytes (16-bits) for each local register are 
transferred.

EIP Assembly Instance 100 (16-bit) DXM Local Registers

Adrs Data Adrs Data

0 1122 11 1122

1 3344 12 3344

2 5566 13 5566

3 7788 14 7788

4 9900 15 9900

Configure Local Registers to Export Data to a PLC

Configure Local Registers to Import Data from a PLC

To view the EIP Input and Output registers, go to the Tools › Protocol Conversion screen. You may also export the register 
map to a CSV file.

On the DXM Configuration Software: Go to the Local Registers screen.1. 

Select the register(s) that will be exported to a Host PLC.
A maximum of 228 registers can be read or written with Ethernet/IP.

2. 

In the Storage/Connectivity section, select EIP DXM -> Originator from the Protocol conversion drop-down list.
To change a block of continuous local registers, use the Modify Multiple Registers screen.

3. 

On the DXM Configuration Software: Go to the Local Registers screen.1. 

Select the register(s) that will be imported from a Host PLC.
A maximum of 228 registers can be read or written with Ethernet/IP.

2. 

In the Storage/Connectivity section, select EIP Originator -> DXM from the Protocol conversion drop-down list.
To change a block of continuous local registers, use the Modify Multiple Registers screen.

3. 
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Save and Upload the Configuration File
After making any changes to the configuration, you must save the configuration files to your computer, then upload it to the 
device.

Changes to the XML file are not automatically saved. Save your configuration file before exiting the tool and before sending 
the XML file to the device to avoid losing data. If you select DXM › Send XML Configuration to DXM before saving the 
configuration file, the software will prompt you to choose between saving the file or continuing without saving the file.

Configuring the Host PLC
On the host PLC, install the DXM using an EDS file or by using the following parameters:

Assembly1: Originator to DXM = Instance 112, 456 bytes (228 words)
Assembly2: DXM to Originator = Instance 100, 456 bytes (228 words)

The Originator is the host PLC system, and the DXM is the DXM. The host system sees the DXM as a generic device with 
the product name of Banner DXM (ProdType: 43 - Generic Device, ProdName: Banner DXM, Integer Type - INT).

IMPORTANT: Do not set the Requested Packet Interval (RPI) any faster than 150 ms.

Define the Network Interface Settings
On the Cloud Services screen (shown with Show advanced settings selected), define the network connection settings by 
selecting Ethernet or Cell from the Network Interface drop-down list. This determines how the DXM sends data.

If you don't require pushing data to a web server, set the Cloud Push interval to zero.

Cloud Services screen

Configure your Ethernet Connection
When selecting Ethernet, go to the Settings › Ethernet screen.

Save the XML configuration file to your hard drive by going to the File › Save As menu.1. 

◦

◦
◦

Go to the DXM › Send XML Configuration to DXM menu.

Status indicator bar

If the Application Status indicator is red, close and restart the DXM Configuration Tool, unplug and re-plug in 
the cable and reconnect the DXM to the software.
If the Application Status indicator is green, the file upload is complete.
If the Application Status indicator is gray and the green status bar is in motion, the file transfer is in progress.

After the file transfer is complete, the device reboots and begins running the new configuration.

2. 
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Settings > Ethernet screen

Configure your Cellular Connection
To use a cellular connection, select Cell as the network connection on the Settings › Cloud Services screen (see "Configure 
the DXM Controller for a Cellular Modem" on page 44). The Cellular screen does not display unless the Network interface is 
set to Cell.

Using a 4G LTE cell module requires a cellular plan; follow the instructions on p/n 205026 to activate a cell modem.

Ethernet and Cellular Push Retries
The DXM can be configured to send register data packets to a webserver. When the Ethernet or cell communications path is 
not operating, the DXM retries the send procedure. The communications retry process is outlined below for each 
configuration.

Regardless of the communications type (Ethernet or cellular), a failed attempt results in the register data packet being saved 
on the local storage device(1). The number of retries will depend upon the network connection type.

When there is bad cellular signal strength or there is no Ethernet connection, the transmission attempts are not counted as 
failed attempts to send data. Only when there is a good network connection and there are 10 failed attempts will the 
controller archive the data on the local storage device. Data archived on the local storage device must be manually retrieved.

To define the Ethernet IP address, give the DXM a static IP address. In most cases, you may select the device to use 
DHCP and have the IP address automatically assigned.

1. 

DNS settings are not typically required. The DXM uses a public service to resolve Domain names, but if the network 
connection does not have Internet access, the DNS settings may be required.

2. 

On the Settings › Cellular screen, select your cellular modem from the drop-down list.1. 

◦
◦
◦
◦

Set the APN.
If you are using a Banner 4G LTE-M Verizon Module (ME910C1), set the APN to vzwinternet.
If you are using a Banner 4G LTE AT&T Module (ME910C1), set the APN to iot0119.com.attz.
If you are using a Banner 4G LTE-M/NB-IoT Worldwide Module (ME910G1), set the APN to m2m.tele2.com.
If you are using a third-party SIM card, the APN, APN Username, and Password must be provided by the 
cellular service provider.

2. 

http://info.bannerengineering.com/cs/idcplg?IdcService=GET_FILE&dDocName=205026&RevisionSelectionMethod=Latest&Rendition=web
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Ethernet Push Retries
With an Ethernet-based network connection, the DXM retries a message five times. The five retry attempts immediately 
follow each other. After all attempts are exhausted, the register data packet is saved on the local storage device.

At the next scheduled time, the DXM attempts to send the saved packet as well as the newly created register data packet. If 
it cannot send the new register data packet, the new register data packet is appended to the saved file on the local storage 
device to be sent later. After 10 rounds of retries, the data set is archived on the local storage device under folder _sxi. No 
additional attempts to resend the data are made; the data file must be manually retrieved.

Using SSL on Ethernet will have no retries but will save each failed attempt to the local storage device until 10 failed rounds. 
At this time, the register data packet is archived.

Cellular Push Retries
In a cellular-connected system there are no retries. Failed transmissions are saved on the local storage device.

After 10 successive failed attempts, the data is archived in the _sxi folder.

Send attempts with a low signal quality are not counted against the 10-count limit. For example, if the cellular antenna is 
disconnected for period that the DXM controller would have sent 20 messages under normal circumstances, all 20 messages 
would be saved and will be retried when the antenna is reconnected.

If the signal quality was good, but the cellular network was not responding, the DXM archives the register data packets after 
10 failed attempts.

Event-Action Rule or Log File Push Retries
Event-based pushes caused by Action rules follow the same process when failures occur, based on the network connection. 
The failed Event-based messages are resent with the next cyclical schedule or the next event message that triggers a push 
message.
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Working with Modbus Devices
The DXM has two physical RS-485 connections using Modbus RTU protocol.

The DXM can be a Modbus RTU client device to other server devices and can be a Modbus server device to another Modbus 
RTU client. The DXM uses the primary RS-485 port (M+/M-) as a Modbus RTU client to control external server devices. All 
wired devices connected to the client RS-485 port must be server devices. 

As a Modbus RTU client device, the DXM controls the external server connected to the primary RS-485 port, the local 
ISM radio, the local I/O base board, and the local display board. 
As a Modbus RTU server device, the DXM local registers can be read from or written to by another Modbus RTU 
client device. 

The secondary port (S+/S-) is the Modbus RTU server connection. The secondary (server) Modbus RS-485 port (S+/S-) is 
controlled by another Modbus client device, not the DXM. The server port is used by an external Modbus client device that 
will access the DXM as a Modbus server device. 

Processor Modbus system overview

Processor Modbus
Control/Data

Lo cal
Registers

ISM
Radio Display I/O Base

Board

Ethernet

Modbus RS-485
(server port)

External
Modbus
Servers (2-10)

Modbus RS-485
(client port)

The DXM has dual Modbus roles: a Modbus server device and a Modbus client device. These run as separate processes.

The Modbus server port can only access the DXM local registers. To operate as a Modbus server device, the DXM needs to 
be assigned a unique Modbus ID as it pertains to the host Modbus network. This ID is separate from the internal Modbus IDs 
the DXM uses for its own Modbus network. The DXM Modbus ID is defined through the LCD menu. Other Modbus server 
port parameters are defined by using the configuration software.

The DXM operates the Modbus client port. Each device on the client port must be assigned a unique Modbus ID. There are 
Modbus IDs that are reserved for internal devices in the DXM.

Additional InformationChapter 9 
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DXM Internal Modbus IDs (factory default) 

Modbus ID  Device 

1  DX80 Performance Gateway or MultiHop ISM Radio—MultiHop wireless devices connected to the internal MultiHop radio 
should be assigned Modbus IDs starting at 11. 

199  Local Registers—Internal storage registers of the DXM 

200  I/O Base Board—All data and parameters for each input or output of the DXM. 

201  LCD Display—The user has access to the LED indicators on the DXM. 

Assigning Modbus IDs
Assign the DXM Modbus ID only if a Modbus client device is reading or writing the DXM Local Register data through the 
Modbus RS-485 server port (S+, S-).

Set the DXM ID from the LCD menu under System › DXM Server ID. The DXM can have any unique ID between 1 and 246, 
depending upon the host Modbus network. Other RS-485 server port parameters are set in the configuration software under 
the Settings › General tab.

DXM Client Configuration—When the DXM operates as a Modbus client device, use the configuration software to configure 
read or write operations of the DXM Modbus network. The DXM communicates with all internal and external peripheral 
devices using the external Modbus bus RS-485 (M+, M-)

configured from the factory with Modbus IDs. Assign IDs 2 through 10 to Modbus server devices that are physically wired to 
the DXM. Assign IDs 11 through 60 to wireless server devices within the MultiHop network.

Do not assign an ID of greater than 10 to Modbus server devices that are physically wired using the RS-485 port if there is an 
internal MultiHop ISM radio in the DXM. The MultiHop ISM radio attempts to send any Modbus data intended for IDs 11 
through 60 across the radio network, which conflicts with wired server devices if the IDs overlap. The MultiHop client radio 
can be changed from the factory default of 11 through 60 Modbus IDs if more hardwired servers are required.

Wireless and Wired Devices
Wireless DX80 Gateway—The DX80 Gateway architecture is a star architecture in which all Nodes in the system send their 
data back to the Gateway. The host can access the entire network data from the Gateway, which is Modbus ID 1. Because 
the DXM will not be sending any Modbus messages across the wireless link, the timeout parameter can be set low (less than 
1 second) and the device is treated like a directly connected device.

MultiHop Client—The MultiHop client radio forms a wireless tree network using repeaters and servers. Each device in a 
MultiHop network must be assigned a unique Modbus ID and accessed as a separate device. For the DXM to talk with a 
MultiHop device in the wireless network, the client MultiHop device interrogates every message on the RS-485 bus. If they 
are within the wireless device range (IDs 11 through 60), the message is sent across the wireless network. To change this 
range, the user must adjust the offset and range setting in the MultiHop client radio (Modbus ID 1). Modbus register 6502 
holds the Modbus offset (default 11). Modbus register 6503 holds the number of Modbus servers allowed (maximum of 100).

Modbus IDs for wireless and wired devices

Modbus ID Description

1 Allocated for the internal ISM radio device, either a DX80 Gateway or MultiHop client radio

2–10 Server addresses available for directly connected Modbus server devices to the client RS485 port (M+ , M-)

11–60 Allocated for wireless MultiHop radio network devices. If there is not an internal MultiHop in the DXM, these server 
addresses are available to use for directly connected devices.

61–198 Available to users for directly connected Modbus server devices or the expansion of the wireless network server IDs to go 
past 50 wireless devices.

199 Allocated for internal Local Register

200 Allocated for the I/O base board; will be different for special DXM server-only models.

201 Allocated for the LCD board, the user can read/write LEDs.

Modbus Communication Timeouts
A Modbus timeout is the amount of time a Modbus server is given to return an acknowledgment of a message sent by the 
Modbus client. If the Modbus client waits for the timeout period and no response is seen, the Modbus client considers it a lost 
message and continues on to the next operation.
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The timeout parameter is simple to set for Modbus devices directly connected to the DXM, if there are no MultiHop wireless 
devices. Special considerations need to be made to set the timeout parameter when a MultiHop network uses the DXM as 
the client radio.

Configure controllers operating wireless networks to allow for enough time for hardware transmission retries. Set the 
Communications Timeout parameter to cover the expected time for messages to be sent throughout the wireless network. 
For the DXM, the Communications Timeout parameter is the maximum amount of time the DXM should wait after a request is 
sent until the response message is received from the Modbus server device. Use the DXM Configuration Software to set the 
timeout parameter on the Settings › System screen (select Show advanced settings).

The default setting for the timeout parameter is 5 seconds.

MultiHop Networks vs DX80 Star Networks
The DX80 star Gateway collects all the data from the Nodes, which allows the host system to directly read the data from the 
Gateway without sending messages across the wireless network. This allows for DX80 Gateway to be treated like any other 
wired Modbus device.

In a MultiHop network, the data resides at each device, forcing the controller to send messages across the wireless network 
to access the data. For this reason, carefully consider the value of the wireless timeout parameter.

Calculating the Communications Timeout for Battery-Powered MultiHop Radios
Battery-powered MultiHop radios are configured to run efficiently to maximize battery life. By optimizing battery life, the 
allowed communications window to receive messages is slow (once per 1.3 seconds) and sending message rates are 
standard (once per 0.04 seconds).

A MultiHop device is set from the factory with the retry parameter of 8. This means that under worst-case conditions, a 
message is sent from the DXM to an end device a total of nine times (one initial message and eight retry messages). The 
end device sends the acknowledgment message back to the DXM a maximum of nine times (one initial message and eight 
retries). A single Modbus transaction may send up to two messages + 16 retry messages before the transaction is complete. 
In addition, the radios randomly wait up to one time period before retransmitting a retry message. So to allow for the random 
wait time, add one extra time period for each in-between time of retries.

To calculate the communication timeout parameter for a client to a server radio (no repeaters):
Client to Server Send time = (9 × 1.3 sec) + (8 retry wait × 1.3 sec) = 22 seconds
Server to Client Send time = (9 × 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Total Send/Receive time = 23 seconds
Minimum Timeout period = 23 seconds

If the link quality of the network is poor, the maximum transfer times may happen. Set the timeout parameter to accommodate 
the maximum number of retries that may happen in your application.

When MultiHop repeaters are added to the wireless network, each additional level of hierarchical network increases the 
required timeout period. Since MultiHop repeaters are running at the highest communications rate, the overall effect is not as 
great.

Client to Repeater Send time = (9 × 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Repeater to Client Send time = (9 × 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Additional Timeout period for a repeater = 2 seconds

Using the timeout calculation above of 23 seconds, if a repeater is added to the network the timeout should be set to 25 
seconds. For each additional MultiHop repeater device creating another level of network hierarchy, add an additional two 
seconds to the timeout period.

Calculating the Communication Timeout for 10–30 VDC MultiHop Radios
Line-powered (10–30 V DC) MultiHop devices operate at the maximum communication rate, resulting in a much lower 
timeout parameter setting. For each repeater added to the network, increase the timeout parameter 2 seconds.

For a client radio to a 10–30 V DC powered server radio (no repeaters):
Client to Server Send time = (9 × 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Server to Client Send time = (9 ×* 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Total send/receive time = 2 seconds
Minimum timeout period = 2 seconds
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Adjusting the Receive Slots and Retry Count Parameters
The number of receive slots governs how often a MultiHop device can communicate on the wireless network.

Battery-powered devices typically have DIP switches that allow the user to set the number of receive slots, which directly 
affects the battery life of the radio. Adjusting the receive slots changes how often a message can be received. By default, the 
receive slots are set to 4 (every 1.3 seconds). When the receive slots are set to 32, the radio listens for an incoming message 
every 0.16 seconds.

Users may also leave the retry mechanism to the application that is accessing the wireless network, in this case the DXM. 
Adjust the number of retries in the MultiHop devices by writing the number of retries desired to Modbus register 6012. The 
factory default setting is 8.

Calculating the Communication Timeout for a DX80 Star Network
In the DX80 network, all Node data is automatically collected at the Gateway to be read. The DXM does not use the wireless 
network to access the data, which allows for much faster messaging and much lower timeout values.

For a DXM with an internal DX80 Gateway, set the timeout value 0.5 seconds. If other Modbus devices are connected to the 
RS-485 lines, the timeout parameter governs all communication transactions and must be set to accommodate all devices on 
the bus.

Modbus TCP Client
The DXM can operate as a Modbus TCP client on Ethernet. Users may define up to five socket connections for Modbus TCP 
server devices to read Modbus register data over Ethernet. Use the DXM Configuration Software to define and configure 
Modbus TCP client communications with other Modbus TCP servers.

Modbus Register Summary
DXM Modbus Registers
The DXM may have up to four internal Modbus server devices.

All Modbus registers are defined as 16-bit Modbus Holding Registers. When connecting external Modbus server devices, 
only use Modbus IDs 2 through 198. The local registers, the I/O base, and the LCD IDs are fixed, but the internal radio ID can 
be changed if needed.

DXM Internal Modbus IDs (factory default)

Modbus ID Device

1 DX80 Performance Gateway or MultiHop ISM Radio—MultiHop wireless devices connected to the internal MultiHop radio 
should be assigned Modbus IDs starting at 11.

199 Local Registers—Internal storage registers of the DXM

200 I/O Base Board—All data and parameters for each input or output of the DXM.

201 LCD Display—The user has access to the LED indicators on the DXM.

Modbus Registers for the MultiHop Radio Board Module
The DX80 MultiHop client radio is a tree-based architecture device that allows for repeater radios to extend the wireless 
network. Each device in a MultiHop network is a Modbus device with a unique Modbus ID.

Modbus registers in a MultiHop network are contained within each individual radio device. To obtain Modbus register data 
from a MultiHop device, configure the DXM to access each device across the wireless network as an individual Modbus 
server device.

Example MultiHop Modbus registers with generic devices.

MulitHop Device Modbus ID Modbus Registers

DXM client radio 1 none

Server radio 11 Modbus register 1–16 are inputs, 501–516 are outputs

Repeater radio 12 Modbus register 1–16 are inputs, 501–516 are outputs

Continued on page 67
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Continued from page 66

MulitHop Device Modbus ID Modbus Registers

Server radio 15 Modbus register 1–16 are inputs, 501–516 are outputs

Modbus Registers for the Performance Gateway Radio Module
The DX80 Performance Gateway is a star-based architecture device that contains all the Modbus registers for the wireless 
network within the Gateway. To access any input or output values within the entire wireless network, read the appropriate 
Modbus register from Gateway.

There are 16 Modbus registers allocated for each device in the wireless network. The first 16 registers (1–16) are allocated 
for the Gateway, the next 16 (17–32) are allocated for Node 1, the next 16 (33–48) are allocated for Node 2 and so forth. 
There are no inputs or outputs on the DXM embedded Gateway but the Modbus registers are still allocated for them.

Although only seven Nodes are listed in the table, the Modbus register numbering continues for as many Nodes as are in the 
network. For example, the register number for Node 10, I/O point 15 , is 175. Calculate the Modbus register number for each 
device using the equation:

Register Number = I/O# + (Node# × 16)

Modbus holding registers

 I/O Point   Gateway   Node 1   Node 2   Node 3   Node 4   Node 5   Node 6   Node 7 

1  1  17  33  49  65  81  97  113 

2  2  18  34  50  66  82  98  114 

3  3  19  35  51  67  83  99  115 

4  4  20  36  52  68  84  100  116 

5  5  21  37  53  69  85  101  117 

6  6  22  38  54  70  86  102  118 

7  7  23  39  55  71  87  103  119 

8  8  24  40  56  72  88  104  120 

9  9  25  41  57  73  89  105  121 

10  10  26  42  58  74  90  106  122 

11  11  27  43  59  75  91  107  123 

12  12  28  44  60  76  92  108  124 

13  13  29  45  61  77  93  109  125 

14  14  30  46  62  78  94  110  126 

15  15  31  47  63  79  95  111  127 

16  16  32  48  64  80  96  112  128 

Access all wireless network registers by reading Modbus ID 1

DX80 Device Modbus ID Modbus Registers

DXM Gateway radio 1 Modbus registers 1–8 are inputs, 9–16 are outputs

Node 1 - Modbus registers 17–24 are inputs, 25–32 are outputs

Node 2 - Modbus registers 33–40 are inputs, 41–48 are outputs

Node 3 - Modbus registers 49–56 are inputs, 57–64 are outputs
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Alternative Modbus Register Organization
The Sure Cross DX80 Alternative Modbus Register Organization registers are used for reordering data registers to allow host 
systems to efficiently access all inputs or outputs using a single Modbus command. The register groups include the input/
output registers, bit-packed registers, and analog registers. This feature is only available with the Performance models using 
version 3 or newer of the LCD firmware code.

Alternative Modbus register organization

Name Modbus Register Address (Decimal)

Inputs and Outputs, in order by device 2201 through 4784

Discrete Bit Packed (Status, Discrete Inputs, Discrete Outputs) 6601 through 6753

Analog Inputs (1–8) and Analog Outputs (1–8) 6801 through 9098

Input Registers and Outputs Registers
Modbus registers 2201 through 2584 are used to organize all inputs together.

In this format, users can sequentially read all input registers using one Modbus message. Modbus registers 4401 through 
4784 organize all outputs together to allow users to sequentially write to all output registers using one Modbus message.

Input and output registers

Inputs (2201–2584) Outputs (4401–4784)

Modbus Register Address (Decimal) 16-bit Register Value Modbus Register Address (Decimal) 16-bit Register Value

2201–2208 Gateway Inputs 1 through 8 4401–4408 Gateway Outputs 1 through 8

2209–2216 Node 1 Inputs 1 through 8 4409–4416 Node 1 Outputs 1 through 8

2217–2224 Node 2 Inputs 1 through 8 4417–4424 Node 2 Outputs 1 through 8

... ... ... ...

2577–2584 Node 47 Inputs 1 through 8 4777–4784 Node 47 Outputs 1 through 8

Refer to your device's datasheet for a list of the active inputs and outputs. Not all inputs or outputs listed in this table may be 
active for your system.

Discrete Bit-Packed Registers
Discrete bit-packed registers include the discrete status registers, discrete inputs, and discrete outputs.

Bit packing involves using a single register, or range of contiguous registers, to represent I/O values.

When networks use similar Nodes to gather data using the same I/O registers for each Node, discrete data from multiple 
Nodes can be bit packed into a single register on the Gateway. The bit-packed data is arranged by I/O point starting at 
Modbus register 6601. For example, Discrete IN 1 for all the Nodes in the network is stored in three contiguous 16-bit 
registers.

The most efficient way to read (or write) discrete data from a Sure Cross® DX80 Gateway is by using these bit-packed 
registers because users can read or write registers for all devices using one Modbus message. The following registers 
contain discrete bit-packed I/O values for the Gateway and all Nodes. Values are stored first for the Gateway, then for each 
Node in order of Node address.
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Discrete bit-packed register addresses and bit positions
Bit-Packed Device Status Registers

Bit Position
Register Address 15 14 13 12 11 10
6601 Node 15 Node 14 Node 13 Node 12 Node 11 Node 10 Node 9 Node 8 Node 7 Node 6 Node 5 Node 4 Node 3 Node 2 Node 1 Gateway
6602 Node 31 Node 30 Node 29 Node 28 Node 27 Node 26 Node 25 Node 24 Node 23 Node 22 Node 21 Node 20 Node 19 Node 18 Node 17 Node 16
6603 Node 47 Node 46 Node 45 Node 44 Node 43 Node 42 Node 41 Node 40 Node 39 Node 38 Node 37 Node 36 Node 35 Node 34 Node 33 Node 32

Bit-Packed Discrete Input 1

Register Address 15 14 13 12 11 10
6611 Node 15 Node 14 Node 13 Node 12 Node 11 Node 10 Node 9 Node 8 Node 7 Node 6 Node 5 Node 4 Node 3 Node 2 Node 1 Gateway
6612 Node 31 Node 30 Node 29 Node 28 Node 27 Node 26 Node 25 Node 24 Node 23 Node 22 Node 21 Node 20 Node 19 Node 18 Node 17 Node 16
6613 Node 47 Node 46 Node 45 Node 44 Node 43 Node 42 Node 41 Node 40 Node 39 Node 38 Node 37 Node 36 Node 35 Node 34 Node 33 Node 32

Bit-Packed Discrete Output 1

Bit Position
Register Address 15 14 13 12 11 10
6691 Node 15 Node 14 Node 13 Node 12 Node 11 Node 10 Node 9 Node 8 Node 7 Node 6 Node 5 Node 4 Node 3 Node 2 Node 1 Gateway
6692 Node 31 Node 30 Node 29 Node 28 Node 27 Node 26 Node 25 Node 24 Node 23 Node 22 Node 21 Node 20 Node 19 Node 18 Node 17 Node 16
6693 Node 47 Node 46 Node 45 Node 44 Node 43 Node 42 Node 41 Node 40 Node 39 Node 38 Node 37 Node 36 Node 35 Node 34 Node 33 Node 32

Bit Position

Discrete bit-packed registers for inputs and outputs

Inputs Outputs

Modbus Register Address 
(Decimal)

Description (Inputs) Modbus Register Address 
(Decimal)

Description (Outputs)

6601–6603 Status for all devices

6611–6613 Input 1 from all devices 6691–6693 Output 1 from all devices

6621–6623 Input 2 from all devices 6701–6703 Output 2 from all devices

6631–6633 Input 3 from all devices 6711–6713 Output 3 from all devices

6641–6643 Input 4 from all devices 6721–6723 Output 4 from all devices

6651–6653 Input 5 from all devices 6731–6733 Output 5 from all devices

6661–6663 Input 6 from all devices 6741–6743 Output 6 from all devices

6671–6673 Input 7 from all devices 6751–6753 Output 7 from all devices

6681–6683 Input 8 from all devices

Status registers (6601–6603) contain a bit-packed representation defining the devices that are operational in the wireless 
system. Each bit indicates Node in Sync (1) or Node Not in Sync (0).

A one (1) written to the Discrete Status Register area indicates the device is active within the wireless system. A zero (0) 
indicates the device is not active within the wireless network.

Input registers from all devices use Modbus registers 6611 through 6683 to organize the least significant bit into a sequential 
array of registers. The first register contains the least significant bit from the input values for the Gateway through Node 15. 
The second register contains the input values for Node 16 through Node 31, and the third register contains the input values 
for Nodes 32 through 47.

For discrete inputs, only the least significant bit is used. For analog inputs, the least significant bit indicates if the analog 
value is above or below the selected threshold value (when using the threshold parameter configured in the User 
Configuration Software). For example, a least significant bit of one (1) indicates the analog value is above the selected 
threshold value. A least significant bit of zero (0) indicates the analog value is below the threshold value.

Output registers from all devices use Modbus registers 6691 through 6753 to organize the least significant bit into a 
sequential array of registers. Output 8 (I/O point 16) cannot be written using the discrete format.
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Analog 16-Bit Registers (Registers 6801 through 9098)
The most efficient way to read (or write) analog data from a Gateway is by using these 16-bit analog registers. Most networks 
consist of similar Nodes reporting data using the same I/O registers for each Node. For this reason, the analog data is 
arranged by I/O point using Modbus registers 6801 through 9098.

For example, Input 1 for Gateway and all Nodes is stored in the first 48 contiguous blocks of 16-bit analog registers, 
beginning with register 6801.

In this format, users can read a 16-bit holding register for all devices or write to a register for all devices using one Modbus 
message. Using these registers is the most efficient way to read all status registers, read all analog inputs, or write all analog 
outputs.

The following registers contain analog I/O values for the Gateway and all Nodes. Values are stored first for the Gateway, then 
for each Node in order of Node address.

Analog input and output registers

Inputs Outputs

Modbus Register Address 
(Decimal)

Description (Inputs) Modbus Register Address 
(Decimal)

Description (Outputs)

6801 Input 1 for Gateway 8001 Output 1 for Gateway

6802 Input 1 for Node 1 8002 Output 1 for Node 1

6803 Input 1 for Node 2 8003 Output 1 for Node 2

... ... ... ...

6951 Input 2 for Gateway 8151 Output 2 for Gateway

6952 Input 2 for Node 1 8152 Output 2 for Node 1

6953 Input 2 for Node 2 8153 Output 2 for Node 2

... ... ... ...

7101 Input 3 for Gateway 8301 Output 3 for Gateway

7102 Input 3 for Node 1 8302 Output 3 for Node 1

7103 Input 3 for Node 2 8303 Output 3 for Node 2

... ... ... ...

7851 Input 8 (Status Register) for Gateway 9051 Output 8 for Gateway

7852 Input 8 (Status Register) for Node 1 9052 Output 8 for Node 1

7853 Input 8 (Status Register) for Node 2 9053 Output 8 for Node 2

... ... ... ...

For example, 6801 contains the input 1 value for the Gateway, 6802 contains the input 1 value for Node 1, and 6848 contains 
the input 1 value for Node 47.

Internal Local Registers (ID 199) for the DXM100 and DXM150
The main storage elements for the DXM are its Local Registers, which can store 4-byte values that result from register 
mapping, action rules, or ScriptBasic commands.

Local Registers 1 through 850 are standard 32-bit unsigned registers.
Local Registers 851 through 900 are non-volatile registers that are limited to 100,000 write cycles.
Local Registers 1001 through 1900 are floating point format numbers. Each register address stores half of a floating 
point number. For example, registers 1001 and 1002 store the first full 32-bit floating point number.
Local Registers 10001 through 19000 are system, read-only, registers that track DXM data and statistics.

Modbus Registers for Internal Local Registers (Modbus ID 199)

Local Registers Type Description

1–845 32-bit unsigned Internal processor memory

Continued on page 71
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Continued from page 70

Local Registers Type Description

846–849 32-bit unsigned Reset, Constant, Timer

851–900 32-bit unsigned Data flash, non-volatile

1001–1900 32-bit IEEE Floating Point Floating point registers, internal processor memory

> 10000 Read-only virtual registers

Local Registers 1–850 (Internal Processor Memory, 32-bit, Unsigned)—The Local Registers are the main global pool of 
registers. Local Registers are used as basic storage registers and as the common data exchange mechanism. External 
Modbus device registers can be read into the Local Registers or written from the Local Registers. The DXM, as a Modbus 
client device or a Modbus server device, exchanges data using the Local Registers. Modbus over Ethernet (Modbus/TCP) 
uses the Local Registers as the accessible register data.

Local Registers 851–900 (Data Flash, Non-volatile, 32-bit, Unsigned)— The top 50 Local Registers are special non-volatile 
registers. The registers can store constants or calibration type data that must be maintained when power is turned off. This 
register data is stored in a data flash component that has a limited write capability of 100,000 cycles, so these registers 
should not be used as common memory registers that change frequently.

Local Registers 1001–1900 (32-bit IEEE Floating Point)— These Local Registers are paired together to store a 32-bit IEEE 
floating point format number in big endian format. Registers 1001 [31:16], 1002 [15:0] store the first floating point value; 
registers 1003, 1004 store the second floating point number. There are a total of 500 floating point values; they are 
addressed as two 16-bit pieces to accommodate the Modbus protocol. Use these registers when reading/writing external 
devices that require Modbus registers in floating point format. Since Modbus transactions are 16-bits, the protocol requires 
two registers to form a 32-bit floating point number.

Virtual Registers— The DXM has a small pool of virtual registers that show internal variables of the main processor. Some 
register values will be dependent upon the configuration settings of the DXM. Do not use Read Rules to move Virtual Local 
Registers data into Local Registers. Use the Action Rule › Register Copy function to move Virtual Local Registers into Local 
Registers space (1-850).

Virtual registers

Virtual Registers Definition

10001 GPS latitude direction (N, S, E, W)

GPS Coordinate Data if the DXM is configured to read an external GPS 
unit.

10002 GPS latitude

10003 GPS longitude direction (N, S, E, W)

10004 GPS longitude

10011–10012 Resync timer Engineering use

10013–10014 Resync timer rollover Engineering use

10015–10016 Reboot cause (Restart Codes above) Reboot Type

10017–10018 Watchdog reset count Counter to track how many resets have been caused by the Watchdog

10021 IO Board Battery Voltage (mV) mV

10022 IO Board - Incoming Supply Voltage (mV) mV

10023 Cut-off Feature
0—No successful readings
1—Normal range

2—Cut-off engaged

10024 IO Board - Battery Charging Current (mA) mA

10025–10026 HTTP Push SSL Acquires
Statistical counts of connections, disconnections and forced disconnects 
when the DXM creates a connection using SSL/TLS (Encrypted 
connections)

10027–10028 HTTP Push SSL Releases

10029–10030 HTTP Push SSL Forced Releases

10031–10032 HTTP Push Attempts
Statistical counts of connections, disconnections and forced disconnects 
when the DXM controller creates a connection using HTTP non-encrypted10033–10034 HTTP Push Successes

10035–10036 HTTP Push Failures

Continued on page 72
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Virtual Registers Definition

10037–10038 HTTP Push Last Status

Last DXM push status
0 = Initial state, no push attempt as finished yet
1 = Attempt complete
2 = Attempt aborted

10039–10040 Cellular Strength, BER

Cellular signal strength. Value range: 0–31
0 = –113 dBm or less
1 = –111 dBm
2–30 = –109 dBm through –53 dBm in 2 dBm steps
31 = –51 dBm or greater
99 = not known or not detectable; BER not used

10055–10056 Alarms, SMTP, attempts Email attempts (only available with some model configurations)

10057–10058 Alarms, SMTP, fails Email failures (only available with some model configurations)

10059–10060 Alarms, SMS, attempts SMS text message attempts (only available with some model 
configurations)

10061–10062 Alarms, SMS, fails SMS text message failures (only available with some model configurations)

10100 Number of read maps in default

Read Map statistics

10101 Number of read map successes

10102 Number of read map timeouts

10103 Number of read map errors

10104 Read map success streak

10105 Number of write map successes

Write Map statistics
10106 Number of write map timeouts

10107 Number of write map errors

10108 Write map success streak

10109 Number of passthrough successes

API message passing statistics
10110 Number of passthrough timeouts

10111 Number of passthrough errors

10112 Passthrough success streak

10113 Number of 43 buffer successes

DX80 Gateway automatic messaging buffer statistics
10114 Number of 43 buffer timeouts

10115 Number of 43 buffer errors

10116 43 buffer success streak

11000 Read map success count

Read/Write maps statistics

12000 Write map success count

13000 Read map timeout count

14000 Write map timeout count

15000 Read map error count

16000 Write map error count

17000 Read map success streak

18000 Write map success streak

19000 Read map is in default

The reset codes are in virtual register 11015 and define the condition of the last restart operation.

Reset Code Definition

0 Undefined

1 Unknown

Continued on page 73
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Reset Code Definition

2 General

3 Brownout

4 Watchdog

5 User

6 Software

7 Return from backup mode

Internal Local Registers (ID 199) for the DXM700, DXM1000, and DXM1200
The main storage elements for the DXM are its local registers, which can store 4-byte values that result from register 
mapping, action rules, or ScriptBasic commands.

Local registers updated from Modbus transactions are restricted to a 16-bit data value to follow standard Modbus holding 
register definition.

The local registers defined in action rules must all be within the same register group. For example, an action rule cannot have 
inputs from an integer group with the result register defined as a floating point register. To move between integers and floats, 
use the Register Copy Rule.

Local registers 1–850 and 5001–7000 are 32-bit integer registers
Local registers 851–900 and 7001–8000 are non-volatile 32-bit integer registers
Local registers 901-1000 are reserved for internal use
Local registers 1001–5000 are floating point format numbers, each address stores half of a floating point number; for 
example, registers 1001 and 1002 store the first full 32-bit floating point number
Local registers 10000 and higher are read-only virtual registers; virtual registers collect various system-level data

Modbus registers for internal local registers (Modbus ID 199)

Local Registers Type Description

1–845 32-bit integer Local data registers

846–849 32-bit integer Reset, Constant, Timer

851–900 32-bit non-volatile integer Data flash, non-volatile

901–1000 Reserved for internal use

1001–5000 Floating point Floating point registers, local data registers

5001–7000 32-bit integer Local data registers

7001–8000 32-bit non-volatile integer Data flash, non-volatile

> 10000 Read-only virtual registers, system-level data

Local registers 1–850 and 5001–7000 (Internal Processor Memory, 32-bit, Unsigned)—The local registers are the main 
global pool of registers. Local registers are used as basic storage registers and as the common data exchange mechanism. 
External Modbus device registers can be read into the local registers or written from the local registers. The DXM, as a 
Modbus client device or a Modbus server device, exchanges data using the local registers. Modbus over Ethernet (Modbus/
TCP) uses the local registers as the accessible register data.

Local registers 851–900 and 7001–8000 (Data Flash, Non-volatile, 32-bit, Unsigned)—The top 50 local registers are special 
non-volatile registers. The registers can store constants or calibration-type data that must be maintained when power is 
turned off. This register data is stored in a data flash component that has a limited write capability of 100,000 cycles, so these 
registers should not be used as common memory registers that change frequently.

Local registers 1001–5000— These local registers are paired together to store a 32-bit IEEE floating point format number in 
big-endian format. Registers 1001 [31:16], 1002 [15:0] store the first floating point value; registers 1003, 1004 store the 
second floating point number. There are a total of 2000 floating point values; they are addressed as two 16-bit pieces to 
accommodate the Modbus protocol. Use these registers when reading/writing external devices that require Modbus registers 
in floating-point format. Since Modbus transactions are 16 bits, the protocol requires two registers to form a 32-bit floating 
point number.
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Virtual registers—The DXM has a small pool of virtual registers that show the internal variables of the main processor. Some 
register values will be dependent upon the configuration settings of the DXM. Do not use Read Rules to move virtual local 
registers data into local registers. Use the Action Rule › Register Copy function to move virtual local registers into local 
registers space (1–850).

Modbus registers for virtual registers

Registers Definition

10001 GPS latitude direction (N, S, E, W)

GPS Coordinate Data if the DXM is configured to read an external GPS unit.
10002 GPS latitude

10003 GPS longitude direction (N, S, E, W)

10004 GPS longitude

10011–10012 Resync timer Engineering use

10013–10014 Resync timer rollover Engineering use

10015–10016 Reboot cause (Restart Codes above) Reboot Type

10017–10018 Watchdog reset count Counter to track how many resets have been caused by the Watchdog

10021 IO Board Battery Voltage (mV) mV (Not applicable for DXM700 or DXM1200 models)

10022 IO Board - Incoming Supply Voltage (mV) mV (Not applicable for DXM700 or DXM1200 models)

10023 IO Board Voltage Cut-off Feature
0—No successful readings (Not applicable for DXM700 or DXM1200 models)
1—Normal range

2—Cut-off engaged

10024 IO Board - Battery Charging Current (mA) mA (Not applicable for DXM700 or DXM1200 models)

10025–10026 Http Push SSL Acquires
Statistical counts of connections, disconnections and forced disconnects when the 
DXM creates a connection using SSL/TLS (Encrypted connections)10027–10028 Http Push SSL Releases

10029–10030 Http Push SSL Forced Releases

10031–10032 Http Push Attempts
Statistical counts of connections, disconnections and forced disconnects when the 
DXM controller creates a connection using HTTP non-encrypted10033–10034 Http Push Successes

10035–10036 Http Push Failures

10037–10038 Http Push Last Status

Last DXM push status
0 = Initial state, no push attempt as finished yet
1 = Attempt complete
2 = Attempt aborted

10039–10040 Cellular Strength, BER

Cellular signal strength. Value range: 0–31
0 = –113 dBm or less
1 = –111 dBm
2–30 = –109 dBm through –53 dBm in 2 dBm steps
31 = –51 dBm or greater
99 = not known or not detectable; BER not used

10055–10056 Alarms, smtp, attempts Email attempts (only available with some model configurations)

10057–10058 Alarms, smtp, fails Email failures (only available with some model configurations)

10100 Number of read maps in default

Read Map statistics

10101 Number of read map successes

10102 Number of read map timeouts

10103 Number of read map errors

10104 Read map success streak

10105 Number of write map successes

Write Map statistics
10106 Number of write map timeouts

10107 Number of write map errors

10108 Write map success streak

10109 Number of passthrough successes API message passing statistics
Continued on page 75
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Continued from page 74

Registers Definition

10110 Number of passthrough timeouts

10111 Number of passthrough errors

10112 Passthrough success streak

10113 Number of 43 buffer successes

DX80 Gateway automatic messaging buffer statistics
10114 Number of 43 buffer timeouts

10115 Number of 43 buffer errors

10116 43 buffer success streak

11000 Read map success count

Read/Write maps statistics

12000 Write map success count

13000 Read map timeout count

14000 Write map timeout count

15000 Read map error count

16000 Write map error count

17000 Read map success streak

18000 Write map success streak

19000 Read map is in default

TCP Client Statistics--The "x" represents the socket 0 through 4. The flex socket is not used. This range repeats for the next socket.

Register Definition

2x001 Socket x connection attempts (20001 is the first socket, 21001 is the second socket...)

2x003 Socket x connections

2x005 Socket x disconnections

2x007 Socket x transmits

2x009 Socket x receives

2x011 Socket x resolver attempts (reserved)

2x013 Socket x resolvers (reserved)

2x015–2x020 Reserved

2x021 Socket x Rule 0 transmits

2x023 Socket x Rule 0 receives

2x025 Socket x Rule 0 timeouts

2x027 Socket x Rule 0 broadcasts

2x029 Reserved

2x031 Socket x Rule 1 transmits

2x033 Socket x Rule 1 receives

2x035 Socket x Rule 1 timeouts

2x037 Socket x Rule 1 broadcasts

2x039 Reserved

Reset Codes—The reset codes are in virtual register 11015 and define the condition of the last restart operation.

Reset Code Definition

0 Undefined

1 Unknown

Continued on page 76
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Continued from page 75

Reset Code Definition

2 General

3 Brownout

4 Watchdog

5 User

6 Software

7 Return from backup mode

Modbus IO Registers for the B1 IO Base Board
The I/O base board stores the input and output values in Modbus holding registers. Since the I/O base board is defined as a 
separate device, configure the DXM to read or write the values on the I/O base board.

Base Board Input Connection

Modbus Register Range Description

1 0–65535 Universal input 1

2 0–65535 Universal input 2

3 0–65535 Universal input 3

4 0–65535 Universal input 4

Universal Input Register Ranges

Register Types Unit Minimum Value Maximum Value

Discrete input/output 0 1

Universal input 0 to 10 V mV 0 10000 *

Universal input 0 to 20 mA µA 0 20000 *

Universal input temperature (–40 °C to +85 °C) C or F, signed, in tenths of a 
degree –400 850

Universal potentiometer unsigned 0 65535

* Setting Enable Full Scale to 1 sets the ranges to a linear scale of 0 to 65535.

B1 Controller Base Board Output Connection

Modbus Register Range Description

501 0–1 NMOS Output 1

502 0–1 NMOS Output 2

503 0–1 NMOS Output 3

504 0–1 NMOS Output 4

505 0–1 Switched Power 1 (5 V or 16 V)

506 0–1 Switched Power 2 (5 V or 16 V)

507
0–20000 Analog Output 1 default (0-20.000 mA)

0–10000 Analog Output 1 (0-10.000 V)

508
0–20000 Analog Output 2 default (0-20.000 mA)

0–10000 Analog Output 2 (0-10.000 V)

Modbus IO Registers for the B2 IO Base Board
The I/O base board stores the input and output values in Modbus holding registers. Since the I/O base board is defined as a 
separate device, configure the DXM to read or write the values on the I/O base board.
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Base Board Input Connection

Modbus Register Range Description

1 0–65535 Universal input 1

2 0–65535 Universal input 2

3 0–65535 Universal input 3

4 0–65535 Universal input 4

Universal Input Register Ranges

Register Types Unit Minimum Value Maximum Value

Discrete input/output 0 1

Universal input 0 to 10 V mV 0 10000 *

Universal input 0 to 20 mA µA 0 20000 *

Universal input temperature (–40 °C to +85 °C) C or F, signed, in tenths of a 
degree –400 850

Universal potentiometer unsigned 0 65535

* Setting Enable Full Scale to 1 sets the ranges to a linear scale of 0 to 65535.

B2 Controller Base Board Output Connection

Modbus Register Range Description

501 0–1 NMOS Output 1

502 0–1 NMOS Output 2

503 0–1 NMOS Output 3

504 0–1 NMOS Output 4

505 0–1 Switched Power 1 (5 V to 24 V)

506 0–1 Switched Power 2 (5 V to 24 V)

507 0–1 DC Latching Output 1

508 0–1 DC Latching Output 2

509 0–10000 Analog Output 1 (0 to 10.000 V)

510 0–10000 Analog Output 2 (0 to 10.000 V)

Modbus Configuration Registers for the Universal Inputs
Each input or output on the I/O base board has associated Modbus registers that configure its operation.

Universal Input Parameters Registers

Universal Inputs 1 2 3 4

Enable Full-Scale Registers 3303 3323 3343 3363

Temperature °C/°F Registers 3304 3324 3344 3364

Input Type Registers 3306 3326 3346 3366

Threshold Registers 3308 3328 3348 3368

Hysteresis Registers 3309 3329 3349 3369

Enable Rising Registers 4908 4928 4948 4968

Enable Falling Registers 4909 4929 4949 4969

High Register for Counter Registers 4910 4930 4950 4970

Low Register for Counter Registers 4911 4931 4951 4971
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Modbus Configuration Registers for the Analog Output
The I/O base board has two analog outputs that are selectable as 0 to 20 mA (factory default) or 0 to 10 V. To change the 
analog output characteristic, physical jumpers on the I/O board and a Modbus register parameter must both be changed.

For step-by-step instructions on changing the output characteristics see "Analog (DAC) Outputs for the B1 and S1 Models" 
on page 35.

Parameters for Analog Output 1 start at 4001 through 4008. Parameters for Analog Output 2 start at 4021 through 4028.

Registers for analog output (4xxxx) parameters

Analog output 1 Analog output 2 Description Values

4001 4021 Maximum Analog Value

4002 4022 Minimum Analog Value

4003 4023 Enable Register Full-Scale
0 = Store readings in unit-specific data

1 = Linear rate from 0 to 65535

4004 4024 Hold Last State Enable
0 = Disables Hold Last State and uses the Default Output State 
setting during an error condition

1 = Sets the output to its last known value

4005 4025 Default Output State

4008 4028 Analog Output Type

0 to 20 mA or 0 to 10 V DC output (I/O board jumper selectable)
Accuracy: 0.1% of full scale +0.01% per °C
Resolution: 12-bit

After changing the jumper position, write the appropriate value to 
the Modbus registers to define your analog output to match the 
setting selected by the jumper.

2 = 0 to 20 mA output (default)
3 = 0 to 10 V output

2952 Enable Default Communication Timeout 0 = Disable
1 = Enable

2953 Communication Default I/O Timeout (100 
ms/Count) Number of 100 ms periods

2954 Enable Default on Power Up 0 = Disable
1 = Sends device outputs to their default condition

Analog Output Type—The analog outputs may be configured as either 0 to 20 mA outputs (default) or 0 to 10 V outputs. To 
change the analog output type change the hardware jumper position and write to the Modbus register that defines the analog 
output type. For analog output 1, write to Modbus register 4008, for analog output 2 write to Modbus register 4028. Write a 
value of 2 (default) to select 0 to 20 mA; write a value of 3 to select 0 to 10 V.

Default Output Conditions—Default output triggers are the conditions that drive outputs to defined states. Example default 
output conditions include when radios are out of sync, when a device cycles power, or during a host communication timeout.

2952 Enable Default Communication Timeout— A “communication timeout" refers to the communication between any 
Modbus client host and the DXM baseboard. Set this register to 1 to enable the default condition when the host has 
not communicated with the DXM baseboard for the period of time defined by the Communication Default IO Timeout.
2953 Communication Default I/O Timeout (100 ms/Count)—This parameter defines the host timeout period in 100-
millisecond increments. If a host does not communicate within this timeout period, the device outputs are set to the 
default values.
2954 Enable Default on Power Up—Setting this parameter to 1 sends the device outputs to their default condition 
when the DXM baseboard is powered up. Set to 0 to disable this feature.

Default Output State—The Default Output State parameter represents the default condition of the analog output. When an 
error condition exists, the outputs are set to this 16-bit user-defined output state. To define the error conditions for device 
outputs, refer to the MultiHop default output parameters 2950–2954.

Enable Register Full-Scale—Set to 1 to enable a linear range from 0 to 65535 for the specified input range. For a 4 to 20 mA 
output, a value of 0 represents 4 mA and 65535 represents 20 mA. Set this parameter to 0 to store readings in unit-specific 
data. For example, the register data representing a 15.53 mA reading is 15530. For units of current (0 to 20 mA outputs), 
values are stored as µA (micro Amps), and voltage values are stored as mV (millivolts).
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Hold Last State Enable—Set the Hold Last State to 1 to set the output to its last known value before the error occurred. Set 
this parameter to 0 to disable the Hold Last State and use the Default Output State setting during an error condition.

Maximum Analog Value—The Maximum Analog Value register stores the maximum allowed analog value. The specific units 
of measure apply to the register value. For example, the register may contain 20000, for 20 mA, or for a voltage output the 
register may contain 8000, for 8 volts.

Minimum Analog Value—The Minimum Analog Value register stores the minimum allowed analog value. The specific units of 
measure apply to register value. For example, the register may contain 4000, for 4 mA, or for a voltage output the register 
may contain 2000, for 2 volts.

Modbus Configuration Registers for the IO (Definitions)
Enable Full Scale

Set to 1 to enable a linear range from 0 to 65535 for specified 
input range. For a 4 to 20 mA input, a value of 0 represents 4 
mA and 65535 represents 20 mA. Set this parameter to 0 to 
store input readings in unit-specific data. For example, the 
register data representing a 15.53 mA reading is 15530. For 
units of current (0 to 20 mA inputs), values are stored as µA 
(micro Amps) and voltage values are stored as mV (millivolts).

Enable Rising/Falling
Use these registers to enable the universal input logic to count 
on a rising transition or a falling transition. Write a one (1) to 
enable; write a zero (0) to disable.

High/Low Register for Counter
The low and high registers for the counter hold the 32-bit 
counter value. To erase the counter, write zeroes to both 
registers. To preset a counter value, write that value to the 
appropriate register.

Hysteresis and Threshold
Threshold and hysteresis work together to establish the ON 
and OFF points of an analog input. The threshold defines a 
trigger point or reporting threshold (ON point) for a sensor 
input. When the input value is higher than the threshold, the 
input is ON. Hysteresis defines how far below the threshold 
the analog input is required to be before the input is 
considered OFF. A typical hysteresis value is 10% to 20% of 
the unit’s range.
In the example shown, the input is considered on at 15 mA. To 
consider the input off at 13 mA, set the hysteresis to 2 mA. 
The input will be considered off when the value is 2 mA less 
than the threshold.

Threshold

ON point

Time

Inp
ut 

Va
lue

Input

Hysteresis

OFF point

Input Type
Program the universal inputs to accept input types NPN, PNP, 
10k thermistor, 0 to 10 V, 0 to 20 mA, or potentiometer. The 
default setting is 8: NPN raw fast. To set the input type, write 
the following values to the Input Type Modbus registers.

0 = NPN
1 = PNP
2 = 0 to 20 mA
3 = 0 to 10 V DC
4 = 10k Thermistor
5 = Potentiometer Sense (DXM150 only)
6 = Not used
7 = Bridge
8 = NPN Raw Fast (default)

Temperature °C/°F
Set to 1 to represent temperature units in degrees Fahrenheit, 
and set to 0 (default) to represent temperature units in 
degrees Celsius. 

Modbus Configuration Registers for Power
To monitor the input power characteristics of the DXM, read the following power Modbus registers. The on-board thermistor is 
not calibrated but can be used as a non-precision temperature input.

Configuration registers for power

Modbus Register Description

6071 Battery backup charging algorithm.
0 = Battery is recharged from a solar panel
1 = Battery is recharged from 12 to 30 V DC (default)

6081 Battery voltage (mV). If no battery is present, the value in this register is less than 5 V. If the value in this register is 
greater than the incoming voltage register, the battery is powering the system.

Continued on page 80
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Continued from page 79

Modbus Register Description

6082 Battery charging current (mA). The charging configuration charges the battery when the incoming voltage register 
value is greater than the battery voltage register value. This register shows the charging current in milliamps.

6083 Incoming supply voltage (mV) (solar or power supply). The incoming power can be from a solar panel or from a 
power supply. The battery is charging when the incoming voltage register value is greater than the battery voltage 
register value. The battery is powering the system when the incoming voltage register value is less than the battery 
voltage register value.

6084 On-board thermistor temperature (⁰C). A thermistor measures the temperature of the solar controller board and its 
surrounding area and uses the temperature as part of the battery charge calculations. This register stores the 
thermistor reading in tenths of degrees C. This is not a calibrated input: divide by 10 to calculate the temperature in 
degrees C. For calibrated temperature inputs, define one of the universal inputs as a temperature input.

Modbus Registers for the LCD Board (Modbus ID 201)
Control the four user-defined LEDs using the display board's Modbus registers. Using write maps or ScriptBasic, write the 
Modbus registers shown below with 0 (off) or 1 (on). The LCD is Modbus ID 201.

Modbus Register I/O Connection Modbus Register I/O Connection

1102 : bit 0 LED 1 1104 : bit 0 LED 3

1103 : bit 0 LED 2 1105 : bit 0 LED 4

Using the Display LEDs
Turn on the DXM LEDs by writing to the LEDs' Modbus registers.

This example shows how to configure the DXM using the configuration software to read four universal inputs and write the 
state values to the display LEDs.

Using the configuration software, go to the Local Registers › Local Registers in Use screen.1. 
Define the local registers by assigning names to the first four registers and setting the LCD permissions parameter to 
read/write. The LCD permissions show the register contents on the LCD menu under the REGISTER menu. You can 
also set the value from the LCD menu.

Local Registers in Use screen

2. 

Create a Read Rule to read the four universal inputs from the I/O board (Modbus ID 200) and write the values in local 
registers 1 through 4.

RTU Read rules

3. 

Create a Write Rule to write the four local register values to the DXM display registers 1102 through 1105 (Modbus ID 
201). Define the Write Rule to only write the display registers when the inputs change.

4. 
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After a configuration file is uploaded, the DXM reboots. The new configuration is now running.

Turning on any one of the universal inputs 1 through 4 on the I/O base board of the DXM now turns on an LED on the display.

Using Courtesy Power or Switch Power
Pin 18 of the DXM100-Bx or 1000-Bx Wireless Controller is a constant power source that supplies 5 V up to 500 mA.

Pins 21 (switch power 2) and 30 (switch power 1) are switched power outputs. Configure the switched power outputs using 
Modbus registers or by using the DXM Configuration Software's Settings › I/O Board screen. The output voltage can be 
selected and is controlled using a Modbus register on the I/O board (Modbus ID 200). The voltage options are:

5 V or 16 V for DXM100-B1 models; or
5 to 24 V DC for DXM100-B2 models.

Turn the switched power on or off using the output register 505 for switch power 1 or 506 for switch power 2. For continuous 
power, set the Default Output register to 1, then cycle the power.

Switch Power Enable 
Register Enable Register Value Voltage 

Register Voltage Register Value Default Output 
Register

Output 
Register

1 (pin 30) 2201
Write a 0 to turn OFF
Write a 1 to turn ON (default)

3601 Write a 0 to select 5 V (default)
Write a 1 to select 16 V
Write a 2 to select 24 V (DXM100-
B2 model only)

3602 505

2 (pin 21) 2251 3621 3622 506

Enable Register
Configuration registers that turn on the ability to use the 
switched power output.
Default setting = ON

Voltage Register
Configuration registers that define the output voltage to the 
switched power output.
Default setting = 5 V

Default Output Register
Configuration registers that turn on the switched power 
outputs for continuous power out.
Set register to 1 for continuous power. Cycle power if this 
register is changed.
Default setting = 0

Modbus Output Register
Turn on or turn off the voltage output. If both outputs 505 and 
506 are turned on at the same time but are set to different 
voltages, the output voltage is 5 V for DXM100-B1 models 
and set to the lower voltage setting for DXM100-B2 models.

Associating a Switched Power Output to an Input
Use the DXM Configuration Software to associate a switched power output to a universal input.

Switched power 1 and 2 (pins 30 and 21) can be associated to any Universal input to apply power to a sensor, take a 
reading, and then remove power from the sensor. This conserves power in battery-operated systems. The switched power 

RTU Write rules

Save the XML configuration from the File › Save As menu.5. 
Connect to the DXM using a USB cable and select Device › Connection Settings from the menu bar.6. 
Upload the XML configuration file to the DXM by selecting Device › Upload Configuration to Device from the menu 
bar.

7. 



Additional InformationDXM100-Bx and 1000-Bx Wireless Controller Product Manual

09-Dec-24page 82 of 110

(1) Only used when supplying courtesy power to the output pin, not when associating switched power to an input.

© Banner Engineering Corp. All rights reserved.

supply can be used in one of two different ways: supplying courtesy power to an output pin or associated to an input. (Only 
one method can be active at a time.)

To manually configure the switched power output using I/O board Modbus registers, write the specified value to the listed 
register.

Courtesy Power Output Configuration Parameters (1)
Modbus Registers to Write To

Switched Power 1 Switched Power 2

Switched Power Enable 2201 2251

Voltage 3601 3621

Default Output 3602 3622

Output Register 505 506

Default Output
Set the register value to 1 for continuous power. The default 
setting is 0.
Cycle power if this register value is changed.

Output Register
Write to the Output register to turn on or turn off the voltage 
output.
If both Output Registers 505 and 506 are turned on at the 
same time, but are set to different voltages, the output voltage 
is 5 V for DXM100-B1 models and set to the lower voltage 
setting for DXM100-B2 models.

Switched Power Enable
Enables the switched power supply. Set to 1 to enable; set to 
0 to disable.
This does not enable the supply output to the actual output 
pin. To enable the supply output to the output pin, set Modbus 
register 505 or 506 to 1. Set to 0 when associating the 
switched power supply to an input.

Voltage
For the B1 and S1 models, set the Modbus register value to 0 
for a switched power supply at 5 volts. Set the Modbus 
register value to 1 for a switched power supply at 16 volts.
For the B2 and S2 models, set one of the following register 
values to select your switched power output voltage.

For 5 V, set the Modbus register to 204
For 7 V, set the Modbus register to 125
For 10 V, set the Modbus register to 69
For 15 V, set the Modbus register to 32
For 20 V, set the Modbus register to 12
For 24 V, set the Modbus register to 3

When associating a switched power supply to an input, set the Switch Power Output Enable register to off (0). Set Modbus 
register 2201 for switched power 1 and Modbus register 2251 for switched power 2. This allows the input sampling 
mechanism to control the output.

Use the following configuration parameters to define the switch power associated with an input.

Input Parameter
Universal Input Configuration Parameter Modbus Registers to Write To

Universal Input 1 Universal Input 2 Universal Input 3 Universal Input 4

Input Enable 1001 1051 1101 1151

Sample Interval (high) 1002 1052 1102 1152

Sample Interval (low) 1003 1053 1103 1153

Switched Power Enable Mask 1004 1054 1104 1154

Switched Power Warmup 1005 1055 1105 1155

Switched Power Voltage 1006 1056 1106 1156

Extended Input Read 1007 1057 1107 1157

Input Out-of-Sync Enable 1008 1058 1108 1158

Extended Input Read
The Extended Input Read is a bit field parameter that allows 
multiple inputs to be sampled with the same switch power 
parameters.
If the bit field is set to 0x000F, the first four inputs are sampled 
after the switch power parameters are satisfied.

If the Extended Input Read parameter is set in the Universal 
input 1 configuration registers, set Universal inputs 2 through 
4 Extended Input Read and Sample Interval parameters to 
zero.

Input Enable
Set to 1 to enable the input. Set to 0 to disable the input.
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•

•

•

Out-of-Sync Enable
To enable the input to continue operating when the device is 
out of sync with the client radio, set to 1.
To disable the input when the device is not synchronized to 
the client radio, set to 0.

Sample Interval (high), Sample Interval (low)
The sample interval (rate) is a 32-bit value (requires two 
Modbus registers) that represents how often the I/O board 
samples the input.
The register value is the number of time units. One time unit is 
equal to 0.01 seconds.
For example, a Modbus register value of 1000 represents a 
sample interval of 10 seconds (1000 × 0.010 seconds = 10 
seconds).

Switch Power Enable Mask
The Switch Power Enable Mask works with the warm-up and 
voltage parameters to define the switch power output. The bit 
mask can select any number of switch powers.

0x0 - No switch power enabled
0x1 - Enable Switch Power 1
0x2 - Enable Switch Power 2
0x3 - Enable Switch Power 1 and Switch Power 2

Switch Power Voltage
The Switch Power Voltage parameter defines the output 
voltage of the switch power output.
This parameter applies only to inputs using switched power. If 
switch power is not used with an input, use the Courtesty 
Power Voltage parameter to control the voltage.
See Voltage entry for Modbus register values used to select 
the output voltage.

Switch Power Warm-up
When an input controls power to external sensors, the Switch 
Power Warm-up parameter defines how long power is applied 
to the external sensor before the input point is examined for 
changes.
The register value is the number of time units, and a time unit 
is 0.01 seconds. For a warm-up time of 1 second, this 
parameter value is 100 (0.01 seconds × 100 = 1 second).

To associate universal input 1 with switched power 1, follow these instructions. Set Input 1 to sample every 60 seconds, with 
a warmup time of 10 seconds.

Working with Solar Power
A reliable solar system requires careful planning and monitoring to size the components correctly. The recommendations 
provided are for the DXM system as an autonomous system.

Adding extra components increases the power requirements and likely requires increasing the solar system components. 
Depending upon the geographical location, the size of the solar panel and battery may vary.

Setting the DXM for Solar Power
By default, the DXM is set from the factory to charge a backup battery from a line power source.

For DXM models with an LCD, use the buttons and menu system to change the charging algorithm to solar power. Go to 
System Config › I/O Board › Charger. Use the up/down arrows to select Solar.

For DXM models without an LCD, use the configuration software to adjust the I/O board Modbus register 6071. Set the 
register to 0 to select battery charging from a solar panel, and set to 1 to select battery charging from incoming 12 to 30 V DC 
supply.

To minimize the power consumption (may not apply to all models):
If Ethernet is not being used, disable Ethernet to save up to 25% of the consumed power. Set DIP switch 1 to the ON 
position on the processor board then reboot.
Instead of powering external devices all the time, take advantage of the switched power mechanisms to turn off 
devices when possible.
Minimize the number of cellular transactions and the amount of data pushed through the cellular modem.

Solar Components
The components of a solar system include the battery and the solar panel.

Battery
The DXM solar controller is designed to use a 12 V sealed lead acid (SLA) battery. The characteristics of a solar system 
require the battery to be of a certain type. There are two types of lead acid batteries:

Verify Switched Power 1 Output Enable is off (0). Set Modbus Register 2201 = 01. 
Set the Sample Interval to 1 minute. Modbus Registers 1002 = 0, 1003= 6000 (0.01 seconds × 6000 = 60 seconds).2. 
Set the Switched Power Enable Mask to use Switch Power 1. Modbus Register 1004 = 13. 
Set the Switched Power Warm-up time to 10 seconds. Modbus Register 1005 = 1000 (0.01 seconds × 1000 = 10 
seconds).

4. 

Set the Switched Power Voltage to 16 volts. Modbus Register 1006 = 1.5. 
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•
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SLI batteries (Starting Lights Ignition) are designed for quick bursts of energy, like starting engines
Deep Cycle batteries - greater long-term energy delivery. This is the best choice for a solar battery.

Since a solar system charges and discharges daily, a deep-cycle battery is the best choice. There are different versions of a 
lead acid battery: wet cell (flooded), gel cell, and an absorbed glass mat (AGM).

Wet cell batteries are the original type of rechargeable battery and come in two styles, serviceable and maintenance-free. 
Wet cell batteries typically require special attention to ventilation as well as periodic maintenance but are the lowest cost. The 
gel cell and AGM battery are sealed batteries that cost more but store very well and do not tend to sulfate or degrade as 
easily as a wet cell. Gel or AGM batteries are the safest lead acid batteries you can use.

Battery capacity is a function of the ambient temperature and the rate of discharge. Depending upon the specific battery, a 
battery operating at –30 °C can have as much as 40 percent less capacity than a battery operating at 20 °C. Choose enough 
battery capacity based on your geographical location.

Average voltage readings relative to battery charge

State of Battery Charge (%) Open Circuit Voltage

100 13.0 or higher

75 12.6

50 12.1

25 11.66

0 11.4 or less

A larger capacity battery typically lasts longer for a given solar application because lead-acid batteries do not like deep 
cycling (discharging a large percentage of its capacity). Depending upon the battery, a battery discharging only 30 percent of 
its capacity before recharging will have approximately 1100 charge/discharge cycles. The same battery discharging 50 
percent of its capacity will have approximately 500 charge/discharge cycles. Discharging 100 percent leaves the battery with 
only 200 charge/discharge cycles.

Use this information as a guide to the approximate state of charge and in determining when to apply conservation measures. 
Batteries degrade over time based on discharge/charge cycles and environmental conditions. Always monitor the battery 
system to obtain the best performance of the solar-powered system.

Solar Panel
Banner solar panels come in two common sizes for the DXM: 5-watt and 20-watt. Both panels are designed to work with the 
DXM but provide different charging characteristics. Use the 5-watt panel for light-duty operation and use the 20-watt panel 
when you require greater charging capabilities.

Solar Panel Voltage Current Typical DXM Configurations

5 Watt 17 V 0.29 A DXM Controller configured as a server, ISM radio, I/O base board

20 Watt 21 V 1 A DXM Controller with ISM radio and Cellular modem

Photovoltaic panels are very sensitive to shading. Unlike solar thermal panels, PV solar panels cannot tolerate shading from 
a branch of a leafless tree or small amounts of snow in the corners of the panel. Because all cells are connected in a series 
string, the weakest cell will bring down the other cells' power level.

Good quality solar panels will not degrade much from year to year, typically less than 1 percent.

To capture the maximum amount of solar radiation throughout the year, mount a fixed solar panel to optimize the sun's 
energy. For the northern hemisphere, face the panel true south. For the southern hemisphere, face the panel true north. If 
you are using a compass to orientate the panels, compensate for the difference between true north and magnetic north. 
Magnetic declination varies across the globe.

A solar panel's average tilt from horizontal is at an angle equal to the latitude of the site location. For optimum performance, 
adjust the tilt by plus 15 degrees in the winter or minus 15 degrees in the summer. For a fixed panel with a consistent power 
requirement throughout the year, adjust the tilt angle to optimize for the winter months: latitude plus 15 degrees. Although in 
the summer months, this angle may not be the most efficient, there are more hours of solar energy available.

For sites with snow in the winter months, the increased angle helps to shed snow. A solar panel covered in snow produces 
little or no power.
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Recommended Solar Configurations
These solar panel and battery combinations assume direct sunlight for at least two to three hours a day. Solar insolation 
maps provide approximate sun energy for various locations. The depth of battery discharge is assumed to be 50 percent.

Solar panel and battery combinations for a DXM system

Solar Panel Output 
(W)

Battery Capacity 
(Ahr) Days of Autonomy DXM Current (mA) DXM Model

5 10 10 25 DXM-Sx models with an ISM radio and I/O base board

20 14 10 30 DXM-Bx models with an ISM radio and no cellular modem

20 20 10 35 DXM-Bx models with an ISM radio and cellular modem

Battery capacity (Ahr) is a standard amp rating taken over 20 hours. Battery capacity should be monitored for reliable system 
power and may need to be increased for cold weather locations.

Monitoring Solar Operation
The DXM solar controller uses Modbus registers to allow the user to monitor the state of the solar panel input voltage, the 
battery voltage, the charging current, and the temperature in °C. The DXM can be configured to monitor the health of the 
charging system as well as send an alert message when the battery is too low.

The charts show a typical charging cycle, with each vertical grid representing about eight hours. The chart shows three days 
of charging.

Solar Panel Voltage (mV) -- Cloudy First Day

Battery Voltage (mV) - Cloudy First Day

Clear the Password on DXM100 and DXM150 Models Only
By default, the DXM Controllers do not require a password to load a configuration file. If a password is defined, the password 
must be entered before uploading a configuration file. To change the password, you must already know the current password. 
If you do not know the current password, follow these steps to clear the password.

IMPORTANT: Clearing the password erases the current configuration and any program files, log files, or 
history files.
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IMPORTANT: DO NOT follow these instructions if you have a DXM700, DXM1000, or DXM1500 model. If 
you attempt to clear the password of a DXM700, DXM1000, or DXM1500 with these instructions, the 
firmware of your device will be erased and your controller will no longer function.

Clear the Password on DXM700-Bx, DXM1000-Bx, or 
DXM1200-Bx Models
By default, the DXM Controllers do not require a password to load a configuration file. If a password is defined, the password 
must be entered before uploading a configuration file.

To change the password, you must already know the current password. If you do not know the current password, follow these 
steps to clear the password.

IMPORTANT: Clearing the password erases the current configuration and any program files, log files, or 
history files.

Turn the power OFF to the DXM Controller.1. 

Set DIP switch 4 to the ON position.2. 

Press and hold the processor button.3. 

Turn the power ON to the DXM Controller.
The processor board's LED flashes to indicate the process is complete (about 10-20 seconds).

4. 

Set DIP switch 4 to the OFF position.5. 

Cycle power to the DXM Controller.6. 

Reload the configuration file before resuming normal operation.7. 

Turn on the power to the DXM Controller.1. 

Set DIP switch 4 to the ON position.2. 

Press and hold the processor button until the processor board LED flashes.3. 

Set DIP switch 4 to the OFF position.4. 

Cycle power to the DXM Controller.5. 

Reload the configuration file before resuming normal operation.6. 
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PROFINET is a data communications protocol for industrial automation and processes. PROFINET IO defines how 
controllers (IO controllers) and peripheral devices (IO devices) exchange data in real-time. PROFINET® is a registered 
trademark of PROFIBUS Nutzerorganisation e.V. and the standard is maintained by PROFIBUS & PROFINET International 
(PI), an organization headquartered in Karlsruhe, Germany.

Only the DXMR90-4K, DXMR90-X1, DXMR110-8K, DXM700, DXM1000, and DXM1200 Controller models support 
PROFINET IO.

General Station Description Markup Language File
A PROFINET General Station Description (GSD) file is a description of an IO device provided by the device manufacturer in 
an XML format (GSDML.xml).

The GSD file is a standardized way of describing the device information to engineering tools and the IO controller and can 
work across a variety of tools as a standard set of device information.

DXM PROFINET IO Data Model
The PROFINET IO data model is based on the typical, expandable field device that has a backplane with slots. Modules 
have different functionalities.

Modules are plugged into slots. In the PROFINET IO data model, Slot 0, Subslot 1 is reserved for the Device Access Point 
(DAP) or network interface.

Configure the DXM Controller for a PROFINET IO Connection
To use PROFINET, follow these instructions.

The PROFINET data type and data size to/from the DXM Controller is configurable. The PROFINET data is processed from 
the Local Register of the DXM Controller.

Configure the IO-Link ports in the XML according to the modules selected for each port.

Save and Upload the Configuration File
After making any changes to the configuration, you must save the configuration files to your computer, then upload it to the 
device.

Changes to the XML file are not automatically saved. Save your configuration file before exiting the tool and before sending 
the XML file to the device to avoid losing data. If you select DXM › Send XML Configuration to DXM before saving the 
configuration file, the software will prompt you to choose between saving the file or continuing without saving the file.

PROFINET®Chapter 10 

Using the DXM Configuration Software, go to the Settings › Ethernet screen.1. 

Select Enable PROFINET.2. 

Save the configuration file and upload it to the DXM Controller (see "Save and Upload the Configuration File" on page 
20).
After PROFINET is enabled, the IP address for the DXM Controller is controlled by the PROFINET host.

3. 

Save the XML configuration file to your hard drive by going to the File › Save As menu.1. 

Go to the DXM › Send XML Configuration to DXM menu.2. 
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Slots and Modules for DXMR90-4K and DXMR110-8K 
PROFINET
There are ten slots to accommodate the DXM Controller data.

Slots for input and output values

Values Maximum Data Size

Input values 1440 bytes

Output values 1440 bytes

Slot 1 - Input (DXM --> PLC)

Module ID Submodule ID Module Size (bytes) Register Start Register End Direction

0x44 0x01 Banner IO-Link 
Client Info 9

1 3

Input6 6

123 123

It is important to note that the module placed in slot 2 corresponds to Port 1; the module placed in slot 3 corresponds to Port 
2; the module placed in slot 4 corresponds to port 3. etc.

For the DXMR90-4K IO-Link Client device, slots 6 through 9 are unused.

If the IO-Link In/Out process data modules (all except digital input and output) are used, the attached IO-Link device must 
have PDI and PDO size less than or equal to the number of data bytes allowed in the module. Data transfers will not be 
applied otherwise. For example, plugging in the 16/16 byte module to a slot corresponding to a device that has 22 bytes of 
PDO results in an error. Process data sent from the PLC to DXM will not be applied.

Slots 2-9 (1 per IO-link port)

Module ID Submodule ID Module Size (bytes) Register Start Register End Direction

0x45 0x01 IO-Link In/Out 32/32 Byte + Status

36
x001 x017

Bidirectional
x506 x507

46
x051 x067

x851 x859

0x46 0x01 IO-Link In/Out 16/16 Byte + Status

20
x001 x009

Bidirectional
x506 x507

30
x051 x059

x851 x859

0x47 0x01 IO-Link In/Out 8/8 Byte + Status
12

x001 x005

Bidirectionalx506 x507

22 x051 x055

Continued on page 89

◦

◦
◦

Status indicator bar

If the Application Status indicator is red, close and restart the DXM Configuration Tool, unplug and re-plug in 
the cable and reconnect the DXM to the software.
If the Application Status indicator is green, the file upload is complete.
If the Application Status indicator is gray and the green status bar is in motion, the file transfer is in progress.

After the file transfer is complete, the device reboots and begins running the new configuration.
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Continued from page 88

Module ID Submodule ID Module Size (bytes) Register Start Register End Direction

x851 x859

0x48 0x01 IO-Link In/Out 4/4 Byte + Status

8
x001 x003

Bidirectional
x506 x507

18
x051 x053

x851 x859

0x49 0x01 IO-Link In/Out 2/2 Byte + Status

6
x001 x002

Bidirectional
x506 x507

16
x051 x052

x851 x859

0x4A 0x01 IO-Link In/Out 1/1 Byte + Status

5
x001 x002

Bidirectional
x506 x507

15
x051 x052

x851 x859

0x4B 0x01 Digital Output 5

x051 x051

Output Module
x851 x851

x853 x853

x858 x858

0x4C 0x01 Digital Input

2 x001 x001

Bidirectional
4

x051 x051

x851 x851

x853 x853

x858 x859

Slot 10 (ISDU)

Module ID Submodule ID Module Size (bytes) Register Start Register End Direction

0x4D 0x01 ISDU 190 Byte + Status
196 351 442

Bidirectional
196 200 291

0x4E 0x01 ISDU  80 Byte + Status
86 351 396

86 200 245

Example Configuration

Slot Module Description

Slot 1 Banner IO-Link Client Info Vendor ID, Device ID, Number of Supported Channels, and Firmware 
Version information

Slot 2 IO-Link In/Out 32/32 Byte + Status Get/send IO-Link PDI/PDO for IO-Link device on Port 1 with PD Size 
between 17 and 32 bytes

Slot 3 IO-Link In/Out 16/16 Byte + Status Get/send IO-Link PDI/PDO for IO-Link device on Port 2 with PD Size 
between 9 and 16 bytes

Slot 4 IO-Link In/Out 2/2 Byte + Status Get/send IO-Link PDI/PDO for IO-Link device on Port 3 with PD Size 
between 1 and 2 bytes

Slot 5 Digital Output Use SIO Output mode on Port 4

Slot 10 ISDU 190 Byte + Status ISDU read/write access for all ports in IO-Link mode
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Configuration Instructions
Install the GSD File
Although these instructions are specific for the Siemens TIA Portal (v14) software, you may use these instructions as a basis 
for installing the GSD file into another controller.

Download the GSD file from www.bannerengineering.com.1. 

Launch the Siemens TIA Portal (v14) software.2. 

Click Open existing project.3. 

Select a project and open it.4. 

After the project is uploaded, click Devices & networks.

Devices and networks screen

5. 

Click Configure networks.

Configure networks screen

6. 

Click Options and select Manage general station description file (GSD).
The Install general station decription file window opens.

7. 

http://www.bannerengineering.com
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If the DXM GSD file does not install properly, save the log and contact Banner Engineering Corp.

Change the Device IP Address
Follow these instructions to change the IP address of the DXM device using the Siemens TIA Portal (v14) software. Use 
these instructions as a basis if you are using another controller (PLC).

Click the More options (...) icon to the right of the Source path field and browse to the location the DXM GSD file was 
downloaded to.

8. 

Select the DXM GSD file.9. 

Click Install.

Hardware catalog

The system installs the DXM GSD file and places it in the Hardware catalog. In the example, the DXM GSD file is 
located under Other field devices › PROFINET IO › Banner Engineering Corp. › Banner.

10. 

Launch the Siemens TIA Portal (v14) software.1. 

Click Open existing project.2. 

Select a project and open it.3. 

Click Devices & networks.

Network view

The Network view displays.

4. 

Double-click on the DXM icon to open the Device view screen.5. 

Click on the DXM icon in the graphic area of the Device view screen.6. 
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The Module properties window displays and the module can now be configured.

Click Properties.7. 

Click General.8. 

Select PROFINET Interface › Ethernet addresses.

Ethernet addresses

9. 

Select Set IP address in the project.10. 

Enter the IP address.11. 

Right-click on the device icon and select Online & diagnostics.

Online & diagnostics menu and screen

The Online & diagnostics windows displays.

12. 

Select Assign IP address under Functions.13. 

Click Accessible devices.
The Select device window searches the network for available devices.

14. 
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By default, each DXM shipped from the factory is assigned the IP address 192.168.0.1.

Immediately after the PROFINET protocol is enabled, the DXM has an IP address of 0.0.0.0. We recommend using the TIA 
Portal to give the DXM an IP address so that the address is saved in the unit. When the PLC powers up, this IP address is 
accessible. The PLC can change the IP address if it is configured to do so.

If the PLC assigns the DXM IP address (for example, using the Set IP address in the project option in Siemens TIA Portal), 
the DXM receives the specified address, but only after the program has been loaded into the PLC and is running. If the DXM 
is restarted after it was discovered and configured by the PLC, the DXM retains the IP address that was assigned to it using 
the LCD or software until after the PLC discovers the DXM and assigns it the specified address again. However, if this 
address is different than what is specified in the PLC, the DXM reverts to the address specified in the PLC after the PLC 
becomes active again.

These configuration options conform to the PROFINET standard.

Change the Device Name
Follow these instructions to change the name of the DXM using the Siemens TIA Portal (v14) software. Use these 
instructions as a basis if you are using another controller (PLC).

Determine the device to be adjusted via the MAC address and select it.15. 

Click Apply.
The IP address for the device is updated.

16. 

Click Assign IP address to complete the step.
This step is completed for every device.

17. 

Open a project and click on Devices & networks.
The Network view displays.

1. 

Right-click on the DXM icon and select Assign device name.
The Assign PROFINET device name window displays. The software searches for devices of the same type.

2. 

Enter the desired name in the PROFINET device name field. Note that each name can be used only once.3. 

Click Assign name.
The device now has a PROFINET name.

4. 
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DXM Accessories
For a complete list of all the accessories for the Sure Cross wireless product line, please download the Accessories List (p/n 
b_3147091).

Cordsets
MQDC1-506—5-pin M12, straight, single-ended, 6 ft
MQDC1-530—5-pin M12, straight, single-ended, 30 ft
MQDC1-506RA—5-pin M12, right-angle, single-ended, 6 ft
MQDC1-530RA—5-pin M12, right-angle, single-ended, 30 ft

Misc Accessories
BWA-CG.5-3X5.6-10—Cable Gland Pack: 1/2-inch NPT, Cordgrip for 3 
holes of 2.8 to 5.6 mm diam, 10 pack 
BWA-HW-052— Cable Gland and Vent Plug Pack: includes 1/2-inch 
NPT gland, 1/2-inch NPT multi-cable gland, and 1/2-inch NPT vent plug, 
one each

Static and Surge Suppressor
BWC-PRC827-DC—Surge Suppressor, bulkhead, DC Blocking, N-Type 
Female, N-Type Male

Antenna Cables
BWC-1MRSMN05—LMR200 RP-SMA to N-Type Male, 0.5 m
BWC-2MRSFRS6—LMR200, RP-SMA Male to RP-SMA Female 
Bulkhead, 6 m
BWC-4MNFN6—LMR400 N-Type Male to N-Type Female, 6 m

Short-Range Omni Antennas
BWA-2O2-D—Antenna, Dome, 2.4 GHz, 2 dBi, RP-SMA Box Mount
BWA-9O2-D—Antenna, Dome, 900 MHz, 2 dBi, RP-SMA Box Mount
BWA-9O2-RA—Antenna, Rubber Fixed Right Angle, 900 MHz, 2 dBi, 
RP-SMA Male Connector

Medium-Range Omni Antennas
BWA-9O5-C—Antenna, Rubber Swivel, 900 MHz 5 dBi, RP-SMA Male 
Connector
BWA-2O5-C—Antenna, Rubber Swivel, 2.4 GHz 5 dBi, RP-SMA Male 
Connector

Long-Range Omni Antennas
BWA-9O8-AS—Antenna, Fiberglass, 3/4 Wave, 900 MHz, 8 dBi, N-Type 
Female Connector
BWA-2O8-A—Antenna, Fiberglass, 2.4 GHz, 8 dBi, N-Type Female 
Connector

Long-Range Yagi Antennas
BWA-9Y10-A—Antenna, 900 MHz, 10 dBd, N-Type Female Connector

Cellular Antenna
BWA-CELLA-002—Cellular multiband, 2 dBi, RP-SMA male connection, 
6.3 inch blade style. Datasheet: b_4475176

Enclosures and DIN Rail Kits
BWA-AH864—Enclosure, Polycarbonate, with Opaque Cover, 8 × 6 × 4
BWA-AH1084—Enclosure, Polycarbonate, with Opaque Cover, 10 × 8 × 
4
BWA-AH12106—Enclosure, Polycarbonate, with Opaque Cover, 12 × 
10 × 6
BWA-AH8DR—DIN Rail Kit, 8", 2 trilobular/self-threading screws
BWA-AH10DR—DIN Rail Kit, 10", 2 trilobular/self-threading screws
BWA-AH12DR—DIN Rail Kit, 12", 2 trilobular/self-threading screws

Power Supplies
PSD-24-4—DC Power Supply, Desktop style, 3.9 A, 24 V DC, Class 2, 
4-pin M12 quick disconnect (QD)
PSDINP-24-13 —DC power supply, 1.3 Amps, 24 V DC, with DIN Rail 
Mount, Class I Division 2 (Groups A, B, C, D) Rated
PSDINP-24-25 — DC power supply, 2.5 Amps, 24 V DC, with DIN Rail 
Mount, Class I Division 2 (Groups A, B, C, D) Rated
BWA-SOLAR PANEL 20W—Solar Panel, 12 V, 20 W, Multicrystalline, 
573 × 357 × 30, "L" style mounting bracket included (does not include 
controller)

Product Support and MaintenanceChapter 11 

http://info.bannerengineering.com/cs/groups/public/documents/literature/b_3147091.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/b_4475176.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/b_4158741.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/b_4158743.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/b_4158745.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/173620.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/180340.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/180340.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/185282.pdf
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DXM100 and DXM1000 Dimensions
All measurements are listed in millimeters, unless noted otherwise. The measurements provided are subject to change.

86 mm
[3.39”]

94.6 mm
[3.72”]

104 mm
[4.09”]

59.5 mm
[2.34”]

20.4 mm
[0.8”]

35 mm
[1.38”]

File System and Archive Process
The DXM file system consists of two physical components: the serial EEPROM that stores non-volatile configuration 
information and a local storage device that stores file backup data and user-created files.

EEPROM Files—The serial EEPROM stores basic data that is required to be non-volatile, including network configuration 
data, IP address, MAC address, network masks, firewall settings, and authentication information. The controller XML 
configuration file created by the DXM Configuration Software is stored in EEPROM. The small section of non-volatile local 
registers is also stored in EEPROM.

Local Storage Device Files—The local storage device (micro SD card or embedded flash memory chip) contains most files at 
the root level. The archive directory contains files kept by the system for history backup. Archive files are stored in the 
directory _sxi and are only accessible by removing the local storage device.

Data Log Files
HTTP Push Files
User-created ScriptBasic file
ScriptBasic program file
CmVMon file
_sxi Archive directory

Data Log files
Users may create up to four data log files using the DXM 
Configuration Software. The log files are stored in the root 
directory on the local storage device. When the file size limit is 
reached, the filename is changed to include the date and time 
and the file is moved into the archive directory _sxi. Archived 
log files are deleted based on the Clear Logs parameter.
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HTTP Push File
If the DXM is configured to send data to a webserver or host 
system, the device creates an HTTP.LOG file on the local 
storage device. The HTTP log is created only if the Logging 
Interval is non-zero and the HTTP enable log is set. An entry 
is placed in the HTTP log file at the Logging Interval specified 
by the user. At the Push Interval time, the HTTP log file is sent 
to the webserver or host system. If the transmission is 
successful, the HTTP log file is time-stamped and placed into 
the archive directory (_sxi). If the transmission fails, the file 
remains in the root directory and subsequent Logging 
Intervals are appended to the file and are sent at the next 
Push Interval. See "Ethernet and Cellular Push Retries" on 
page 61.

User Created ScriptBasic Files
Users may use ScriptBasic to create files on the local storage 
device by using the FILEOUT function. The filenames are 
fixed and up to five files can be created in the root directory.

ScriptBasic Program File
The main ScriptBasic program that runs at boot time is stored 
on the local storage device in the root directory.

CmVMon File
The CmVMon.txt file (Cellular milli-Volt Monitor) is created by 
the system and is used to track power events. Every power-up 
cycle is date/time stamped with the voltage read from the I/O 
board. The value 24487 is equal to 24.487 volts. If the voltage 
drops below 11.2 V, another entry is put in the log file 
indicating the cellular modem will shut down.

CM 2015-09-22 18:52:43 VMon Power entered normal 
range 24487

CM 2015-10-13 20:49:47 VMon Power entered normal 
range 24004

CM 2015-10-16 15:00:20 VMon Power entered normal 
range 24014

CM 2015-10-19 19:12:26 VMon Power entered normal 
range 12845

_sxi Archive Directory
Only two types of files are moved into the archive directory: 
data log files and HTTP log files. Data log files are date/time 
stamped and placed into the archive directory when the size 
limit is reached. HTTP log files are date/time stamped then 
placed into the archive directory when they are successfully 
sent to the webserver or host system. If the HTTP log files 
were not successfully sent after the retries have been 
exhausted, the files are placed into a root directory called sav.

Troubleshooting
Restoring Factory Default Settings for the IO Base Board
To reset the I/O base board to factory defaults, write to two Modbus registers in the base board. The default ID for the base 
board is 200.

To reset the DXM I/O base board parameters back to factory defaults:

To reboot (cycle power) the DXM I/O base board:

Restoring Factory Defaults for the I/O Base Board

Register Values Description

4151 0–255

Reset/restore trigger. This timer is based in 100 millisecond units. Once written, the timer 
starts to count down to zero. After the timer expires, the restore factory defaults are applied 
if register 4152 = 1. If register 4152 is zero, the I/O board is reset.
Default value: 0

1 = 100 milliseconds, 10 = 1 second.

4152 0–1
0 = Reboots (cycles power) to the I/O base board

1 = Restores factory defaults for I/O parameters

Updating the DXM Processor Firmware
There are two different update procedures, depending on the DXM firmware version of your device.

Write a 1 to Modbus register 41521. 
Write a 10 to Modbus register 41512. 

Write a 0 to Modbus register 41521. 
Write a 10 to Modbus register 41512. 
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Update Your DXM Processor Firmware (Prior to Version 2.0)
To update DXM Processor firmware prior to version 2.0, use the SAM-BA program from MicroChip/Atmel. Following these 
instructions to update the DXM100 or DXM150 processor firmware.

Download the SAM-BA software from http://www.microchip.com/developmenttools/productdetails.aspx?
partno=atmel+sam-ba+in-system+programmer.

1. 

Install the SAM-BA program.2. 

Set the processor board jumper (jumper C, shown below in the "boot load off" position).

Processor board

1

14

H

I

A

B
C

D

E

A

F

G

3. 

Disconnect the DXM Controller from its power supply.a. 
Open the hardware cover.b. 
Using your fingers or tweezers, move the jumper to the "boot load on" position (jumper on the top two pins).c. 
Connect the DXM back to its power supply.d. 
The lower left LED on the I/O base board is solid when power is turned on. After the LED begins flashing, 
remove power.

e. 

Move the jumper back to its original position.f. 
Replace the hardware cover.g. 
Connect the DXM back to its power supply.h. 

Launch the SAM-BA program. Select the COM port and correct board. Click CONNECT.

Popup screen

The SAM-BA program attempts to automatically detect the COM port and the correct device.

4. 

On the SCRIPTS pull-down m] enu select ENABLE FLASH ACCESS. Click EXECUTE.5. 

http://www.microchip.com/developmenttools/productdetails.aspx?partno=atmel+sam-ba+in-system+programmer
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Updating Your DXM Processor Firmware (Version 2 or Later)
DXMs with processor firmware version 2.0 or later have a built-in boot loader program to update the firmware. Use the 
configuration software version 3 or later, the BannerCDS webserver, or manually write the files on the SD card to update the 
firmware.

The new firmware file loads into the BOOT directory of the SD card on the DXM. The configuration software or 
BannerCDS website handles the reprogramming process automatically. During the programming process, the internal LEDs 
on the processor board indicate the status of the programming.

SAM-BA popup window

In the SCRIPTS pull-down menu, select BOOT FROM FLASH (GPNVM1). Click EXECUTE. Click EXECUTE again if 
the message indicates it failed.

6. 

In the Flash tab, click on the folder icon for the Send File Name field. Select the boot load file (must be a *.bin file) and 
click SEND FILE. The file is: DXM PROCESSOR FIRMWARE V2.02 or go to the software section of the Wireless 
Reference Library on www.bannerengineering.com.

SAM-BA popup window

The load process takes a few seconds.

7. 

After the load is complete, the program asks if you want to lock the flash region. Click NO.8. 

Close the SAM-BA bootloader program.9. 

Cycle the power to the DXM.
The new code should now be running and the LEDs should be on.

10. 

http://info.bannerengineering.com/cs/groups/public/documents/software/182124.zip
http://www.bannerengineering.com
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(1) While the file download is in process over a USB connection, do not use other applications on the PC. After the DXM reboots for a firmware update, the USB 
port may be unresponsive. Clear the connection by disconnecting the USB cable and restarting the DXM Configuration Software.
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Update process overview

Reprogramming Step Approximate time required Description

Loading new firmware file (*.HEX) Configuration software: 2 minutes over Ethernet or 
15 minutes over USB
BannerCDS: 2 minutes over Ethernet or 5 minutes 
over Cellular

Send the new firmware image to the DXM. After the new 
image is on the device, the controller resets.
LED3 is red during the loading process.

Verify the contents of the new 
firmware file

1 minute When the DXM finds a file that should be installed, LED4 
(amber) flashes at about a 1 second rate while the contents of 
the file are validated.

New firmware file is valid After validation successfully completes, LED4 is on (amber).

New firmware file is being loaded 2 minutes; do not remove power to the DXM 
during the programming process.

LED3 (red) blinks approximately once per second. LED3 
continues to blink during the application programming 
process.

Finished After programming has completed, the DXM resets and begins 
running the new firmware

The firmware file names follow an 8.3 filename convention. The first 5 characters are the firmware part number in 
hexadecimal; the last 3 characters of the part number are the major/minor version number. For example, if 30FA9052.hex is 
the firmware programming file, 200617 decimal (30FA9 hex) is the firmware part number and 0.5.2 (0502) is the decoded 
version number.

Update the DXM Processor Firmware Using the DXM Configuration Software
To update your processor firmware using the DXM Configuration Software, follow these instructions.

After the file load is completed, the DXM restarts and loads the new firmware file. It takes about 2 minutes to complete the 
programming process. The device reboots when finished. Verify the firmware has been updated, under 
Settings › General › Device Information.

Update Your Processor Firmware Using the BannerCDS Website
To update your processor firmware (version 2.0 or later) using the DXM website, follow these instructions.

To use the website to update the firmware file, first configure the DXM to push data to the website.

Using the DXM Configuration Software version 3 or later, connect to the DXM via USB(1) or Ethernet.
File loads to the DXM will take about 15 minutes using USB or approximately 2 minutes using Ethernet.

1. 

On the configuration software, go to Settings › General › Device Information to verify the current firmware version.
You must load a different version with the same firmware number for the boot loader to operate. Download firmware 
files from the Banner website.

Device Information

2. 

Under Settings › Reprogram, click Select upgrade file to select the firmware file to program.3. 

Go to Dashboard › Sites and click + to verify the current firmware part number and version on the DXM.

Data collected from the DXM is displayed.

1. 

From the main Dashboard › Sites screen, click on Update.
A popup box appears.

2. 
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Update Your Processor Firmware Manually
To manually update your processor firmware (version 2.0 or later) using SD card, follow these instructions.

The firmware file can manually be put on the SD card in the BOOT directory (must have version 2.0 or later on the DXM).

Troubleshooting Issues

Problem Solution

Communication contention between 
the LCD and the process

The LCD and the processor applications share the external Modbus connection. If the processor is configured to 
constantly interact with Modbus, it may cause issues with the LCD attempting to use the functions of the ISM radio. 
To alleviate the contention do one of these things:

Load a DXM configuration file that slows down the read/write rules.
Disable the DXM configuration file from loading into the processor by setting DIP switch 4 to ON (on the 
processor board). Reboot the device. When the processor reboots, it will not load the configuration file 
and remains idle.

Cellular modem did not turn on If the incoming voltage drops below 11.2 V DC, the cellular modem does not turn on and will not turn on until the 
voltage is above 11.8 V DC. A text file (CmVMon.txt) on the internal micro SD card saves the periodic sampling of 
the incoming voltage. If cellular operation stops because of voltage, it is logged in this file.

Set the Communications Type to Push Reply, and set the Update Type to Firmware file.3. 

Choose the appropriate Upload File (*.HEX) and click Queue. Click Close.
At the next scheduled push interval, the DXM retrieves the new firmware file. The new firmware file must be the same 
part number of firmware that is currently in the DXM.

4. 

Disconnect the DXM from its power supply.1. 

Remove the micro SD card from the DXM.2. 

Open the cover housing to the DXM.a. 
Use your fingernail to slide the top metal portion of SD card holder.b. 
The metal cover hinges upward, allowing access to remove the SD card.c. 
Press down on the SD cover and slide back into position to close the SD card holder.d. 

Insert the micro SD card into an SD card reader to access the data from a PC.3. 

Load the new firmware file (*.hex) into the BOOT directory of the micro SD card.4. 

Re-insert the micro SD card into the DXM by sliding the card into the holder.5. 

Reconnect the DXM to its power supply.
The automatic boot process should begin. If the boot process does not begin, verify the firmware file is correct and it 
is a different version than what is currently installed on the device.

6. 
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Modbus Operation
All Modbus transactions are managed by a central Modbus engine. If there are Modbus messages intended for a Modbus 
server that doesn't exist, the Modbus engine waits for a response until the timeout period is expired. This slows down the 
Modbus polling loop for read and write operations.

For this reason, verify all Modbus read and write operations are intended for Modbus server devices that are in the network. If 
a Modbus server is not in the network, either a wired or wireless device, the operation of the LCD menu system can be 
compromised. Operations like Binding, Site Survey, or accessing the ISM menu may be slower. This is because all internal 
devices (such as the ISM radio, LCD, etc) of the DXM are also Modbus servers.

DXM100 Documentation
DXM Wireless Controller Sell Sheet, p/n 194063
DXM100-B1 Wireless Controller Datasheet, p/n 186724
DXM100-B2 Wireless Controller Datasheet, p/n 195232
DXM100-Bx Wireless Controller Instruction Manual, p/n 190037
DXM100-S1 Modbus Server Datasheet, p/n 195454
DXM100-S2 Modbus Server Datasheet, p/n 195231
DXM100-Sx Modbus Server Instruction Manual, p/n 188231
DXM ScriptBasic Instruction Manual, p/n 191745
DXM Controller API Protocol, p/n 186221
DXM Controller Configuration Quick Start, p/n 191247
DXM Configuration Software v4 (p/n b_4496867)
DXM Configuration Software v4 Instruction Manual, p/n 209933
DXM EDS Configuration file for Allen-Bradley PLCs, p/n b_4205242
EIP Configuration File for DXM 1xx-BxR1 and R3 models, p/n 194730
Banner CDS Web Service Quick Start Guide, p/n 201126
Banner CDS Web Service Instruction Manual, p/n 178337
Activating a Cellular Modem, p/n b_4419353
Additional technical notes and videos

For more information about the DXM100 family of products, including technical notes, configuration examples, and 
ScriptBasic programs, please visit www.bannerengineering.com.

DXM1000 Documentation
DXM Wireless Controller Sell Sheet, p/n 194063
DXM1000-B1 Wireless Controller Datasheet, p/n 210852
DXM100 and 1000-Bx Wireless Controller Instruction Manual, p/n 190037
DXM ScriptBasic Instruction Manual, p/n 191745
DXM Controller Configuration Quick Start, p/n 191247
DXM Configuration Software (p/n b_4447978)
DXM Configuration Software Instruction Manual, p/n 158447
DXM EDS Configuration file for Allen-Bradley PLCs
EIP Configuration File for DXM 1xx-BxR1 and R3 models (p/n 194730)
Activating a Cellular Modem (p/n b_4419353)
Video tutorials: search "DXM Tutorial" at youtube.com/bannerengineering.
Additional technical notes

For more information about the DXM1000 family of products, including technical notes, configuration examples, and 
ScriptBasic program examples, please refer to the Banner website: www.bannerengineering.com.

DXM Support Policy
The DXM Wireless Controllers are industrial wireless controllers that facilitate Industrial Internet of Things (IIoT) applications. 
As a communications gateway, it interfaces local serial ports, local I/O ports, and local ISM radio devices to the Internet using 
either a cellular connection or a wired Ethernet network connection. In a continuing effort to provide the best operation for 
the DXM, stay connected with Banner Engineering Corp to hear about the latest updates through the Banner website. Create 
a login today to stay informed of all Banner product releases.

http://info.bannerengineering.com/cs/groups/public/documents/literature/194063.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/186724.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/195232.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/190037.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/195454.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/195231.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/188231.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/191745.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/186221.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/191247.pdf
http://info.bannerengineering.com/cs/groups/public/documents/software/b_4496867.exe
http://info.bannerengineering.com/cs/groups/public/documents/literature/209933.pdf
http://info.bannerengineering.com/cs/groups/public/documents/product_data_files/b_4205242.zip
http://info.bannerengineering.com/cs/groups/public/documents/product_data_files/194730.zip
http://info.bannerengineering.com/cs/groups/public/documents/literature/201126.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/178337.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/b_4419353.pdf
http://www.bannerengineering.com
http://info.bannerengineering.com/cs/groups/public/documents/literature/194063.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/210852.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/190037.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/191745.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/191247.pdf
http://info.bannerengineering.com/cs/groups/public/documents/software/b_4447978.exe
http://info.bannerengineering.com/cs/groups/public/documents/literature/158447.pdf
http://info.bannerengineering.com/cs/groups/public/documents/product_data_files/b_4205242.exe
http://info.bannerengineering.com/cs/groups/public/documents/product_data_files/194730.zip
http://info.bannerengineering.com/cs/groups/public/documents/literature/b_4419353.pdf
http://www.youtube.com/bannerengineering
http://www.bannerengineering.com
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Firmware Updates
The DXM has been designed to be a robust and secure IOT device. To provide the most reliable and secure device possible, 
periodic firmware updates are released to enhance and expand the capabilities of the DXM. Firmware updates and 
description details are found on the Banner website. Customers with critical update requirements will get access to pre-
released firmware from the factory.

Website Information
The Banner website is the main method of disseminating DXM information to customers. The data found on the website 
include:

DXM instruction manuals
Configuration manuals
Firmware downloads
Firmware release notes
Errata data, any known issues with a release of firmware
Possible work-around solutions for known issues
DXM Solutions Guides

Feature Requests
Our customer is our most valuable resource to improve our DXM. If you have suggestions for improvements to the DXM or 
configuration software, please contact Banner Engineering Corp.

Potential DXM Issues
Potential issues with the DXM are collected from Banner's support engineers to provide solutions. Users can get help from 
the website documentation or by calling Banner Engineering for support help. Solutions are as simple as configuration 
adjustments, work-around configuration solutions, or potential new firmware updates.

DXM Security
The DXM was designed to collect local wireless sensor data, local sensor data, provide simple control, and send the data to 
the cloud.

The DXM does not run a Linux or Windows-based operating system but an embedded real-time operating system (RTOS) 
environment. As a proprietary operating system, the security aspects are easier to manage and minimize.

Security updates are released through the Banner Engineering Corp website (www.bannerengineering.com) and New 
Product Release Announcements (NPRA).

Specifications
Radio Specifications for Performance and MultiHop (500 mW)
Radio Transmit Power (900 MHz, 500 mW radios)

Conducted: 27 dBm (500 mW)
EIRP with the supplied antenna: < 36 dBm

Radio Transmit Power (2.4 GHz radios)
Conducted: < 18 dBm (65 mW)
EIRP with the supplied antenna: < 20 dBm (100 mW)

Radio Range
A 2 dB antenna ships with this device.
Transmit power and range are subject to many factors, 
including antenna gain, installation methods, characteristics of 
the application, and environmental conditions.
Please refer to the following documents for installation 
instructions and high-gain antenna options.

Installing Your Sure Cross® Radios (151514) 
Conducting a Site Survey (133602)
Sure Cross® Antenna Basics (132113)

Antenna Minimum Separation Distance
900 MHz radios transmitting at ≥ 500 mW: 4.57 m (15 ft) with 
the supplied antenna
2.4 GHz radios transmitting at 65 mW: 0.3 m (1 ft) with the 
supplied antenna

Antenna Connection
Ext. Reverse Polarity SMA, 50 Ohms
Max Tightening Torque: 0.45 N·m (4 lbf·in)

Spread Spectrum Technology
FHSS (Frequency Hopping Spread Spectrum)

Link Timeout (Performance)
Gateway: Configurable via User Configuration Software 
Node: Defined by Gateway 

Radio Packet Size (MultiHop)
900 MHz: 175 bytes (85 Modbus registers)
2.4 GHz: 75 bytes (37 Modbus registers)

900 MHz Compliance (SX7023EXT Radio Module)
Radio module is indicated by the product label marking
Contains FCC ID: UE3SX7023EXT
Contains IC: 7044A-SX7023EXT

http://www.bannerengineering.com
http://www.bannerengineering.com/us/en/company/press-releases.html#all
https://info.bannerengineering.com/cs/groups/public/documents/literature/151514.pdf
https://info.bannerengineering.com/cs/groups/public/documents/literature/133602.pdf
https://info.bannerengineering.com/cs/groups/public/documents/literature/132113.pdf
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2.4 GHz Compliance (SX243 Radio Module)
Radio module is indicated by the product label marking

Contains FCC ID: UE3SX243
Radio Equipment Directive (RED) 2014/53/EU
Contains IC: 7044A-SX243

RS-485 Communication Specifications
Communication Hardware (MultiHop RS-485)

Interface: 2-wire half-duplex RS-485
Baud rates: 9.6k, 19.2k (default), or 38.4k via DIP switches; 
1200 and 2400 via the MultiHop Configuration Software
Data format: 8 data bits, no parity, 1 stop bit

RS-232 Communication Specifications
Communication Hardware (MultiHop RS-232)

Interface: 2-wire RS-232
Baud rates: 9.6k, 19.2k (default), or 38.4k via DIP switches; 
1200 and 2400 via the MultiHop Configuration Software
Data format: 8 data bits, no parity, 1 stop bit

DXM100-B1 Power and IO Specifications
Supply Voltage 

12 to 30 V DC (use only with a suitable Class 2 power supply 
(UL) or a SELV (CE) power supply) or 
12 V DC solar panel and 12 V sealed lead acid battery

Courtesy Power Out
One output at 5 Volts, 500 mA maximum
No short circuit protection

Power Consumption
35 mA average at 12 Volts (exclusive of load)

Solar Power
12 V sealed lead acid battery
2 A maximum charge current
12 V, 20 W maximum solar panel

Solar Power Battery Charging
1 A maximum with 20 Watt solar panel

Switched Power Out
Two selectable 5 V or 16 V outputs
5 V: 400 mA maximum
16 V: 125 mA maximum

Construction
Polycarbonate; DIN rail mount option

Communication Protocols
Modbus RTU Client/Server, Modbus TCP, and Ethernet/IP

Security Protocols
VPN, SSL, and HTTPS

Logging
8 GB maximum; removable Micro SD card format

Counters, Synchronous
32-bits unsigned
10 ms clock rate minimum

Universal Inputs
Sinking/Sourcing discrete, 4–20 mA analog, 0–10 V analog, 
counter, and temperature 10 kOhm thermistor

Analog Outputs (DAC)
0 to 20 mA or 0 to 10 V DC output
Accuracy: 0.1% of full scale +0.01% per °C
Resolution: 12-bit

Discrete Output Rating (NMOS)
Less than 1 A max current at 30 V DC
ON-State Saturation: Less than 0.7 V at 20 mA
ON Condition: Less than 0.7 V
OFF Condition: Open

Certifications
CE/UKCA approval only applies to 2.4 GHz models NOM 
approval only applies to 900 MHz models

Banner Engineering BV
Park Lane, Culliganlaan 2F bus 3
1831 Diegem, BELGIUM

Turck Banner LTD Blenheim House
Blenheim Court
Wickford, Essex SS11 8YT
GREAT BRITAIN

 03737-22-04042

Required Overcurrent Protection

WARNING: Electrical connections must 
be made by qualified personnel in 
accordance with local and national 
electrical codes and regulations. 

Overcurrent protection is required to be provided by end 
product application per the supplied table. 
Overcurrent protection may be provided with external fusing 
or via Current Limiting, Class 2 Power Supply.
Supply wiring leads < 24 AWG shall not be spliced.

For additional product support, go 
to www.bannerengineering.com. 

Supply 
Wiring 
(AWG)

Required Overcurrent 
Protection (A)

Supply 
Wiring 
(AWG)

Required Overcurrent 
Protection (A)

20 5.0 26 1.0

22 3.0 28 0.8

24 1.0 30 0.5
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DXM100-B2 Power and IO Specifications
Supply Voltage 

12 to 30 V DC (use only with a suitable Class 2 power supply 
(UL) or a SELV (CE) power supply) or 
12 V DC solar panel and 12 V sealed lead acid battery

Courtesy Power Out
One output at 5 Volts, 500 mA maximum
No short circuit protection

Switched Power Outputs
Two adjustable 5 V to 24 V outputs
One SDI-12 adjustable 5 V to 24 V output
5 V: 400 mA maximum
16 V: 125 mA maximum
24 V: 85 mA maximum

Power Consumption
35 mA average at 12 Volts (exclusive of load)

Solar Power
12 V sealed lead acid battery
2 A maximum charge current
12 V, 20 W maximum solar panel

Solar Power Battery Charging
1 A maximum with 20 Watt solar panel

Communication Protocols
Modbus RTU Client/Server, Modbus TCP, and Ethernet/IP

Security Protocols
VPN, SSL, and HTTPS

Logging
8 GB maximum; removable Micro SD card format

Construction
Polycarbonate; DIN rail mount option

Counters, Synchronous
32-bits unsigned
10 ms clock rate minimum

Universal Inputs
Sinking/Sourcing discrete, 4–20 mA analog, 0–10 V analog, 
counter, and temperature 10 kOhm thermistor

Analog Outputs (DAC)
0 to 10 V DC output
Accuracy: 0.1% of full scale +0.01% per °C
Resolution: 12-bit

Discrete Output Rating (NMOS)
Less than 1 A max current at 30 V DC
ON-State Saturation: Less than 0.7 V at 20 mA
ON Condition: Less than 0.7 V
OFF Condition: Open

Certifications
CE/UKCA approval only applies to 2.4 GHz models

Banner Engineering BV
Park Lane, Culliganlaan 2F bus 3
1831 Diegem, BELGIUM

Turck Banner LTD Blenheim House
Blenheim Court
Wickford, Essex SS11 8YT
GREAT BRITAIN

 03737-22-04042

Required Overcurrent Protection

WARNING: Electrical connections must 
be made by qualified personnel in 
accordance with local and national 
electrical codes and regulations. 

Overcurrent protection is required to be provided by end 
product application per the supplied table. 
Overcurrent protection may be provided with external fusing 
or via Current Limiting, Class 2 Power Supply.
Supply wiring leads < 24 AWG shall not be spliced.
For additional product support, go 
to www.bannerengineering.com. 

Supply 
Wiring 
(AWG)

Required Overcurrent 
Protection (A)

Supply 
Wiring 
(AWG)

Required Overcurrent 
Protection (A)

20 5.0 26 1.0

22 3.0 28 0.8

24 1.0 30 0.5

DXM1000-B1 Power and IO Specifications
Supply Voltage 

12 to 30 V DC (use only with a suitable Class 2 power supply 
(UL) or a SELV (CE) power supply) or 
12 V DC solar panel and 12 V sealed lead acid battery

Courtesy Power Out
One output at 5 Volts, 500 mA maximum
No short circuit protection

Power Consumption
35 mA average at 12 Volts (exclusive of load)

Solar Power
12 V sealed lead acid battery
2 A maximum charge current
12 V, 20 W maximum solar panel

Solar Power Battery Charging
1 A maximum with 20 Watt solar panel

Switched Power Out
Two selectable 5 V or 16 V outputs
5 V: 400 mA maximum
16 V: 125 mA maximum

Communication Protocols
Modbus RTU Client/Server, Modbus TCP, and Ethernet/IP

Counters, Synchronous
32-bits unsigned
10 ms clock rate minimum

Universal Inputs
Sinking/Sourcing discrete, 4–20 mA analog, 0–10 V analog, 
counter, and temperature 10 kOhm thermistor
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Analog Outputs (DAC)
0 to 20 mA or 0 to 10 V DC output
Accuracy: 0.1% of full scale +0.01% per °C
Resolution: 12-bit

Discrete Output Rating (NMOS)
Less than 1 A max current at 30 V DC
ON-State Saturation: Less than 0.7 V at 20 mA
ON Condition: Less than 0.7 V
OFF Condition: Open

Security Protocols
VPN, SSL, and HTTPS

Construction
Polycarbonate; DIN rail mount option

Logging
8 GB maximum; removable Micro SD card format

DXM1000-B2 Power and I/O Specifications
Supply Voltage 

12 to 30 V DC (use only with a suitable Class 2 power supply 
(UL) or a SELV (CE) power supply) or 
12 V DC solar panel and 12 V sealed lead acid battery

Courtesy Power Out
One output at 5 Volts, 500 mA maximum
No short circuit protection

Switched Power Outputs
Two adjustable 5 V to 24 V outputs
One SDI-12 adjustable 5 V to 24 V output
5 V: 400 mA maximum
16 V: 125 mA maximum
24 V: 85 mA maximum

Power Consumption
35 mA average at 12 Volts (exclusive of load)

Solar Power
12 V sealed lead acid battery
2 A maximum charge current
12 V, 20 W maximum solar panel

Solar Power Battery Charging
1 A maximum with 20 Watt solar panel

Communication Protocols
Modbus RTU Client/Server, Modbus TCP, and Ethernet/IP

Security Protocols
SSL, TLS, and HTTPS

Logging
8 GB maximum; removable Micro SD card format

Construction
Polycarbonate; DIN rail mount option

Counters, Synchronous
32-bits unsigned
10 ms clock rate minimum

Universal Inputs
Sinking/Sourcing discrete, 4–20 mA analog, 0–10 V analog, 
counter, and temperature 10 kOhm thermistor

Analog Outputs (DAC)
0 to 10 V DC output
Accuracy: 0.1% of full scale +0.01% per °C
Resolution: 12-bit

Discrete Output Rating (NMOS)
Less than 1 A max current at 30 V DC
ON-State Saturation: Less than 0.7 V at 20 mA
ON Condition: Less than 0.7 V
OFF Condition: Open

Environmental Specifications (DXM)
Operating Conditions

–20 °C to +60 °C (–4 °F to +140 °F)
95% maximum relative humidity (non-condensing)
Radiated Immunity: 10 V/m (EN 61000-4-3)
Operating the devices at the maximum operating conditions 
for extended periods can shorten the life of the device.

Environmental Rating
IP20

Shock and Vibration
All models meet IEC 60068-2-6 and IEC 60068-2-27 testing 
criteria
Shock: 15G 11 ms duration, half sine wave per IEC 
60068-2-27
Vibration: 10 Hz to 55 Hz, 0.5 mm peak-to-peak amplitude per 
IEC 60068-2-6

Contact Us
Banner Engineering Corp. headquarters is located at: 9714 Tenth Avenue North | Plymouth, MN 55441, USA | Phone: + 1 
888 373 6767

For worldwide locations and local representatives, visit www.bannerengineering.com.

Mexican Importer
Banner Engineering de Mèxico, S. de R.L. de C.V. | David Alfaro Siqueiros 103 Piso 2 Valle oriente | San Pedro Garza Garcia Nuevo Leòn, C. P. 66269

81 8363.2714

http://www.bannerengineering.com
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FCC and ISED Certification for 900 MHz
This equipment contains transmitter module RM1809 or SX7023EXT.

Radio Module RM1809 Radio Module SX7023EXT

FCC ID: UE3RM1809 FCC ID: UE3SX7023EXT

IC: 7044A-RM1809 IC: 7044A-SX7023EXT

HVIN: RM1809 HVIN: 223150

FCC Notices
IMPORTANT: The transmitter modules RM1809 and SX7023EXT have been certified by the FCC / ISED for use with other 
products without any further certification (as per FCC section 2.1091). Changes or modifications not expressly approved by 
the manufacturer could void the user’s authority to operate the equipment.

IMPORTANT: The transmitter modules RM1809 and SX7023EXT have been certified for fixed base station and mobile 
applications. If modules will be used for portable applications, the device must undergo SAR testing.

IMPORTANT: If integrated into another product, the FCC ID label must be visible through a window on the final device or it 
must be visible when an access panel, door, or cover is easily removed. If not, a second label must be placed on the outside 
of the final device that contains the following text:

Transmitter Module [RM1809 or SX7023EXT]
Contains FCC ID: [UE3RM1809 or UE3SX7023EXT]
Contains IC: [7044A-RM1809 or 7044A-SX7023EXT]
HVIN: [RM1809 or 223150]

This device complies with Part 15 of the FCC Rules. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation is subject to the following two conditions: 1) This device may not cause harmful interference; and 
2) This device must accept any interference received, including interference that may cause undesired operation.

Antenna WARNING: This device has been tested with Reverse Polarity SMA connectors with the antennas listed in "Certified 
Antennas for 900 MHz on page 106. When integrated into OEM products, fixed antennas require installation preventing end-
users from replacing them with non-approved antennas. Antennas not listed in the tables must be tested to comply with FCC 
Section 15.203 (unique antenna connectors), FCC Section 15.247 (emissions), and ISED RSS-Gen Section 6.8.

FCC and ISED Approved Antennas
WARNING: Antenna(s) used for this transmitter must be installed to provide a separation distance of at least 20 cm from all 
persons.

AVERTISSEMENT : Les antennes utilisées pour cet émetteur doivent être installées de manière à assurer une distance de 
séparation d'au moins 20 cm de toutes les personnes.

NOTICE: This equipment is approved only for mobile and base station transmitting devices. The antenna(s) used for this 
transmitter must not transmit simultaneously with any other antenna or transmitter, except in accordance with FCC multi-
transmitter product procedures.

The radio transmitter modules RM1809 and SX7023EXT have been approved by FCC and ISED Canada to operate with the 
antenna types listed below, with the maximum permissible gain indicated. Antenna types not included in this list that have a 
gain greater than the maximum gain indicated for any type listed are strictly prohibited for use with this device.

Certified Antennas for 900 MHz

Model Number Antenna Type 900 MHz Radio Module Maximum Gain Impedance Minimum Required 
Cable/Connector Loss

- Integral Antenna RM1809 Unity gain 0

BWA-9O1-x Omni, 1/4 wave dipole RM1809 ≤2 dBi 50 Ω 0

BWA-9O2-C Omni, 1/2 wave dipole, Swivel RM1809 or SX7023EXT ≤2 dBi 50 Ω 0

BWA-9O6-A Omni Wideband, Fiberglass 
Radome RM1809 ≤8.2 dBi 50 Ω 2.2 dB

Continued on page 107



Product Support and Maintenance DXM100-Bx and 1000-Bx Wireless Controller Product Manual

09-Dec-24 page 107 of 110© Banner Engineering Corp. All rights reserved.

Continued from page 106

Model Number Antenna Type 900 MHz Radio Module Maximum Gain Impedance Minimum Required 
Cable/Connector Loss

BWA-9O5-B Omni Base Whip RM1809 ≤7.2 dBi 50 Ω 1.2 dB

BWA-9Y10-A Yagi RM1809 ≤10 dBi 50 Ω 4 dB

BWA-9O5-C Coaxial sleeve SX7023EXT ≤5 dBi 50 Ω 0

BWA-9O6-AS Omni SX7023EXT ≤6 dBi 50 Ω 0

FCC and ISED Certification for 2.4 GHz
This equipment contains transmitter module DX80-2400 or SX243.

Radio Module DX80-2400 Radio Module SX243

FCC ID: UE300DX80-2400 FCC ID: UE3SX243

IC: 7044A-DX8024 IC: 7044A-SX243

HVIN: DX80G2 / DX80N2 HVIN: SX243

FCC Notices
IMPORTANT: The transmitter modules DX80-2400 and SX243 have been certified by the FCC / ISED for use with other 
products without any further certification (as per FCC section 2.1091). Changes or modifications not expressly approved by 
the manufacturer could void the user’s authority to operate the equipment.

IMPORTANT: The transmitter modules DX80-2400 and SX243 have been certified for fixed base station and mobile 
applications. If modules will be used for portable applications, the device must undergo SAR testing.

IMPORTANT: If integrated into another product, the FCC ID/IC label must be visible through a window on the final device or it 
must be visible when an access panel, door, or cover is easily removed. If not, a second label must be placed on the outside 
of the final device that contains the following text:

Transmitter Module [DX80-2400 or SX243]
Contains FCC ID: [UE300DX80-2400 or UE3SX243]
Contains IC: [7044A-DX8024 or 7044A-SX243]
HVIN: [DX80G2, DX80N2 or SX243]

This device complies with Part 15 of the FCC Rules. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation is subject to the following two conditions: 1) This device may not cause harmful interference; and 
2) This device must accept any interference received, including interference that may cause undesired operation.

Antenna Warning: This device has been tested with Reverse Polarity SMA connectors with the antennas listed in "Certified 
Antennas for 2.4 GHz on page 108. When integrated into OEM products, fixed antennas require installation preventing end-
users from replacing them with non-approved antennas. Antennas not listed in the tables must be tested to comply with FCC 
Section 15.203 (unique antenna connectors), FCC Section 15.247 (emissions), and ISED RSS-Gen Section 6.8.

FCC and ISED Approved Antennas
AVERTISSEMENT : Les antennes utilisées pour cet émetteur doivent être installées de manière à assurer une distance de 
séparation d'au moins 20 cm de toutes les personnes.

NOTICE: This equipment is approved only for mobile and base station transmitting devices. The antenna(s) used for this 
transmitter must not transmit simultaneously with any other antenna or transmitter, except in accordance with FCC multi-
transmitter product procedures.

The radio transmitter modules DX80-2400 and SX243 have been approved by FCC and ISED Canada to operate with the 
antenna types listed below, with the maximum permissible gain indicated. Antenna types not included in this list that have a 
gain greater than the maximum gain indicated for any type listed are strictly prohibited for use with this device.
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Certified Antennas for 2.4 GHz

Model Antenna Type 2.4 GHz Radio Module Maximum Gain Impedance

Integral antenna DX80-2400 or SX243 Unity gain

BWA-2O2-C Omni, 1/2 wave dipole, Swivel DX80-2400 or SX243 ≤ 2 dBi 50 Ω

BWA-2O2-D Omni, Dome, Box Mount DX80-2400 or SX243 ≤ 2 dBi 50 Ω

BWA-2O2-E Omni, 1/4 wave dipole, Swivel DX80-2400 or SX243 ≤ 2 dBi 50 Ω

BWA-2O5-C Omni, Collinear, Swivel DX80-2400 ≤ 5 dBi 50 Ω

BWA-2O5-MA Omni, full-wave dipole, NMO DX80-2400 ≤ 4.5 dBi 50 Ω

BWA-2O6-A Omni, Dome, Box Mount DX80-2400 ≤ 6 dBi 50 Ω

BWA-2O7-C Omni, Coaxial Sleeve, Swivel DX80-2400 ≤ 7 dBi 50 Ω

ANATEL
Este equipamento não tem direito à proteção contra interferência prejudicial e não pode causar interferência em sistemas 
devidamente autorizados.  Para maiores informações, consulte o site da ANATEL www.gov.br/anatel/pt-br/ 

Warnings
WARNING:

Do not use this device for personnel protection 
Using this device for personnel protection could result in serious injury or death.
This device does not include the self-checking redundant circuitry necessary to allow its use in personnel safety applications. A 
device failure or malfunction can cause either an energized (on) or de-energized (off) output condition.

IMPORTANT: Please download the complete DXM100-Bx or 1000-Bx Wireless Controller technical documentation, available in multiple 
languages, from www.bannerengineering.com for details on the proper use, applications, Warnings, and installation instructions of this 
device. 

IMPORTANT: Por favor descargue desde www.bannerengineering.com toda la documentación técnica de los DXM100-Bx or 1000-Bx 
Wireless Controller, disponibles en múltiples idiomas, para detalles del uso adecuado, aplicaciones, advertencias, y las instrucciones de 
instalación de estos dispositivos. 

IMPORTANT: Veuillez télécharger la documentation technique complète des DXM100-Bx or 1000-Bx Wireless Controller sur notre site 
www.bannerengineering.com pour les détails sur leur utilisation correcte, les applications, les notes de sécurité et les instructions de 
montage. 

Install and properly ground a qualified surge suppressor when installing a remote antenna system. Remote antenna configurations installed without surge 
suppressors invalidate the manufacturer's warranty. Keep the ground wire as short as possible and make all ground connections to a single-point ground system 
to ensure no ground loops are created. No surge suppressor can absorb all lightning strikes; do not touch the Sure Cross® device or any equipment connected 
to the Sure Cross® device during a thunderstorm. 

Exporting Sure Cross® Radios. It is our intent to fully comply with all national and regional regulations regarding radio frequency emissions. Customers who want 
to re-export this product to a country other than that to which it was sold must ensure the device is approved in the destination country. The Sure Cross wireless 
products were certified for use in these countries using the antenna that ships with the product. When using other antennas, verify you are not exceeding the 
transmit power levels allowed by local governing agencies. This device has been designed to operate with the antennas listed on Banner Engineering’s website 
and having a maximum gain of 9 dBm. Antennas not included in this list or having a gain greater than 9 dBm are strictly prohibited for use with this device. The 
required antenna impedance is 50 ohms. To reduce potential radio interference to other users, the antenna type and its gain should be so chosen such that the 
equivalent isotropically radiated power (EIRP) is not more than that permitted for successful communication. Consult with Banner Engineering Corp. if the 
destination country is not on this list.

http://www.gov.br/anatel/pt-br/
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IMPORTANT:
Never operate a radio without connecting an antenna
Operating radios without an antenna connected will damage the radio circuitry.
To avoid damaging the radio circuitry, never apply power to a Sure Cross® Performance or Sure Cross® MultiHop radio 
without an antenna connected.

IMPORTANT:
Electrostatic discharge (ESD) sensitive device
ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
Use proper handling procedures to prevent ESD damage. Proper handling procedures include leaving devices in their anti-
static packaging until ready for use; wearing anti-static wrist straps; and assembling units on a grounded, static-dissipative 
surface.

Banner Engineering Corp Limited Warranty
Banner Engineering Corp. warrants its products to be free from defects in material and workmanship for one year following the date of shipment. Banner 
Engineering Corp. will repair or replace, free of charge, any product of its manufacture which, at the time it is returned to the factory, is found to have been 
defective during the warranty period. This warranty does not cover damage or liability for misuse, abuse, or the improper application or installation of the Banner 
product.

THIS LIMITED WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT 
LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE), AND WHETHER ARISING UNDER COURSE OF 
PERFORMANCE, COURSE OF DEALING OR TRADE USAGE.

This Warranty is exclusive and limited to repair or, at the discretion of Banner Engineering Corp., replacement. IN NO EVENT SHALL BANNER ENGINEERING 
CORP. BE LIABLE TO BUYER OR ANY OTHER PERSON OR ENTITY FOR ANY EXTRA COSTS, EXPENSES, LOSSES, LOSS OF PROFITS, OR ANY 
INCIDENTAL, CONSEQUENTIAL OR SPECIAL DAMAGES RESULTING FROM ANY PRODUCT DEFECT OR FROM THE USE OR INABILITY TO USE THE 
PRODUCT, WHETHER ARISING IN CONTRACT OR WARRANTY, STATUTE, TORT, STRICT LIABILITY, NEGLIGENCE, OR OTHERWISE.

Banner Engineering Corp. reserves the right to change, modify or improve the design of the product without assuming any obligations or liabilities relating to any 
product previously manufactured by Banner Engineering Corp. Any misuse, abuse, or improper application or installation of this product or use of the product for 
personal protection applications when the product is identified as not intended for such purposes will void the product warranty. Any modifications to this product 
without prior express approval by Banner Engineering Corp will void the product warranties. All specifications published in this document are subject to change; 
Banner reserves the right to modify product specifications or update documentation at any time. Specifications and product information in English supersede that 
which is provided in any other language. For the most recent version of any documentation, refer to: www.bannerengineering.com.

For patent information, see www.bannerengineering.com/patents.

http://www.bannerengineering.com
http://www.bannerengineering.com/patents
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